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1 .O INTRODUCTION 

1.1 Introduction, Purpose, and Organization 

Shaw Environmental & Infrastructure of New York, P.C. (Shaw) has prepared the following 
Downgradient Treatment System Project Final Design Report to address the Volatile Organic 
Compound (VOC) impacted on-site and off-site aquifer plume at the New York Department of 
Environmental Conservation (NYSDEC) National Heatset Printing (NHP) Site No. 1-52-1 40 
under the State Superfund Standby Contract Work Assignment. This report was prepared in 
accordance to the NYSDEC approved Remedial Design Work Plan, September 29, 2000 
(Shaw, formerly IT Corporation). In accordance with this work plan a two-tiered approach to the 
on-site and off-site aquifer remediation is presented. Two designs for each portion of the 
aquifer are presented. The first tier presents performance specifications for in-well stripping 
(recirculation) remediation systems, while the second tier presents a design for groundwater 
extraction and treatment systems. 

The purpose of this report is to evaluate and address issues necessary to proceed with the 
designs of the aquifer restoration systems. Included are such elements as the results of the 
aquifer pump test, selection of preferred locations and geometries of the extraction wells for the 
extraction and treatment systems, definition of the performance requirements for the 
recirculation well system, and process flow for the on-site and off-site groundwater extraction 
and treatment systems. This report discusses and suggests solutions for design concerns and 
uncertainties that could adversely affect adjacent properties, the environment, or the operation 
of the remedy. This report finalizes the design of the on-site and off-site groundwater extraction 
and treatment systems described in the Pre-Final Design Report by incorporating comments 
from the NYSDEC and adding sufficient design detail for bidding the construction via the 
Contract Documents. The Final Design Report document will be used as a reference to support 
the Contract Documents. 

Based on these changes, the Final design report is divided into the following Sections: 

Section 1 presents the introduction, site background, and site geology. 

Section 2 presents the pre-design activities. 

Section 3 presents the aquifer analysis, including pre-test activities, step drawdown test, aquifer 
test methodologies, aquifer test data analysis, and aquifer test results. 
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Section 4 presents the remediation system design considerations including remedial objectives, 
proposed treatment scenarios, design basis and criteria for the groundwater extraction and 
treatment systems, and performance requirements for the in-well stripping recirculation system. 

Section 5 presents the evaluation of the groundwater extraction and treatment alternatives for 
on-site and off-site considerations. 

Section 6 presents an evaluation of the groundwater extraction and treatment systems, 
including process options and permitting requirements for on-site and off-site consideration. 

Section 7 presents a summary of the final design for the on-site and off-site extraction and 

treatment systems. 

Section 8 presents a list of the technical specifications to be included in the Contract 
Documents and a project implementation schedule. 

Appendices include the final design drawings, supporting design calculations, and off-gas 
discharge modeling results. 

"pu 1.2 Site Background 

The National Heatset Printing site is located at One Adams Boulevard in the Hamlet of East 
Farmingdale, Town of Babylon, Suffolk County (Figure 1-1). The site contains one multi-tenant 
industrial building approximately 4.5 acres in size. The National Heatset Printing Company 
occupied a portion of this building from July 1983 to April 1989. Their operations consisted of 
lithographic tri-color printing of newspaper and periodical advertisements and the manufacture 
of lithographic printing plates. National Heatset had been using organic solvents at the site 
since 1983. Inspections by the Suffolk County Department of Health Services (SCDHS) in 1983 
and 1986 reported improper storage and discharge of waste materials. 

The National Heatset Printing Company filed for bankruptcy in 1987. The SCDHS discovered 
that after filing for bankruptcy, National Heatset disposed of its chemical inventory by dumping 
the materials onto the soils and into a leaching pool located off the rear of the building on the 
northeast side of the property. 

Investigations conducted by the SCDHS and the property owner's consultant reported the 
presence of on-site subsurface soil contamination and on-site and downgradient groundwater 
contamination. The contaminants identified consisted of VOCs, principally Tetrachloroethylene 
(PCE). The site was listed in the Registry as a Class 2 in 1993. 
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A Remedial Investigation (RI) was performed by Holzmacher, McLendon & Murrell, P.C. for the 
NYSDEC from August 1997 to January 1999. The RI reported the presence of a groundwater 
plume containing VOCs, which at that time extended approximately 7,100 feet downgradient of 
the site. The highest concentrations of PCE in groundwater were detected at approximately 80 
feet below ground surface (bgs) on top of a clay layer. Concentrations of VOCs greater than 
1,000 parts per billion (ppb) (maximum 12,021 ppb) in the groundwater were present in the 75 
to 85-foot sampling interval to approximately 4,100 feet downgradient (south-southeast) of the 
site. Contaminated soils were detected in the saturated zone, below the water table, and were 
located directly below the leaching pool in the rear of the property. 

The Suffolk County Water Authority (SCWA) Albany Avenue well field is located 6,500 feet 
downgradient from the site. The wells are screened at depths of 419 to 509 feet bgs below the 
contaminant plume. Monthly monitoring of these wells has not detected the presence of any 
contamination. Data collected during the RI indicates that the groundwater contaminant plume 
migrating from the National Heatset site is sinking, and therefore may eventually contaminate 
the public drinking water well field. However, exposure to contaminants that may reach the 
Albany Avenue well field is not expected since these wells are monitored on a monthly basis 
and must meet NYSDOH standards. 

b' Potential remedial alternatives for the National Heatset Printing site were identified, screened 
and evaluated in a Feasibility Study (FS). Based on the RI and FS, the Department issued a 
Record of Decision (ROD) document dated June 17, 1999 that identified the selected remedy 
for the site. The major elements of the National Heatset printing site remedy, as presented in 
the ROD. are as follows: 

A remedial design program that includes a pilot test to verify the components of the 
conceptual design and provide the details necessary for the construction, operation, 
maintenance, and monitoring of the remedial program. Additional investigation 
needed for the pilot test or the remedial design will be conducted. 

Based on the pilot test data, the effectiveness of the in-well stripping system at the 
source area will be evaluated. Since the high VOC concentrations at the source 
area indicate the presence of undissolved product mixed with groundwater, an 
alternative remedy such as extraction and treatment or sparging with air or ozone 
may be chosen to recover and/or treat the undissolved product. The two 
downgradient in-well stripping systems would be retained to prevent migration of the 
contaminant plume. 

Construction and implementation of the in-well stripping systems or an alternative 
remedy supported by pilot test data, which includes: 

- One system at the source area, consisting of two groundwater circulation wells 
This system will remediate the area with the highest VOC concentrations; 

- One system at the south end of the site consisting of three groundwater 
circulation wells. This system will prevent additional VOC contamination from 
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- One system downgradient of the southern edge of the one (1) ppm groundwater 
contamination contour. This system will consist of seven wells and will halt 
further migration of VOCs downgradient of the site. 

Providing public water to any properties that utilize private wells within the affected 
area. Any private wells identified downgradient of the site will be tested for VOCs by 
the Suffolk County Department of Health Services. If site-related contaminants are 
detected in the well samples, the home or business serviced by the contaminated 
well will be connected to public water. 

Since the remedy results in untreated hazardous waste remaining at the site, a long-term 
monitoring program will be instituted. Monitoring wells will be installed, where needed, and 
sampled upgradient and downgradient of each of the in-well stripping systems. Wells already 
exist on-site and upgradient and downgradient of the site. Additional wells will be installed 
downgradient of the site. This program will allow the effectiveness of the in-well stripping to be 
monitored and will be a component of the operation and maintenance for the site; and 
institutional controls will be implemented and deed restrictions will be recorded in the chain of 
title of the property to restrict future use of groundwater at the site. 

L Since the ROD for this site was signed, the NYSDEC has attempted to obtain competitive bids 
using in-well stripping remedial technology at another inactive hazardous waste site. Since the 
NYSDEC was unable to obtain bids at a reasonable cost at the other site using re-circulation 
well technology, an alternate remedy was needed to avoid the same problems from occurring at 
this site. In June 2000, the NYSDEC issued an Explanation of Significant Differences (ESD) for 
this site. The ESD added groundwater extraction and treatment as an alternate remedy for the 
downgradient groundwater contamination. 

1.3 Site GeologylHydrogeology 

The following sections have been adapted from the 1999 Remedial Investigation Report (H2M 
Group, 1999). 

1.3. I Surface Features 
The local topography surrounding the Heatset Site consists of relatively flat terrain with a slight 
south-southwest slope. The gradient of the natural land surface within the site boundaries is 
less than four feet. Gradients of man-made surfaces (i.e., paved surfaces) at the Heatset Site 
can vary as much as four feet due to truck loading bays sloping back toward the building. The 
recharge basin located at the adjoining property to the west, has moderately sloping sides with 
a base elevation approximately 15 to 20 feet below that of the surrounding property. A site 

.C topography map is provided as Figure 1-3. 
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I. 3.2 Surface Water Hydrology 
No surface water bodies exist within the Heatset Site property boundaries. There is no 
evidence of ephemeral streams or steam-cut channels at the site. Review of the Amityville 7.5 
min quadrangle United States Geographic Survey (USGS) topographic maps support these field 
observations. The nearest downgradient stream shown on the topographic map is a creek 
tributary connected to Avon Lake, approximately 1.7 miles south of the site. The headwaters of 
this creek are located just to the south of Sunrise Highway in the Town of Amityville. The 
headwaters of the Carmans Creek and Massapequa Creek occur approximately 2.0 miles 
south-southeast and southwest of the site, respectively. 

1.3.3 Hydrogeologic Setting 
The geologic formations that underlie Suffolk County are composed of a series of thick deposits 
of unconsolidated water bearing sediments of the late Cretaceous and Pleistocene age. These 
unconsolidated deposits are underlain by crystalline bedrock of Precambrian age. 

There are three primary water bearing aquifers underlying Suffolk County. These aquifers, from 
shallow to deep, are the Upper Glacial, Magothy, and Lloyd. The aquifers are considered to be 
hydraulically connected, with the Glacial and Magothy contributing recharge for the underlying 
Lloyd aquifer. Together, they are a federally designated sole source of drinking water for Long 
Island. 

During the great glacial retreat, the area was covered with outwash deposits that constitute 
most of the Upper Glacial aquifer of Long Island. The Upper Glacial aquifer is the most 
permeable aquifer on Long Island because these sand and gravel deposits contain virtually no 
interstitial clay and silt. The estimated average horizontal hydraulic conductivity of the outwash 
is from 1,000 to 1,500 gpd/ft2, The direction of groundwater movement through Long Island's 
aquifers is horizontal and is generally more rapid than the movement in the vertical direction. 
This arises because of an anistrophic effect: the largest dimensions of particles in the 
interbedded fine- and coarse-grained layers tend to be oriented horizontally. 
Groundwater in the Upper Glacial aquifer flows away from two major highs on the main water 
table divide on Long Island. The general directions of groundwater flow of the Island are north 
toward the Long Island Sound and south toward the Great South Bay. Based on site-specific 
data, local groundwater flow at the site moves south to southeast toward the Great South Bay 
with a gradient of 0.0014 foot per foot (Wft) and a velocity of approximately I .34 Wday. 
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2.0 DESIGN ACTIVITIES 

Several work tasks have been completed as part of the source delineationlpre-design work. 

The complete tasks include: 

Health and Safety Plan Preparation 

Source Area Investigations 

- Soil Borings and Sampling 

- Monitoring Well Installation 

- Groundwater Sampling 

Aquifer Pump Test 

Pump and Treat and In-Well Stripping System 35% Engineering Design Report 

65% Engineering Design Report 

95% Engineering Design Report 

100% Design Report 

Site Survey and Site Plan Preparation 

Meeting with the Suffolk County Water Authority (SCWA) 

Final Engineering Design Report 

The Site Specific Health and Safety Plan (HASP) was updated on January 15, 2001. 

Source area investigation work was completed from January through April 2001 and included 
completion of several soil borings and monitoring wells. The investigation also included the 
collection and analysis of several soil and groundwater samples from the site source area. The 
investigation work concentrated on an area of the site with the potential for Dense Non-Aqueous 
Phase Liquid (DNAPL) to exist at the lower confining clay layer. (Refer to the on-site General 
Site Plan included as Figure 2-1). 

An aquifer pump test was performed at the site from April 23, 2001 to April 27, 2001 

The 35% Engineering Design Report was submitted July 5,2001. The 65% Engineering Design 
Report was submitted November 8, 2001. The 95% Engineering Design Report was submitted 
December 18,2002 and a 100% Design Report was issued July 17,2003. Other than 
meetings at the SCWA, no additional site work has been implemented as of the writing of this 
Final Design Report. Refer to the off-site General Site Plan included as Figure 2-2. 
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3.0 AQUIFER TEST ANALYSIS 

Between April 24 and 27, 2001, an aquifer test was conducted at the site to determine the 
transmissivity and specific yield of the upper glacial aquifer. Transmissivity (T) is the measure 
of the amount of water that can be transmitted horizontally through a unit width by the full 
saturated thickness of the aquifer under a hydraulic gradient of one. Specific yield (Sy) is the 
ratio of the volume of water that drains from a saturated rock owing to the attraction of gravity to 
the total volume of the rock. These hydraulic characteristics were later utilized in the design of 
the groundwater recovery and treatment systems at the site. The following sections detail the 
activities that were conducted for the aquifer test. 

3.1 Pre-Test Activities and Data Collection 

Based on site hydrogeologic conditions, it was determined that a pumping rate of up to 50 
gallons per minute (gpm) was a sustainable pumping rate that would sufficiently stress the 
aquifer to obtain useful hydrogeologic data from the existing set of monitoring wells. Monitoring 
well MW-10 was selected as the pumping well for the aquifer test due to its down-gradient 
location on the property and the surrounding network of monitoring wells. Pressure transducers 
were placed in monitoring wells MW-2A, MW-3A, MW-4A, MW-9 and MW-10 and were * controlled by a HermitTM 3000 Datalogger. In addition, a downhole TrollTM was installed in 
monitoring well MW-H to record water levels at that location. Prior to initiating pumping, water 
levels were manually gauged at all on-site monitoring wells to aid in assessment of the influence 
of pumping across the property. 

3 I .  Groundwater Treatment Activities 
Based on previous groundwater sampling results in the aquifer test area, groundwater 
generated during well development and aquifer test activities required treatment prior to 
discharging via sanitary sewer to the local Publicly Owned Treatment Works (POTW). The 
treatment consisted of filtering the water through a series of two 500-pound granular activated 
carbon (GAC) vessels temporarily set up at the site. Prior to the aquifer test, Shaw obtained 
approval to discharge to the POTW from Suffolk County Department of Health Services 
(SCDHS). 

On April 27, 2001 a representative from SCDHS collected one sample of the discharge effluent. 

3.1.2 Background Water Levels and Meteorological Data 
To determine if changes in water levels observed during the aquifer test could be attributed to 
pumping or non-pumping conditions, meteorological data from the National Weather Service 
(NWS) station located at Farmington, NY, approximately four miles west of the site, was 
monitored. During the aquifer test, approximately 0.02 inches of rain fell the evening of April 24, 
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2001. Prior to the aquifer test, rainfall had not fallen for 3 days. Thus, recharge due to rainfall is 
not believed to have affected the results of the aquifer test. Because the aquifer is unconfined, 
barometric pressure changes do not affect the aquifer response to pumping. 

A summary of meteorological data is provided along with the gauging results in Appendix A. 

3.2 Aquifer Test Pumping 

The aquifer test was initiated on April 24, 2001 at approximately 6:35 PM. The initial 2.5 hours 
of the test was conducted as a step-drawdown test to assess the well efficiency and to 
determine the optimal pumping rate for the threeday aquifer test. The initial pumping rate was 
30 gpm, which was maintained for a period of 60 minutes, followed by a pumping rate of 
approximately 40 gpm, which was maintained for a period of 95 minutes, followed by a pumping 
rate of 50 gpm which was maintained for the duration of the test. The pump was shut down at 
approximately 1:30 PM on April 27, 2001. 

Pumping rates were assessed by monitoring a flow totalizer installed in-line after the GAC 
vessels. Pumping rates were controlled by adjusting a ball valve located in-line between the 
pumping well and the GAC vessels. 

'L 
Because flow rates were measured downstream of the GAC vessels, flow rates were slow to 
stabilize due to pressure effects in the GAC vessels. As a result, pumping rates fluctuated for 
approximately 10 minutes until an accurate flow reading could be obtained at the desired 
pumping rate. This is evident in the early timedrawdown (displacement) graphs shown in 
Appendix B. Flow stabilization based on the meter reading was difficult during this time 
period. The effect is also more noticeable due to the logarithmic scale on which the data is 
analyzed. Therefore, the early time-drawdown data were not weighted as heavily in the curve 
matching analysis. 

The pump was periodically shut down (for approximately 5 minutes at a time) to refuel the 
generators. This occurred approximately once every 5 hours. There was some difficulty 
restarting the generator at approximately 1 :I 5 AM on April 26, 2001. This resulted in the pump 
being non-operational for approximately 35 minutes at 1,800 to 1,900 minutes into the test, 
during which time the water levels rebounded (See time-drawdown graphs in Appendix B). 
Upon restarting this pump, water levels quickly returned to their previous lower levels. The total 
downtime of the pump over the three-day aquifer test amounted to less than one percent of the 
operational duration of the test. Based on the observation well data, these shutdowns did not 
have a significant effect on the results of the aquifer test. 
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3.3 Aquifer Test Monitoring 

Throughout the aquifer test, water levels in five adjacent monitoring wells (MW-2A, MW-3A, 
MW-4A, MW-9 and MW-H) were measured with a pressure transducer and datalogger. Data 
was recorded on a schedule of decreasing frequency. Measurements were initially collected 
approximately once every 2 seconds. After forty seconds of measurements, the interval 
between measurements was increased by a factor of 1.06 until a final interval of one 
measurement every 10 minutes was reached. This frequency of measurement was maintained 
until after pumping had been discontinued. Prior to turning off the pump at the end of the 
aquifer test, all on-property wells were manually gauged to assess the influence of pumping 
across the site. 

At approximately 8:00 AM on April 27, 2001 a truck drove across the cable to MW-9, moving the 
pressure transducer and thus making subsequent data acquired at that location unreliable. 
Data from monitoring well MW-H were considered not useable. All other data were considered 
accurate and reliable. 

The time-drawdown and recovery data for each observation well are included in Appendix B. 
The variables shown in the solution section of the data sheet represent the following aquifer 

C characteristics: transmissivity (T), storativity (S), specific yield (Sy), and the compressibility of 

the water (P). Transmissivity (T) is the measure of the amount of water that can be transmitted 
horizontally through a unit width by the full saturated thickness of the aquifer under a hydraulic 
gradient of one. Specific yield (Sy) is the ratio of the volume of water that drains from a 
saturated rock owing to the attraction of gravity to the total volume of the rock. Storativity (S)  is 
the volume of water that a permeable unit will absorb or expel from storage per unit surface 
area per unit change in head. 
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3.4 Aquifer Test Data Analysis 

The following sections describe the procedures used to analyze the data collected during the 
aquifer test activities and their results. The data was analyzed by graphical curve matching 
methods. Due to the initial instability in the pumping rate (see Section 3.2) when the pumping 
rates were adjusted, curve matching focused on data from after the first 10 minutes of the 
pumping test. 

3.4. I Data Analysis Methodology 
The time-drawdown data from all wells with measurable drawdowns attributable to the aquifer 
test was plotted on graphs with logarithmic axes and graphically analyzed by the Neuman 
method for unconfined aquifers (1974), utilizing an aquifer test analysis software package 
(AQTESOLV for Windows by HydroSOLVE, Inc.). The Neuman method was utilized since the 
circumstances associated with the pump test correlate to the assumptions assumed in the 
Neuman method (unconfined aquifer, vadose zone has no influence on the drawdown, the 
drawdown is negligible compared to the saturated aquifer thickness, can model wells that 
partially penetrate the aquifer, etc.). Documentation for the software and description of the 
basis for the analytical solutions supported by it are provided in Appendix C pages 66 through 
73. The equations associated with the Neuman method can be referenced in Appendix C, 

pages 66-68. The variables are defined on page 109. 

The assumptions used to graphically analyze the aquifer test data in order to determine the 

transmissivity (T), storativity (S),  specific yield (Sy), and compressibility of the water (P) 
included: 

1. An infinite, homogeneous (isotropic), unconfined aquifer with a uniform thickness of 70 
feet, underlain by an impermeable bed (clay) with an initially horizontal water table within 
the zone of influence of the test; 

2. Partial penetration of the aquifer by the monitoring wells and pumping well; 

3. Partially penetrating extraction and observation wells with negligible water storage 
capabilities in the well; and 

4. Unsteady flow to the pumping well. 

These assumptions are believed to be appropriate for the site. The sand aquifer is as 
homogenous as any naturally occurring aquifer. The clay layer was encountered at 
approximately 85 feet below ground surface at all borings advanced that deep at the site. The 
water table is generally horizontal (a gradient of approximately 0.001 5 based on the ROD), 
relative to the drawdown generated during the pumping test (greater than 20 feet in MW-10 and 
over 0.3 feet at the nearest monitoring wells). 
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3.5 Aquifer Test Results 

After 67 hours of pumping, drawdown in the pumping well was approximately 22.29 feet. 
Drawdown in the observation wells ranged between 0.09 feet and 0.35 feet. 

Analysis of the pumping test data yielded values for transmissivity (T) and specific yield (Sy) for 
each well that exhibited greater than 0.3 feet of drawdown. These data are presented in Table 
3-1. Hydraulic conductivity (Kh (feetlday) = T (square feet)/b (ft)) values were obtained from the 
transmissivity (T) values by assuming a constant saturated thickness (b) of 70 feet across the 
aquifer. A horizontal hydraulic conductivity (Kh=T/b=9,594/70=137 feetlday) was calculated for 
the area surrounding MW-10. This value is typical for the geologic material. This horizontal 
hydraulic conductivity was calculated as the arithmetic mean conductivity, since it is assumed 
that all flow between these wells was parallel to the geological bedding. 

There was no apparent correlation between aquifer response and direction from the pumping 
well. This isotropic behavior is typical for an aquifer comprised primarily of alluvial outwash 
deposits (sand). The Neuman method allows the calculation of the vertical to horizontal 
hydraulic conductivity ratio, based on the P-value used to obtain the best curve fit. 

where 

P - - compressibility of the water (l/(lb/feet squared)); 
r - radial distance (feet); 
Kv = vertical hydraulic conductivity (feetlday); 
b - - aquifer thickness (feet); and 
Kh = hydraulic conductivity (feetlday). 

Based on the results of this analysis, the vertical to horizontal hydraulic conductivity ratio is 
approximately 1:l. This isotropic behavior is not uncommon for clean alluvial outwash sands. 
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3.6 Pumping Rate Determination 

To begin the design of the groundwater extraction and treatment system, the pumping rate 
necessary to achieve containment of the VOC plume was calculated based on hydrologic and 
contaminant concentration data obtained from the pump test and monitoring activities. The 
analytical solution used in this calculation and the results are discussed below. 

3.7 Pumping Rate Determination Methodology 

3.7.1 Analytical Solution Method 
An analytical solution described by Keely and Tsang (1 983) and developed further by Erdmann 
(2000) was used to calculate the pumping rate necessary to generate a capture zone of a 
specified width (i.e., extent in the cross-gradient direction). This calculation was performed for 
two pumping systems, one to contain groundwater crossing the National Heatset property and 
another to contain the down-gradient groundwater plume. The results and an example of the 
calculations are presented in Table 3-2. Appendix D contains a copy of the journal article 
describing the analytical solution. 

The calculation performed is based on complex potential theory (e.g., flow net mathematics) for 
steady flow in an isotropic, homogeneous aquifer. The maximum width of the capture zone was 
calculated, assuming steady-state flow conditions, according to the following equation (Keely & 
Tsang, 1983): 

where 

W,,, = width of capture zone infinitely up-gradient of the pumping well (feet); 
Q = flow to well (feet3/day); 
K = average hydraulic conductivity (feetlday); 
i = hydraulic gradient (feetlfoot); and 
B = thickness of the aquifer. 

The width of the capture zone at the pumping well (Erdmann, 2000) is calculated as 

*L 
where 
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Wo = width of capture zone at the pumping well (feet). 

The calculations for the down-gradient groundwater extraction system assume that three wells 
will be placed along Benjoe Drive and Albany Avenue to intercept the plume. The width of the 
plume (Table 3-2) at that location was assumed based on the groundwater data collected in 
1998 by H2M. To account for continuing plume dispersion, the width was assumed to be 133% 
of the maximum width of the 1.0 mg/L isopleth for total VOCs in groundwater at 75-85 bgs 
(H2M, 1998, Figure 4.3). Additional groundwater data was collected in July 2002 by Shaw and 
was utilized to adjust the downgradient treatment system data presented in Table 3-2. The 
older and current versions have been included in Table 3-2 for comparison. The location of any 
wells along Benjoe Drive and Albany Avenue are not expected to interfere with the production 
capacity of the Albany Avenue public water supply wells due to the fact the wells are in different 
aquifers. The public supply wells are located in the Magothy Aquifer and the pumping wells will 
be in the Glacial Aquifer. Appendix D contains a copy of the journal article describing the 
analytical solution. 

3.7.2 Pumping Rate Determination Data 
The hydraulic conductivity of the aquifer was obtained from the average value calculated in the 
pump test analysis. Given the relatively consistent geology at the site, the use of the aquifer test 
data to describe down-gradient hydraulic conductivity is believed to be appropriate. The aquifer 
thickness was assumed to be a constant 70 feet and the gradient to be 0.001 8, based on the 
most recent round of groundwater gauging conducted on August 8, 2001. This gradient was 
estimated using gauging data from the National Heatset property wells, as well as down- 
gradient wells M-I I and M-12. Because these data points are situated longitudinally to one 
another, there is some uncertainty regarding the calculated gradient. However, this uncertainty 
is somewhat lessened because they are situated along the inferred axis of migration of the 
plume (i.e., roughly along the hydraulic gradient). 

Because the chemical concentration data previously available for the down-gradient portion of 
the site was several years old (1 998), a simple calculation was performed to estimate plume 
migration. The plume configuration from the most heavily impacted depth interval sampled (75 
to 85 feet below ground surface) was used as a basis for this calculation (see H2M, February, 
1999 Figure 4.3). The calculation was conservatively performed without consideration of 
contaminant retardation to help ensure that the well locations selected for the groundwater 
extraction system were sufficiently down-gradient to effectively capture the contaminant plume. 
The calculation performed was: 
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where 

x = distance plume has migrated (feet); 

n = effective porosity of the aquifer (assumed to be 0.25); and 

t = elapsed time (days). 

Based on this calculation it was estimated that the plume had migrated approximately 1,350 feet 
downgradient between August 1998 and September 2001. Appendix E, Tab 1 presents the 
calculation of this distance. This distance of migration would put the leading edge of the 1 mg/L 
isopleth of the plume approximately 100 feet upgradient of the proposed Benjoe Drive and 
Albany Avenue extraction well locations. In July of 2002, a groundwater sampling event was 
performed to further characterize the location of the off-site plume. Analytical results from the 
2002 groundwater sampling event confirmed the calculated plume migration. The plume, as 
determined by 1998 groundwater date, and the proposed groundwater extraction well and 

'ru 
treatment plant locations are included in Figure 3-1. 

Figure 4.3 from the 1999 H2M report, which presents interpreted groundwater contaminant data 
as concentration isopleths, suggests that the width of the total VOC plume above 1,000 pg/L is 
approximately 1,150 feet across at its widest point. However, the July 2002 groundwater data 
suggests that the width of the total VOC plume above 1,000 pg/L is approximately 600 ft across 
at its widest point. For the purposes of assessing the pumping rate, in this final design report, 
the older groundwater data was used as a conservative measure and it was assumed that the 
total plume to be captured is twice this width at the most-down-gradient extraction well. 

3.8 Pumping Rate Determination Results 

Based on the site data and the calculations outline above, a total minimum groundwater 
extraction rate of approximately 79 gpm will be necessary to contain contaminated groundwater 
on the National Heatset Printing property. These calculations further indicate that a total 
minimum groundwater extraction rate of approximately 330 gpm will be necessary to obtain 
containment of the down-gradient plume. For the purposes of these calculations, it is assumed 
that, following treatment, this groundwater will be either discharged to surface water or re- 
injected into the aquifer in such a way as to not interfere with the capture of the plume. Final 
design pumping rates will incorporate an uncertainty factor to compensate for limited site data 
and to provide greater confidence that remedial goals will be met. 

N;/802901NHSlresponse to comment letterlfinal documentlfinal design report 



Downgradient Treatment System Project - Final Design Report 
National Heatset Printina. Babvlon. New York 

'cw 
As a check on the selected pumping rates, a calculation was performed to determine the total 
recharge to the calculated capture zones for each well. This calculation was based on the 
recharge entering the aquifer (Jensen and Soren, 1974), the width of the capture zone, and the 
distance up-gradient to the groundwater divide (Jensen and Soren, 1974). This calculation is as 
follows: 

where 

Q,, = the maximum sustainable flow rate in the absence of other pumping systems 
(feet3/day); and 

L = the distance up-gradient to the groundwater divide (feet). 

The results of this calculation indicate that the pumping system will not approach the capacity of 
the aquifer (Table 3-3). 
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4.0 REMEDIATION SYSTEM DESIGN CONSIDERATIONS 

The following section presents the remedial objectives for the Heatset site, the proposed 
treatment scenarios for the on-site and off-site portions of the aquifer, the design basis and 
criteria for the groundwater extraction and treatment systems, and the preliminary performance 
requirements for the in-well stripping system. 

4. I Remedial Objectives 

The proposed remedial designs and performance requirements presented in this report, will 
meet or exceed the remediation goals as set forth in the 1999 ROD. These goals are: 

Meet all Standards, Criteria, and Guidance (SCGs) 

Be protective of human health and the environment 

Eliminate, to the extent practicable, ingestion of groundwater affected by the site that 
does not attain NYSDOH drinking water standards; and 

Eliminate, to the extent practicable, further off-site migration of groundwater that does 
not attain NYSDEC Class GA Ambient Water Quality Criteria. 

w 
4.2 Proposed Treatment Scenarios 

The proposed treatment scenarios presented in this section follow a two-tiered approach to the 
on-site and off-site aquifer remediation. Two scenarios for each portion of the aquifer are 
presented. The first scenario requires the use of an in-well stripping remediation system for the 
on-site and off-site plumes, while the second scenario requires the use of a groundwater 
extraction and treatment system for the on-site and off-site systems. This approach was chosen 
to allow the NYSDEC flexibility should they be unable to obtain competitive reasonable cost bids 
for the in-well stripping technology. Should the lowest responsible bidder utilize the in-well 
stripping well technology, then that vendor would be given the opportunity to demonstrate the 
effectiveness of this chosen technology. If the technology does not meet the performance 
requirements, then the lowest responsible bidder utilizing the groundwater extraction system 
would be awarded the contract. 
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4.2.1 On-Site Groundwater Aquifer Remediation 
The proposed on-site groundwater remediation scenarios are as follows: 

Scenario 1: Two to four in-well stripping wells, adjusted based on the radius of influence 
determined from the pilot test results, would be installed in the upper aquifer at the 
downgradient edge of the on-site plume to remediate any remaining groundwater contamination 
after the source area remedial action. The wells would have the appropriate off-gas treatment. 
The in-well stripping wells create an elliptical groundwater circulation zone surrounding the well. 
The groundwater circulation well uses a screened well and a drop tube to create the circulation 
zone. Air is injected at the bottom of the well via the drop tube, which is installed inside the well 
casing, The air forms bubbles, which flow upwards within the casing, displacing water and 
reducing the density of the water column within the well. These air bubbles also effectively strip 
the volatile contaminants from the water column and transfer them to the air stream within the 
well. Air emitted from the wells is monitored and exhausted to an appropriate air treatment 
system prior to being discharged to the atmosphere. 

Scenario 2: Two groundwater extraction wells will be screened in the upper aquifer at the 
downgradient edge of the on-site plume to contain and remediate any remaining groundwater 
contamination after the source area remedial action. The groundwater treatment system is 
designed to treat 100 gpm of contaminated water (150% of the 66 gpm pumping rate). The unit 
operations identified for the treatment plant are oxidation and sedimentation of metals, air 
stripping of volatile organic compounds and activated carbon polishing of effluent water. 
Treated groundwater would be discharged to a local retention basin. 

4.2.2 Off-site Groundwater Aquifer Remediation 
The proposed off-site groundwater remediation scenarios are as follows: 

Scenario 1: In accordance with the ROD and to be verified during the pilot test based on the 
proven radius of influence, approximately six to nine in-well stripping wells would be installed in 
the upper aquifer at the 10 part per billion (ppb) edge of the off-site plume to protect the Suffolk 
County Water Authority Albany Avenue well field. The well system would have appropriate off- 
gas treatment. The in-well stripping wells create an elliptical groundwater circulation zone 
surrounding the well. The groundwater circulation well uses a screened well and a drop tube to 
create the circulation zone. Air is injected at the bottom of the well via the drop tube, which is 
installed inside the well casing. The air forms bubbles that flow upwards within the casing, 
displacing water and reducing the density of the water column within the well. These air 
bubbles also effectively strip the volatile contaminants from the water column and transfer them 
to the air stream within the well. Air emitted from the wells is monitored and exhausted to an 

21 appropriate air treatment system. 
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Scenario 2: Three groundwater extraction wells will be screened in the upper aquifer 
perpendicular to the down-gradient center axis of the off-site plume to protect Suffolk County 
Water Authority Albany Avenue well field. The groundwater treatment system is designed to 
treat 500 gpm of contaminated water (1 50% of the 340 gpm pumping rate). The unit operations 
identified for the treatment plant are oxidation and sedimentation of metals, air stripping of 
volatile organic compounds, activated carbon polishing of effluent water, and catalytic oxidation 
andlor carbon treatment of off-gases. Treated groundwater would be discharged to a local 
retention basin. 

During the Final design effort, the off-site scenarios were advanced to the final level of 
engineering completeness based on discussions with the SCWA and NYSDEC regarding the 
off-site remediation plans for the extractionltreatment system. The off-site system has been 
finalized in this report as a result of the review and approval by the SCWA. 

4.3 Design Basis For In-Well Stripping Systems 

Numerous investigations have been completed to evaluate the site geology, hydrogeology and 
groundwater quality at the site. This information, in conjunction with a pilot scale field test of the 
proprietary methodology, will be used by the equipment vendor to design an in-well stripping * system to meet the project Remedial Objectives. The in-well stripping system would include: 

Collection of groundwater within a stripping well 

Treatment of the groundwater to meet established remedial action criteria 

Discharge of the treated groundwater within the influenced area of the stripping well 

Collection and treatment of any gas generated that may contain site VOC 
contaminants without discharging to the atmosphere contaminants at or above 
regulated limits 

Treatment compounds for the air pollution control systems and other above ground 
appurtenances associated with the in-well stripping systems 

4.4 Design Basis for the Groundwater Treatment Plant 

Numerous investigations have been and are being performed to evaluate the site geology, 
hydrogeology, and groundwater quality at the site as well as appropriate treatment technologies. 
A database created as a result of these investigations, in conjunction with the ROD, has been 
used to develop a Basis of Design for remediation of the on-site and off-site contaminant plume. 
Based on the groundwater extraction and treatment scenario, each remediation system 
includes: 

*- 
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Extraction of groundwater from the upper aquifer 

Treatment of the extracted groundwater based on the most recent characterization data 
obtained during remedial and pre-design investigations to meet the established 
discharge criteria which involves metals removal and VOC removal from the extracted 
groundwater 

Discharge of the treated groundwater to a town sump (on-site) and recharge basin (off- 
site) 

Treatment of off-gas to remove VOCs transferred from the groundwater to the air (off- 
site only) 

Treatment compounds sized to house the process equipment components and 
associated appurtenances. 

4.4. I Extraction Well Network and Pumping Rates 
The extraction well network and pumping rate descriptions are specific to the pump and treat 
scenario. The configuration of the extraction well networks and pumping rates for the on-site 
and off-site extraction system have been based on the groundwater monitoring results, pump 
test data, and groundwater modeling results. The basis of design for this portion of the remedial 
systems consists of five criteria: 

b V  Capture of the remaining on-site plume to prevent further migration and remediate, to 
the extent practical, the aquifer to groundwater quality standards. 

Capture the off-site plume to protect the Suffolk County Water Authority Albany Well 
Field. 

Balance of the well locations (number of wells) and flow rates for efficient plume 
recovery. 

Minimize the impacts to the surrounding area. 

Allowance for up to 50% increase in the overall groundwater extraction flowrate. 

Based on the groundwater extraction system analysis, the on-site extraction system will consist 
of two extraction wells placed at the downgradient edge of the on-site plume ( Figures 4-1 and 
4-3). These wells will each have a nominal pumping capacity of 50 gallon per minute (gpm). 

The off-site extraction system will consist of three extraction wells placed along Benjoe Drive 
and Albany Avenue well field (Figures 4-2 and 4-4). Two wells will have a pumping capacity of 
125 gpm, while the third will have a pumping capacity of 250 gpm. 

4.4.2 Influent Characteristics 
To develop the design criteria for the groundwater extraction and treatment plants, influent 

w characteristics of the extracted groundwater were estimated. As a conservative measure, the 
maximum known concentrations in the groundwater were used in the design process. Table 4-1 
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provides the influent characteristics from the on-site plume (July 26, 2001 sample event) and 
off-site plume (1999 ROD maximum concentrations and July 2002 sampling event). 

4.4.3 Groundwater Treatment System Performance Requirements 
The primary objective of the on-site groundwater extraction and treatment system is to prevent 
further off-site migration of the VOC plume and to remediate any remaining VOC contamination 
after the source area remedial action. This objective will be met by the installation of two 
groundwater extraction wells at the downgradient boundary of the Heatset property that are 
designed to extract the necessary groundwater and transport it to the on-site treatment system. 
The proposed system shall capture the migrating plume and remediate the aquifer to 
groundwater quality standards (Table 4-2). All off-gases generated by the groundwater 
extraction and treatment system shall meet NYSDEC DAR-1 (formerly Air Guide-1) discharge 
requirements (Table 4-3). 

The primary objective of the off-site groundwater extraction and treatment system is to prevent 
further off-site migration of the VOC plume and protect the Suffolk County Water Authority 
Albany Avenue Well Field. This objective will be met by the installation of three extraction wells 
along Benjoe Drive and Albany Avenue just north of the Albany Avenue well field that are 
designed to extract the necessary groundwater and transport it to the off-site treatment system. 
The system shall capture the migrating plume and protect the Albany Avenue Well Field and 
treat the extracted groundwater to New York State groundwater standards (Table 4-2). All off- 
gases generated by the groundwater treatment system shall meet NYSDEC DAR-1 (formerly Air 
Guide-1 ) discharge requirements (Table 4-3). 

Each of the groundwater treatment systems will follow the following performance requirements. 

Removal of VOCs will take place in an air stripper. A downstream liquid-phase granular 
activated carbon system will be used to polish the air stripper effluent to ensure compliance with 
the NYSDEC SPDES discharge permit (or permit equivalence). These units have been proven 
effective in removing contaminants of concern at and exceeding the estimated influent 
concentrations. An air stripper off-gas treatment system will be provided as necessary to meet 
the NYSDEC DAR-1 (formerly Air Guide -1) air discharge requirements. 

Metals removal (iron pre-treatment) will be accomplished by oxidation/sedimentation. 
Precipitation of metal hydroxides will be achieved by chemical oxidant addition and pH 
adjustment. The precipitated metals and suspended solids will settle out in an inclined plate 
clarifier. This system will minimize fouling of the downstream air stripper, thereby ensuring 
reliable treatment of the VOCs. 

*. 
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The performance of the final treatment systems will be monitored as required by the substantive 
requirements of a NYSDEC SPDES permit. The groundwater extraction systems shall be 
designed to operate on a continuous basis (24 hourslday, 7 dayslweek) and will be automated, 
requiring minimal operator attendance under normal operating conditions. Sludge generated 
from the metals removal process will be disposed of off-site, requiring periodic operator 
intervention. 

Equipment shall be provided in duplicate, where appropriate, so that the on-line spares will 
provide for unintempted service. The treatment systems shall be provided with an alarm and 
telemetry system such that system upsets are identified to the operator for immediate response. 

The goal for the final groundwater treatment systems is to maintain uninterrupted groundwater 
extraction and treatment operation. However, it may be necessary to reduce the throughput to 
perform pretreatment or sludge handling tasks, routine, preventative maintenance or equipment 
change out. In some cases, it may be necessary to shut down the system for maintenance. 

4.4.4 Permitting Requirements 
Although permitting requirements are waived as part of the inactive hazardous waste disposal 

bf 
site program, the substantive requirements of the following permits will be met: 

SPDES water discharge permit (on-site and off-site treatment systems) 

Exhaust and Ventilation system permit 

Building Permit 

4.4.5 Residual Waste Streams 
The major waste stream to address is the VOC laden off gas from the air strippers. The air 
strippers are designed to effectively meet the remedial objectives and produce the minimum 
volume of off gas for treatment. Based on the on-site air stripper off-gas dispersion modeling 
the emissions are within DAR-1 guidelines and do not require off-gas controls. However, the 
off-site treatment system (in-well stripping or extractionltreatment) will have a design included 
for pollution abatement equipment at the request of the SCWA. The prime choices are vapor 
phase carbon or an oxidizer (thermal or catalytic). Either of these choices are provided as 
equipment packages, available from vendors experienced in their design, fabrication, 
installation, startup and O&M. For the final design, vapor phase carbon has been selected for 
the off-site treatment system, (refer to Section 7.4). 

Secondary waste streams include metal hydroxide sludge, sand filter media, and spent bag 
filters. Both waste streams will be disposed off-site as solid wastes. 

N:1802901NHSlresponse to comment lenerlfinal documentlfinal design report 



Downgradient Treatment System Project - Final Design Report 22 
National Heatset Printing, Babylon. New York September 7, 2004 

w 
4.4.6 Retention Basin Design Basis 
On-site treated water will be discharged to the ground surface of a town sump west of the site. 
See Figure 4-3. The Town of Babylon Public Works Department has approved of this 
discharge location. 

Off-site treated water will be discharged to the local recharge basin to be constructed in close 
proximity to the proposed location of the off-site treatment system. The retention basin will be 
approximately 2,000 square feet in size and will include sufficient capacity for the 500-gpm 
maximum discharge rate. Refer to Figure 4-4. 

4.4.7 Treatment System Enclosure 
Year round operation of the treatment system requires protection from the elements and climate 
control within a suitable, permanent structure. The anticipated footprint of such a structure to 
house the equipment components, control area, and floor sumps for the treatment of on-site 
influent water system is estimated at 30-feet by 65-feet. Thus, the design basis of a 1,950 
square foot permanent structure dictates a pre-engineered metal building on a slab-on-grade 
over other types of structures such as fabric buildings, greenhouses, or modularized trailers. Its 
location has been finalized during this phase of design as this is the smallest structure offered 
including iron pretreatment equipment. The building height of 18 feet has been designed to 
accommodate the cone bottom sludge thickener tank, which establishes the highest clearance. 
An elevation detail of the on-site treatment compound is illustrated in Figure 4-5. As a result, 
utility requirements, well locations and discharge locations have all been finalized and are 
shown on the final design drawings. 

The anticipated footprint of such a structure to house the equipment components, control area, 
and floor sumps for the treatment of off-site influent water system is estimated at 85 feet by 67 
feet. Thus, the design basis of a 5,695 square foot permanent structure dictates a pre- 
engineered metal building on a slab-on-grade over other types of structures such as fabric 
buildings, greenhouses, or modularized trailers. Its location has been finalized during this 
phase of design as this is the smallest structure offered including iron pretreatment equipment. 
The building height of 17 feet has been designed to accommodate the inclined plate clarifier, 
which establishes the highest clearance. This is the lowest profile possible to comply with the 
aesthetic demands of the SCWA and surrounding residences. An elevation detail of the off- 
site treatment compound is illustrated in Figure 4-6. As a result, utility requirements, well 
locations and discharge locations have all been finalized and are shown on the final design 
drawings. 

Several vendors offer a "Butler" type of metal building, where the pre-engineering is the 

w responsibility of the building vendor. The specifications and resultant shop drawings for these 
building will then become part of the Contract Documents. The materials of construction 
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availability and building erection implementation easily fall within the timeframe of an extraction 
and treatment system installation. From a cost perspective, this type of structure is cost 
effective on a cost per square foot basis. The installation of the pre-engineered buildings will 
follow National Building Officials & Code Administrators (BOCA and local building code 
ordinances, including Suffolk County Sanitary Code - Article 12, Appendix F). 

The treatment compounds for in-well stripping equipment will be designed to fit into modularized 
containers for the pilot testing. Based upon the pilot test results, the containers can be reused 
or added to in modular fashion for the full-scale in-well stripping scenarios, once the pilot test 
has been completed and the contractor has provided the full-scale design plans. 

4.5 Other Design CriteriaIConsiderations 

A listing of important design considerations not covered previously in this section that will impact 
the design of the groundwater treatment plant (GWTP) includes the following: 

The operating life expectancy of the GWTP and in-well stripping systems will be 30 
years. 

All piping will be buried below the frost line for freeze protection. 

Secondary containment for the treatment equipment tanks, vessels, etc., will be 
designed into the building foundation. 

Materials of construction will be compatible with the fluids to be handled. 

The electrical classification is non-hazardous (unclassified) both outdoors and within 
the treatment building. Hence, explosion proof equipment is not required. 

Unattended operation to the greatest extent possible, for 24 hours per day. 
Reduction in the hours of daily operation by half has also been considered. (12 
hours). Low maintenance equipment preferred. 

Limited form of remote telemetry via an Autodialer. 

The delivery approach shall be design-bid-build. 

As off-gas treatment requirements change more rapidly with time compared to water 
treatment requirements; consider rentllease options for off-gas equipment 
components. Modular containers would be included in the rent/lease option for in- 
well stripping. 

Innovative alternative technologies have been explored but will not be utilized. 

Electric utilities, and service (clean) water will be required to operate the treatment 
systems. No other utilities are required. 

Article 12 shall be the design basis for indoor storage tanks and secondary 
containment features. 
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5.0 PERFORMANCE REQUIREMENTS FOR RECIRCULATION WELLS 

5.1 On-Site In-Well Stripping System 

The primary objective of the on-site in-well stripping system is to prevent further off-site 
migration of the VOC plume and remediate any remaining VOC contamination after the source 
area remedial action. This objective will be met by the installation of stripping wells at the 
downgradient boundary of the Heatset property. It is the vendor's responsibility, with 
Department approval, to determine the number of wells, their design, their location, and their 
depth. The vendor proposed system shall capture the migrating plume and remediate the 
aquifer to groundwater quality standards (Table 4-2). All off-gases generated by the system 
shall meet NYSDEC DAR-1 (formerly Air Guide-1) discharge requirements (Table 4-3). 

51.1 Pilot Test Requirements 
Prior to the installation of the vendor specified system, the vendor shall be required to install and 
operate one of the vendor designed in-well stripping wells at the Heatset property to 
demonstrate that the well system will meet the site performance standards. Primarily, this will 
be determined by the collection and analysis of water samples. The design of the pilot test will 

'rr 
be presented in a workplan prepared by the vendor. Upon approval of the workplan, 
incorporating the Department's comments, the pilot test will be performed and a report will be 
written, which documents the pilot test activities and presents the preliminary design for the full 
scale systems. The pilot test must meet the following minimum requirements: 

Demonstrate horizontal influence in the aquifer at a designated minimum radius 
away from the stripping well through use of acceptable groundwater tracer 
compounds (chemical dyes or equivalent). 

Demonstrate vertical influence in the entire depth of the groundwater aquifer through 
the installation of nested monitoring wells at various depths in the aquifer. Two 
zones (shallow; from the water table interface to depth 45-feet below ground surface 
and deep; from 45 feet to a depth of 80 feet below ground surface) of measurement 
will be used at a minimum. Tracer compound, or other acceptable monitoring 
devices, must be used to demonstrate the influence. 

Demonstrate effective treatment of the water to the criteria shown in Table 4-2 in the 
stripping well through collected and analyzed groundwater samples. 

Demonstrate effective collection and treatment to the criteria shown in Table 4-3 of 
any gas from the stripping wells through the collection and analysis of air samples. 

Demonstrate treatment of the groundwater influenced by the in-well stripping system 
by the collection and analysis of groundwater samples collected from both the 
shallow and deep zones in the aquifer. 
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Demonstrate effective operation of the in-well stripping equipment in terms of fouling 
by evidence of reductions in removal efficiencies or desired throughput should 
buildup occur. 

The test results will provide information to calculate the actual contaminant removal rates and 
ensure that the system will be able to achieve groundwater quality standards throughout the 
impacted aquifer. The pilot test data will also be used to delineate the wells' area of influence. 
If these parameters differ from the original vendor specified parameters, the vendor shall modify 
the design as necessary to meet the required remediation goals. This test will be performed 
over a 60-120 day period, to be agreed upon by the NYSDEC and the vendor (60-90 days for 
installation and operation and 30 days for preparation of final report). All costs for this test shall 
be born by the vendor, it shall not be included as a line item in the bid. If the vendor is approved 
to install the full-scale remediatisn system, the NYSDEC will reimburse the vendor for the cost 
of the pilot test. 

5.2 Off-Site Recirculation Well System 

The primary objective of the off-site in-well stripping well system is to prevent further off-site 
migration of the VOC plume and to protect the Suffolk County Water Authority Albany Avenue 

L Well Field. This objective will be met by the installation of stripping wells at the 10 ppb iso- 
concentration contour. The in-well stripping system design will incorporate data gathered during 
the field pilot test. It is the vendor's responsibility, with Department's approval, to determine the 
number of wells, their location, and their depth. The vendor proposed system shall capture the 
migrating plume and protect the Albany Avenue Well Field. All off-gases generated by the 
system shall meet substantive NYSDEC DAR-1 (formerly Air Guide-1) discharge requirements 
(Table 4-3). 
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6.0 EVALUATION OF GROUNDWATER TREATMENT PLANT TREATMENT 

ALTERNATIVES 

This section identifies and describes potentially applicable process options for the groundwater 
extraction and treatment scenario and provides a screening of each option. The groundwater at 
the Heatset site not only contains elevated levels of VOCs, but it also contains elevated levels of 
calcium, iron, and magnesium, which could foul the treatment system. Therefore, process 
options for the treatment of metals and VOCs have been reviewed to select equipment 
components for final detailed design. 

6.1 Evaluation of Groundwater Treatment Process Options 

The purpose of metals removal is to protect downstream VOC removal equipment from fouling 
or scaling. Not only is this a maintenance issue, but coating and scaling of VOC removal 
equipment could lead to a reduction in removal efficiencies below that required to meet the 
remedial objectives and discharge requirements. 

Metals Removal 

Ir* 
Chemical Preci~itation and Sedimentation 
Chemical precipitation and sedimentation are the most common method of metals removal. 
Precipitation is the physicochemical process whereby some or all of a substance in solution is 
transformed into a solid phase. Precipitation is based on altering the chemical equilibrium 
relationship of the soluble inorganic species by shifting the equilibrium towards the solid phase. 
Lime soda softening and oxidation are the most common types of precipitation in water 

treatment. 

Lime soda softening refers to the addition of lime or sodium sulfide to the water in a rapid mixing 
tank along with flocculating agents. Within the rapid mixing tank and flocculation tank, adequate 
retention time is provided for the agglomeration of precipitate particles. The agglomerated 
particles are separated from the liquid phase by either sedimentation or filtration. Because iron 
is not effectively removed by softening, this type of chemical precipitation will not be retained. 

Metals may also be precipitated by oxidation. Oxidation of the soluble metals may be 
accomplished by aeration, chlorination, ozonation, or chemical oxidation with potassium 
permanganate or hydrogen peroxide. Chemical oxidation is the most common method of iron 
removal. However, potassium permanganate is the oxidant of choice for these reasons: 

N;1802901NHSlresponse to comment letterfinal documenthal design report 



Downgradient Treatment System Project - Final Design Report 27 
National Heaket Printing, Babylon, New York September 7.2004 

w 
The elimination of aeration reduces the volume of off-gas generated, and hence, 
reduces the cost for off-gas treatment more significantly than does the savings cost per 
pound of O2 delivered by aeration. 

Potassium permanganate has been proposed for in situ treatment of the source VOCs in 
the groundwater plume, hence, it has the potential to oxidize VOCs above ground in a 
continuous stirred tank reactor. 

Dry KMn04 is safer and easier to handle and store than hydrogen peroxide. 

This process also alters the chemical equilibrium shifting the equilibrium to the solid phase. As 
with softening, agglomerated particles are separated from the liquid phase by sedimentation 
and/or filtration. Sedimentation is defined as the gravitational separation of particles from 
water. The primary purpose of sedimentation in groundwater treatment is to produce a clarified 
effluent for either discharge or further treatment. The removal of suspended particles by 
gravitational settlement is low cost and energy efficient. Sedimentation may be performed in 
sedimentation basins, plate separators, tube settlers, or clarifiers. To economize on space in 
the building, the most cost-effective sedimentation equipment is the inclined plate clarifier. 
These units are readily available and typically, there is suspended solids carryover of 
approximately 5 to 10 mg/L in the clarified water. Thus, filtration is required to remove the 
carryover solids to protect the downstream equipment from fouling. 

Filtration is a physical process where suspended solids are removed from the liquid phase by 
passing the liquid through a porous media. Granular filtration is the most typical type of 
filtration. The filter media generally consists of a bed of granular particles, such as sand or sand 
with anthracite, supported by an underdrain within an enclosed vessel. The liquid passes 
through the filter media and is drawn off the bottom. The suspended particles are trapped on 
and within the filter media. The entrainment of particles within the bed reduces the filtration 
rate, thereby increasing the amount of pressure needed to force the liquid through the filter. In 
order to prevent plugging of the filter, the filter is backwashed at a high velocity to dislodge the 
particles. The backwash water then flows through a sludge dewatering system for final 
disposal. Filtration units typically require a large amount of space. Because of the anticipated 
space limitation in the groundwater treatment plant, the technology will be used to process carry 
over of solids but will not be retained for dewatering the metal sludge. 

Another type of filtration, bag filtration, uses a fabric or non-woven material to remove micron 
sired particles. In general these filters are used in line or in series as polishing unit operation. 
This technology is being used as an effluent stream polishing step. 

In summary, metals removal will be achieved by designing unit operations and process 

'C 
equipment that will raise the pH of the influent water and chemically oxidize the dissolved 
metals into metal hydroxide sludge. Caustic Soda (25% NaOH) is commonly used to raise the 
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pH of influent groundwater and similarly, chemical oxidation via Potassium Permanganate has 
been selected for the site because it is effective, economical to use, and readily available. 

Volatile Organic Compounds Removal 

Mass Transfer - Air Strip~inq 
Air stripping is a proven mass transfer technology for removing volatile organic compounds 
(VOCs) from groundwater. In an air stripping unit, the liquid is passed down over packing or 
trays while air is blown up through the liquid (countercurrent). The contaminants are transferred 
from the liquid phase to the gaseous phase as the air makes contact with the liquid. The 
packing or trays are used to increase the mass transfer between the air and liquid. Treated 
groundwater flows out of the bottom of the unit while the effluent gas is vented out of the top of 
the unit. The effluent gas may be vented to the atmosphere or to further treatment depending 
on contaminant concentrations. Air stripping is a cost effective and efficient means of removing 
contaminants with a Henry's Law Constant greater than 3E-3 atmosphere-cubic meters per 
mole (atm-m3/mole). The Henry's Law Constants for the site-related contaminates are as 
follows: 1 , l  -Dichloroethene (0.19 atm-m3/mole), 1,2-Dichloroethene (6.7E-2 atm-m3/mole), 1,2- 
Dichloroethane (9.1 E-4 atm-m3/mole), 1 ,I,  1-Trichloroethane (0.03 atm-m3/mole), Vinyl Chloride 
(8.1 E-2 atm-m3/mole), Trichloroethene (9.1 E-2 atm-m3/mole), Tetrachloroethene (l.53E-2 atm- 
m3hole). The primary compounds of concern, PCE, 1,2-DCE and TCE all have favorable gas 
constants indicative of good removal using air stripping. The compound exhibiting the least 
favorable gas constant, 1,2-DCA, will still strip, but not as well as the other compounds listed. 
Based on reported influent concentrations both on site and off site, 1,2-DCA is below the 
discharge standards and is thus not a primary compound of concern, (see Appendix E, Tab 2). 

A low-profile tray stripper is preferred over the packed column to minimize the height of the 
building. Moreover, the trays are designed to accept a higher solids loading before fouling 
interferes with VOC removal and to ease the maintenance requirements for cleaning once 
fouled compared to the packed column stripper. 

Adsor~tion - Granular Activated Carbon 
Granular activated carbon (GAC) is effective in removing a wide range of organic compounds. 
The activated carbon selectively adsorbs organics from the liquid phase by a surface attraction 
phenomenon (Van der Walls theory) in which organic molecules are attracted to the internal 
micropores of the carbon granules. The adsorption rate is controlled by the molecular attraction 
between the adsorbate and adsorbent, the molecular weight of the adsorbate, and the surface 
area of the carbon. Appendix E, Tab 3 provides the supporting information and calculations 
that demonstrates the viability of utilizing GAC to remove the site-related contaminants 
(adsorbate). 
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GAC units operate in series or in parallel configurations. Operating the units in series is 
generally the most cost effective configuration and produces the lowest effluent concentrations 
compared to a parallel configuration. Once the GAC surface is equilibrated with the dissolved 
influent contamination concentrations, the carbon is considered "spent" and must be replaced or 
regenerated. Off-site regeneration is the preferred method. The time to reach "breakthrough" 
is a function of the adsorptive capacity of the carbon and influent concentration. Pretreatment 
steps such as air stripping can greatly enhance the carbon's life and reduce the need for 
frequent carbon replacement. This technology is retained as a polishing treatment for the 
primary VOC treatment, air stripping. 

Oxidation - Ultraviolet Liaht/Peroxide Svstem 
An ultraviolet lightlperoxide system uses hydrogen peroxide to oxidize the contaminants with 
ultraviolet light acting as the catalyst. The UV light converts the hydrogen peroxide into hydroxyl 
radicals, which are a strong oxidant. The hydroxyl radical then oxidizes the VOC contaminants 
into inert compounds. Rrocess variables include UV energy dose, hydrogen peroxide dose, pH 
level, temperature, and mixing efficiency. Bench-scale studies are generally required to 
estimate these quantities and the size of the reactor. 

w In this process, water is pumped through a heat exchanger that regulates the inlet temperature. 
Hydrogen peroxide is injected into the line as the water enters the reactor, which is equipped 
with UV light lamps. As the water passes through the reactor, the contaminants are destroyed 
and the effluent is discharged. The operational costs associated with a UVIperoxide system are 
high due to the great amount of energy required to operate the system. Metals are also 
damaging to the system, therefore, significant metals pretreatment would be required. In 
addition, suspended solids limit the effectiveness of the UV lamps over time by coating them. 
Due to these reasons, this unit operation is not retained. 

Off-Gas Treatment 

Carbon Adsor~tion 
Carbon adsorption is one of the most commonly used and cost effective off-gas treatments for 
the reduction of VOC emissions, with granular activated carbon the most widely used form of 
carbon. As with the liquid phase carbon adsorption system, the physical principal behind the 
carbon adsorption is the Van der Walls attractive potential between the adsorbate and the 
adsorbent. Again, as with the liquid phase system, the adsorption rate is controlled by the 
molewlar attraction between the adsorbate and adsorbent, the molecular weight of the 
adsorbate, and the surface area of the carbon. For gas phase carbon adsorption, contaminants 
must have a molecular weight between 50 to 200 grams per gram-mole for efficient adsorption. 
Generally, if the influent gas stream concentration of total VOCs is more than 1,000 parts per 
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million volume (ppmv) then other thermal or catalytic oxidation systems may be more cost 
effective. 

GAC units typically operate either in series or in parallel configurations. Operating the units in 
series is generally the most cost effective configuration and produces the lowest effluent 
concentrations compared to a parallel configuration. Once the micropores are saturated, the 
carbon is considered "spent" and must be replaced or regenerated. Off-site regeneration is the 
preferred method. The time to reach 'breakthrough" is a function of the adsorptive capacity of 
the carbon and influent concentration. 

The carbon technology is retained for VOC emission control. 

Catalvtic Oxidation 
Catalytic oxidation, also known as catalytic incineration, is a commonly applied combustion 
technology for controlling VOC ernikions from waste streams. In catalytic oxidation a 
contaminant laden waste stream is heated with auxiliary fuel to between 600 and 900" F. The 
waste gas is then passed across a catalyst where the VOC contamination reacts with oxygen to 
form carbon dioxide, water, and hydrochloric acid. The effluent gas is then passed through a 

w heat exchanger and hydrogen chloride scrubber to reduce the gas temperature and remove 
hydrochloric acid prior to discharge. This option is a cost effective and efficient method for 
treating high VOC concentration streams. This technique has been eliminated during the Final 
design phase. 

6.2 Summary and Selection of Chosen Groundwater Treatment Process Options 

Based on the review and evaluation performed in the previous section and considering the 
remedial objectives and the design basislcriteria established. the following process equipment 
options were selected for the groundwater treatment systems that primarily consist of Metals 
Removal (M), VOC Removal (V) and Polishing/Discharge/Residuals Management (PIDIR) unit 
operations. 

Chemical Oxidation with a chemical oxidant for iron and heavy metals removal (M) 

Clarification and Sedimentation (M) 

Filtration for removal of solids before air stripping process (M and R) 

Air Stripping for VOC removal (V) 

Bag filtration to protect downstream equipment (M and V and R) 

Granular Activated Carbon for air stripper effluent polishing prior to discharge (P and , 
D) 

Carbon adsorption for air stripper off-gases (D and R) - (off-site only) 
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Off-site disposal of the generated metal sludges (R) 

N;1802901 NHSlresponse to comment letterlfinal documenUfinal design report 



Do~gradient Treatment System Project - Fmal Design Report 32 
National Heatset Printing, Babylon, New York September 7, 2004 

(Isr. 
7.0 FINAL GROUNDWATER TREATMENT SYSTEM DESIGN 

The groundwater extraction rate for the on-site system was designed for a nominal flow rate of 
100 gpm and a maximum design flow rate of 120 gpm for some of the equipment, while the off- 
site system extraction rate was estimated at 500 gpm and the equipment was sized 
appropriately for that flow. These extraction rates are 150% of the calculated extraction needed 
to contain the plume. This allows for system flexibility should the system need to be updated in 
the future. The influent contaminant cdncentrations used are those presented in Section 4.3. 

In order to eliminate long transmission pipe runs, the need for additional pump stations, and the 
commingling of waters with significantly different chemicalltreatment demands, the extracted 
groundwater will be processed through two separate treatment plants. One plant will be located 
on-site to treat the on-site contaminant plume. The second system will be located off-site at the 
downgradient edge of the off-site plume to treat the off-site contaminant plume. Treated 
groundwater from the on-site system will be discharged to a town sump and the discharge from 
the off-site system is proposed to go to a recharge basin to be constructed on the Suffolk 
County Water Authority property. The locations of the on-site treatment building, recovery wells 
and discharge point are shown on Figure 4-3. Figures 4-2 and 4-4 show location of the 
treatment building, recovery wells and discharge point for the off-site system. 

Calculations that show the size of a new recharge basin required for the off-site discharge are 
presented as Appendix E, Tab 1.4 

The sections that follow describe the unit processes that will be used based on the anticipated 
influent concentrations, assumed discharge limits, the other design criteria and design basis 
established from Section 4.4, and equipment selection criteria from Section 6.1. 

7.1 Unit Processes 

An overview of the on-site and bff-site extraction and treatment system unit processes are 
I 

illustrated in the Process Flop diagrams (PFDs) Figures 7-1, 7-2 and 7-3 for the on-site 
treatment system and Figures 7-4, 7-5 and 7-6 for the off-site treatment system. The following 
groundwater treatment sy~tem unit processes are common to the on-site and off-site systems: 

t 
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Groundwater Extraction (2 wells for on-site treatment, and 3 wells for off-site 
treatment) 

Equalization 

Metals removal consisting of: pH adjustment, chemical oxidation, filtration 

Multi-media filtration 

Air Stripping 

Bag Filtration 

Liquid-Phase GAC adsorption 

Discharge to a town sump (on-site) and a recharge basin (off-site) 

Off-gas treatment (off-site system only) 

Sludge storage, dewatering and disposal 

The major equipment components involved in each unit operation (100 and 500 gpm) are 
summarized as follows: 

1. Electric submersible pumps, buried pipe, and pipe manifold. 

2. HDPE Equalization tank with a mixer for 100 gprn system and gravity feed to an 
'C oxidation tank. (Two Equalization Tanks for 500 gpm system) 

3. HDPE Oxidation tank with mixer with gravity overflow to the lnclined Plate Clarifier, and 
chemical metering pumps for delivery systems for caustic and potassium permanganate. 

4. lnclined Plate Clarifier (IPC), sludge pump and cone-bottom sludge storage tank with 
clarified gravity overflow to a surge tank. 

5. Polymer Feed System for coagulation and precipitation of metal hydroxides in the IPC. 

6. Pressure Filter to remove carryover solids before the air stripper. 

7. Low profile tray-type air stripper with a blower and discharge pump for 100 gprn system 
(Two strippers in parallel for 500 gprn off-site system). 

8. Bag Filter Assemblies for removal of carried over suspended solids. 

9. Discharge stack for the on-site treatment system and Granular Activated Carbon (GAC) 
Adsorbers for polishing the air stripper off-gas for the 500-gpm system. (Note: Emissions 
from the 100gpm system do not require carbon system.) 

10. Treated Water HDPE Storage Tank with backwash supply pump, backwash hold tank 
and backwash transfer pump for 100 gprn system. (Two Treated Water HDPE tanks for 
500-gpm off-site.) 

11. One discharge pump and buried piping to the town sump for the on-site treatment 
system and to the SCWA recharge basin for the off-site treatment system. 

The unit processes selected in this Final Design are low maintenance, field-proven, standard 
unit processes, for which there is significant performance data available for the capital 
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equipment selected. The following subsections provide a description of the equipment 
components needed for these unit processes, identify key design parameters needed, and 
present the rational for the selection of a particular type of process equipment for the on-site 
system. Appendix E, Tab 5 contains the calculations performed to select the various process 
equipment. The equipment descriptions follow the PFD drawings, Figures 7-1, 7-2 and 7-3 for 
the on-site process and Figures 7-4, 7-5, and 7-6 for the off-site system. Equipment sizes, type, 
capacities, Materials of Construction (MOC), etc, are shown on the P&IDs, Figures 7-8, 7-9,7- 
10 for the on-site system and Figures 7-1 1,7-12 and 7-1 3 for the off-site system. 

7 . .  Groundwater Extraction 
The on-site extraction system will consist of two extraction wells placed at the downgradient 
edge of the on-site plume (See Figure 4-3). These wells will each have a pumping capacity of 
50 gallons per minute (gprn). 

The off-site extraction system will consist of three extraction wells. One well will be installed 
along Benjoe Drive ( I  25 gpm), just west of the Albany Avenue Field, and two wells (1 25 gprn 
and 250 gpm) will be positioned along Albany Avenue (Figures 4-2 and 4-4). 

Optimum pipe sizes for this flow configuration of well laterals and headers were calculated and 
ly the calculations for each system are included in Appendix El Tab 6 for 100-gpm and 500-gpm 

systems. For the 100 gprn system, the laterals from individual extraction wells will be 2". For the 
500 gprn system, the laterals from the 125 gprn and 250 gprn extraction wells will be 3" and 4", 
respectively. The configuration also economizes on the trenching requirements to convey, via 
buried pipe, extracted groundwater to the treatment building that will house the process 
equipment. Extraction well details and cross sections of the extraction and discharge trenching 
are shown in Figures 7-14 and 7-15 for on-site and off-site systems. 

Each extraction well will be equipped with a submersible pump sized to provide the design well 
yield at the required total dynamic head, plus reserve capacity. Each well will be capable of 
meeting design flow rates with sufficient head to discharge to the groundwater treatment system 
without in-line boost pumps (see Appendix E, Tab 7). 

Each well will be metered with an automatic, continuous recording device that will measure to 
within + or - five percent of actual flow, as required by the necessary permits. Each well will be 
equipped with a manual flow control valve and readily accessible capped ports and drop pipes 
so that water levels may be measured under all conditions, as required. 
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7.1.2 Equalization 
The purpose of the equalization tank(s) in each system is to: (1) dampen any flow variations 
resulting from changes in groundwater extraction rates, and (2) blend the groundwater extracted 
from different wells at the site and other waste streams (building sump, off-spec treated water, 
etc.) such that the concentration of contaminants is uniform to the subsequent unit processes, 
and (3) begin the pH adjustment and oxidation reactions by introducing chemicals to this tank. 

The equalization tank will allow for a minimum of 30 minutes of residence time for attenuation 
and reaction. The equalization tanks for the on-site and off-site systems were designed with a 
1 .I safety margin. The residence time calculations are found in Appendix E, Tab 4. 

A tank agitator has been added to each tank to promote mixing of well water with the chemical 
additions. By adding the third function and the tank agitator, the reaction (oxidation) tank has 
been downsized. The equalization tank will be sealed and vented to minimize the emissions of 
VOCs into the treatment compound. 

A second equalization tank for the off-site treatment system is needed to lower the overall 
hydraulic profile, and hence, the overall height of the off-site pre-engineered metal building. 

'.rul 7.1.3 Metals Removal 
An oxidation/sedimentation process has been selected and designed that involves adding an 
oxidant source, KMn04, and raising the pH of the influent water using caustic soda (25%) for 
metal hydroxide precipitation of the dissolved iron and manganese. The Process Flow Diagram 
(PFD) indicates the use of metering pumps for the addition of NaOH to raise the pH to between 
6.3 to 8.2, and a solution of KMn04. 

To achieve the desired oxidation/sedimentation, oxidant and caustic are added and mixed by a 
tank agitator at the Equalization Tank. The Equalization Tank working volume of 4,000 gallons 
for the on-site system provides approximately 40 minutes of residence time at 100 gpm flow, 
which is sufficient to complete the reactions and attenuate the well waters. A total working 
volume of 18,000 gallons for the off-site system provides 36 minutes of residence time to 
complete the reactions and attenuate the off-site well water. To ensure complete pH adjustment 
and reaction, the residence time has been increased for both on site and off site systems by 
using an additional, small reaction tank, as a surge (oxidation) tank ahead of the IPC. At the 
Oxidation Tank, the residence time has been calculated at 5 minutes, and thus, the total 
reaction time for oxidation is 45 and 41 minutes. The reaction time for the off-site Equalization 
Tank and the Oxidation Tank has been calculated to be approximately 36 minutes. Appendix E, 

Tab 4 provides the calculations used to determine the tank size for the desired residence times 
for the equalization and oxidation tanks. The Equalization and Oxidation Tanks will be supplied 
with stainless steel offset angle type of mixers. 
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There are two chemicals fed into each Equalization Tank: potassium permanganate (KMn04) 
and 25% sodium hydroxide (NaOH) solution. KMn04 solution is pumped from the KMn04 
storage tank with a chemical metering pump. The 25% NaOH solution is pumped from a 120- 
gallon tote and 330gallon tote for the on-site and off-site systems, respectively. There are two 
stackable totes for each system providing 240 and 660 gallons of the chernical for each system. 
The bottom tote is stationary and the top tote is replaced when empty. 

The KMn04 tank capacities for the on-site (100 gpm) and off-site (500 gpm) treatment systems 
have been calculated to be 300 and 1,500 gallons, respectively. The metering pumps have 
been designed to pump at a maximum rate of 3.0 and 9.0 gallons per hour for the 100 gprn and 
500 gpm systems, respectively 

Based on the maximum 25% caustic feed rate of 5.6 gallons per day, the chemical stored in two 
120-gallon totes will provide approximately 42 days of capacity. For the off-site system, which 
requires a maximum caustic feed rate of 30 gallons per day, the chernical will be delivered in 
330- gallon totes (660 gallons total) to provide approximately 22 days of supply. 

All metals removal calculations are located in Appendix E, Tab 8. The basis for influent metals 
concentrations used in the metals removal process is presented as Table 7-1. 

7.1.4 Inclined Plate Clarifier 
Reacted groundwater is pumped from the metals treatment process to an inclined plate clarifier 
(IPC) where coagulant and flocculent aids are added and mixed in flashlfloc tanks ahead of the 
incline plate clarifier. lPCs are ideal for large GWPT systems because angled plates take up 
much less floor space than a typical, round clarifier in projecting the same square footage of 
collection area. The IPC selected for 100-gpm system is 7'-In' W x 15'-6" L x 8' H. The IPC 
selected for the 500gpm system has dimensions of 8'-6"' W x 26' L x 13' H. Additional height is 
required for removal of the plates for cleaning. Each IPC is equipped with three small tanks: 
500-gallon (ON-SITE) and 2,500-gallon (OFF-SITE) oxidation, flash mix and floc tanks. The 
three ON-SITE and OFF-SITE tanks have dimensions of 7'-1 "W x 6'-OnL x 9'-O"H and 8'-6""W x 
1 8'-OnL x '-1 3'-O"H, respectively. Additional KMn04 is added to the oxidation tank to ensure 
complete oxidation of dissolved metals. The neat polymer is added at a 5-ppm dosage to the 
flash mix tank at a rate of 0.6 gallons per day for the 100-gpm system and 3.0 gallons per day 
for the 500-gpm system. The actual type of polymer and dosage will be determined during the 
system startup by performing jar tests. The Flash Mix and Floc tanks are designed for a 
minimum of 5-minute residence time. 

Sedimentation of the metal hydroxides (along with solids) is promoted by these agents. 
Optimum types and dosage of polymer is achieved through jar testing of representative 
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groundwater samples or during startup of the extraction and treatment system. Generally, for 
adequate flocculation of metal hydroxides, anionic polyacrylamide polymers are used in the 
range of 2 - 20 ppm depending upon groundwater (influent) characteristics. For sizing 
purposes in the final design, 5 ppm polymer was chosen. The metering pumps used to inject 
pre-diluted polymer have turndown ratios of up to 100:l and can readily handle a 2 - 20 ppm (or 
greater) range of polymer treatment. 

The resultant metal hydroxide floc drops to the bottom chamber of the IPC as sludge for 
collection and residuals management. Clarified water, with the dissolved metals of concern 
removed, overflows by gravity to a 1,700-gallon or 7,500-gallon IPC Surge Tank (for 1 OO-gpm 
and 500 gprn systems, respectively), located after the IPC, and then is pumped to the next unit 
process operation - VOC removal. 

Thus, a potassium permanganate reaction tank with agitator, flash mix tank, and floc tank, 
followed by the lnclined Plate Clarifier as a packaged unit have been sized for the removal of 
iron (and manganese) to levels below the discharge limits and for reliable operation of the VOC 
removal equipment at 100 gprn and at 500 gpm. The lnclined Plate Clarifier will be sealed and 
vented to minimize the emissions of VOCs into the treatment compound. 

(CI 
The calculations provided in Appendix E. Tab 8 include the rate of chemical addition for the 
total KMn04, polymer and caustic feeds for the 100 gprn and 500 gprn clarifiers. 

7.1.5 Multi Media Filter 
A multi media filter will be placed in line between the inclined plate clarifier and the VOC 
removal system. This filter has been sized to remove any carryover solids from the clarifier and 
provide minimum pressure drop across the system. Each sand filter is 48 inches in diameter by 
6 feet high for the 100-gpm system and 5 4  diameter by 10 feet 8 inches high for the 500-gpm 
system. Each filter system requires a periodic backwash cycle. Both filter assemblies will be 
skid mounted and pre-piped. Multi media filter technical information and product literature is 
included in Appendix E, Tab 5. 

The backwash cycle for the 100 gprn system involves dual filter vessels: one is always on line 
during a backwash cycle of the dirtiest filter vessel. Backwash water is supplied from the 
treated water storage tank and backwash pumps. Refer to the P&IDs. Regular treatment 
operation continues with filtration occurring in the "standby" cleaner filter vessel and subsequent 
VOC removal proceeds normally after the vessel switch is made. 

The backwash cycle for the 500 gprn system involves triple filter vessels filtering 165 gprn of 
water each. When the dirtiest filter reaches its differential pressure set point the backwash cycle 
begins. The automatic valves switch out the dirty vessel for backwash and feed forward filtered 
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water is split between the filter vessel to be backwashed and the air stripper. The split is 
approximately 50150. Thus, 250 gpm of water is remediated of VOCs (uninterrupted) and 250 
gpm of filtered water is used for backwash. 

7.1.6 Air Stripping 
A low-profile air stripper will transfer the VOCs in the groundwater to an air stream created by 
the stripper blower. The air stripper selected for the 100 gpm system is designed for 53 to 1 air 
to water ratio to remove the VOCs in the liquid stream to below the discharge criteria. Two air 
strippers in parallel are needed to handle the 500 gpm design flow. Each of the two air strippers 
for the 500gpm plant is designed to handle 250 gpm at an air to water ratio of approximately 54 
to 1. The mass balance calculations performed for the ON-SITE and OFF-SITE systems are 
based on the influent contaminant concentrations as listed in Table 4-1 and the discharge 
criteria listed in Table 4-2. QED Environmental lnc. 6-tray air stripper (QED) and two North East 
Environmental Products (NEEP) 5-tray air strippers (for on-site and off-site, respectively), will 
reduce the VOCs in the liquid stream to levels below the water discharge permit requirements. 

Calculations of the off-gas VOC concentrations for the 100-gpm air stripper, and the pair of 250- 
gpm strippers, indicate that no additional off-gas treatment is necessary. For the discharge air 
permit calculations, it is assumed that all of the VOCs are stripped from the water to the off-gas 

*r stream. Two vapor phase carbon vessels placed in a series arrangement were added to the 
500-gpm air stripper off-gas discharge to remove VOCs prior to the discharge to the 
atmosphere at the request of the SCWA. VOC-laden off-gas will be directed to the off-gas 
treatment units described in Section 7.4. 

All calculations and supporting documentation utilized to finalize the number of trays, air to liquid 
ratios, and operating parameters for the 100-gpm and 500-gpm air strippers can be referenced 
in Appendix E, Tab 2. 

7.1.7 Filtration 
To protect the liquid GAC vessels from fouling, the air stripper effluent is first pumped through 
bag filters to remove additional solids generated by aeration or pH changes. Two duplex bag 
filter assemblies are recommended for continuous operation of the treatment train for the 100- 
gpm system. Only one set of two bag filters arranged in series will be on line at a time. The bags 
will be changed periodically. 

The filter housing holds standard 30-inch long bags. Thus, each dual assembly (two bags) will 
provide approximately 8.8 ft2 of filtration surface area. The optimize bag micron size will be 
determined during and after start-up to balance particulate removal with O&M bag change out * frequency. 
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Rosedale Duplex Model 22 bag filter (or equal) with automatic sequenced backwashing was 
selected as the most representative process option for filtration equipment in the 500-gpm 
system. Each bag filter assembly is designed to process up to 800 gpm and contains four filter 
bags. The 30-inch standard bag size provides 17.6 ft2 of filtration area per filter housing. The 
two filters will be run in parallel. When the bags in one filter assembly become dirty and need to 
be changed, the total flow of 500 gpm can be processed through one bag filter., The optimized 
bag micron size will be determined during and after start-up to balance particulate removal with 
O&M bag change out frequency. For more information on the bag filter selection see Appendix 
E, Tab 5. 

7.1.8 Process Pumps 
Per the P&ID figures, the calculation set was performed to site and select other process pumps 
for both the on-site and off-site treatment systems (see Appendix E, Tab 9). Total dynamic 
heads (TDHs) and motor sizes for these transfer pumps are summarized in a table at the end of 
Appendix E, Tab 9. 

7.1.9 Liquid Phase Carbon Polishing 

w To ensure complete compliance with substantive surface and groundwater discharge permit 
requirements, carbon filters serve as final polishing units. Should there be a stripper upset or 
shutdown for minor repairslcleaning, the carbon will continue to remove VOCs. In the polishing 
mode, carbon filters installed in a lead-lag, reversible arrangement of two carbon filters in series 
works most effectively. When there is evidence of breakthrough in the lead vessel, the carbon 
filters are reversed before the carbon change out occurs. When the carbon is changed, the 
filters will be reversed again once breakthrough is monitored after the lead vessel. 

For the 100gpm system, each carbon vessel is filled with approximately 3,000 Ibs of carbon. 
The two carbon vessels selected for the 500gpm system contain approximately 10,000 Ibs of 
carbon per vessel. Liquid phase carbon usage calculations are located in Appendix E, Tab 3. 

7.2 Pre-Engineered Metal Buildings 
The pre-engineered metal buildings for the on-site and off-site treatment systems will house all 
the process equipment to provide freeze protection. Each building shall include, at a minimum, 
the structural frame, foundation, metal walls, sloped roof system including gutters, trims, 
flashing and downspouts, vents, interior and exterior doors and windows, electric space heating 
system, internal and external lighting system, cables, conduits, switches and power distribution 
systems, and building exhaust units. The height of each treatment building has been 
established by the tallest equipment component. This is illustrated in the hydraulic profiles * developed for the 100 and 500-gpm treatment systems, Figures 7-16 and 7-17. 
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The control room area (office space) will be equipped with a unit air conditioner, baseboard 
heat, ventilation, window and lighting. HVAC system for both treatment buildings' main floor 
areas have been designed for proper ventilation and sufficient heat for freeze protection. Only 
the office area will be heated and air conditioned to office conditions (see Appendix E, Tab 12 
for building heat calculations). For the 100-gpm system, the electric motors are of small enough 
size to combine the motor control center and the process controls into one Main Control Panel 
(MCP). The MCP will consist of appropriately sized motor starters and the Programmable Logic 
Controller (PLC). For the 500-gpm system, the larger electric motors in this system require a 
Motor Control Center for power distribution to the motors. 

Equipment arrangemenuplant layouts are shown in Figures 7-18 and 7-19 for the on-site and 
off-site systems. Single line electrical diagrams are shown in Figures 7-20 and 7-21, 
respectively. 

Roadworthy containers will be used to house the off-gas equipment associated with in-well 
stripping. Each modular container will be designed using the same HVAC guidelines as for 
ventilating and heating pre-engineered buildings. If space allows, there will be a separate area 
divided off in the container for the system controls and to serve as an office area for one person 
with heating and cooling. 

w 
7.3 Residuals Management 

Sludge from the bottom of the IPC units will be pumped out periodically using an air-operated 
diaphragm pump. Evacuated sludge from the 100-gpm IPC will fill a 2,500-gallon cone bottom 
Sludge Holding Tank and a 7,500-gallon tank will collect sludge from the 500-gpm IPC located 
at the off-site facility. The sludge for disposal may contain residual VOCs and will need to be 
tested to determine the type of waste. The sludge holding tank has been sized to fit within the 
treatment compound and afford up to 7 days of storage time for the on-site facility and 5 days 
for the off-site system. The sludge from each sludge holding tank will be disposed of off site 
using a truck service. While the sludge settles in this tank, water will be decanted continuously 
by gravity for recycling to the Equalization tank. The sludge holding tank will also receive GAC 
and sand filter backwash water from the backwash holding tank when these units are 
periodically backwashed. Space has been reserved for the addition of a filter press at the off- 
site treatment compound because its use could be justified by lower disposal costs if the volume 
of sludge is reduced. This would be evaluated as part of the startup or acceptance of the 
installed treatment systems. 
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7.4 Off-Gas Treatment 

Based on air modeling performed for the on-site and off-site treatment systems, the air 
discharge stripper concentrations are low enough to be discharged directly into the atmosphere 
without any additional treatment. However, the off-site system will require an off-gas treatment 
system, at the request of the SCWA. The off-gas treatment system will consist of two vapor 
phase carbon vessels placed in a series arrangement. The carbon vessels are designed to treat 
combined emissions from the process vents and off-gas from two air strippers. The combined 
stream will be characterized by mass balance calculations for 25% of the maximum VOC 
concentrations as a minimum threshold and at maximum (100%) concentrations at the same 
flow conditions. 

Each carbon vessel selected for the 500-gpm system contains 8,000 pounds of activated 
carbon. Based on the carbon usage calculations, shown in Appendix E, Tab 3,8,000 pounds of 
carbon should last approximately 41 days (or 82 days for 16,000 pounds total) before it is spent 
and needs to be replaced. 

EPA Screen3 was utilized to perform air discharge modeling for the on-site and off-site 
treatment systems. This model incorporates input parameters including but not limited to stack 
height, distance to receptor, treatment building height, stack exit velocity and urbanlrural 
dispersion option. Based on the air modeling, the on-site system will not require carbon for air 
discharge polishing. NYSDEC air emission standards will be met by utilizing a 1 ft. diameter 
stack with a total height of 26 ft. Air modeling performed for the off-site system indicated that air 
discharge polishing would not be required, depending upon the selection of the discharge stack 
height. However, air discharge polishing has been incorporated into the design of the request of 
the SCWA. The use of carbon for air discharge polishing resulted in a discharge stack height of 
30 ft according to air modeling. Air model runs and input parameters are included in Appendix 
E Tab 11. 

7.5 Process Control Description 

This section provides a preliminary description of the process controls and PLC system for the 
groundwater extraction and treatment systems. The goals of the system process control and 
automation are to minimize the operator's daily routine and to minimize the operator time on 
site. The system automation provided will help define the degree of operator attention required 
and the extent of on-site and remote data handling. The degree of operator attention is 
discussed in the following subsection. An overview of the Final design and the process controls 
is illustrated in the Process and Instrumentation Diagrams (P&IDs), Figures 7-8, 7-9 and 7-10 
for the 100 gpm system and Figures 7-11, 7-12 and 7-13 for the 500-gpm treatment system. 
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7.5. I General 
The process controls will be similar for the on-site and off-site treatment systems because they 
differ only in scale. The work related to the process control systems is beyond the scope of this 
final design report, but will include (but not be limited to) the supply, complete installation, and 
testing of: 

A microprocessor-based control system PLC to control and monitor the overall 
treatment system from the well fields to the final discharge of treated water. 

The specific control and data equipment to be used as shown in the final P&IDs. 

7.5.2 Major Equipment Controls 
A summary of the process control description is shown on the P&IDs for the Final design of the 
on-site and off-site extractionltreatment systems. Included in these details are the specifications 
for instrumentation, unit process alarms and safeguards, flow monitoring, feed rate adjustments, 
and interfaces with the PLC and autodialer. 

7.6 Degree of Operator Attention 

w 
The following is a preliminary description of required operator attention for the major unit 
process operations as presented in this design. 

ExtractionlCollection System 
Flow from the groundwater collection system (pump onloff operation) will be controlled 
automatically. Flow adjustments at each well will be controlled with manual valves. 

Equalization, pH Adjustment, and Chemical Precipitation 
Equalization requires operator attention to maintain the correct chemistry for the metals removal 
process. The chemical feed pumps will be automatically adjusted based on flow rate. However, 
if the water quality varies the operator must recheck the pH and oxidation dosages for optimum, 
cost-effective performance. In addition, the operator will also need to periodically check all of 
the chemical feed pumps, which will be controlled automatically through the use of controllers, 
using manual calibration techniques and routine maintenance, as well as routine maintenance 
to check the mixer operations. 

Other tasks requiring operator attention include: 

Refilling the chemical storage day tanks will be arranged by the operator 
'Cr 

Premixing of potassium perrnanganate solution, polymer drum deliveries and disposal 
will be arranged by the operator. 
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Scheduling delivery of the 25% NaOH solution in totes. 

Flocculation and Clarification 
The variable speed drive on the flocculating mixer requires manual adjustment to be set. 

Air Stripping 
Air stripping is fully automatic requiring minimal operator attention. A pressure wash of a 
removed tray will be required periodically. For the larger strippers, a dilute acid wash may be 
required after several pressure washes. 

Sand Filter 
The multi-media unit will have its own local controls for automatic operations including 
backwashing and vessel sequencing. The operator is to confirm that there is an adequate 
amount of treated water in the treated water holding tank and adequate storage in the sludge 
holding tanks before sand filter backwashing. 

Bag Filters 
Bag filtration is fully automatic requiring minimal operator attention. Bag filter replacements will 

P be the responsibility of the operator. 

Liquid and Vapor-Phase GAC Adsorbers 
Spent carbon change outs will be the responsibility of the operator. Backwashing of the liquid 
GAC will be operator-initiated and manually controlled. The operator is to confirm that there is 
an adequate amount of treated water in the treated water holding tank and adequate storage in 
the Backwash Holding and Sludge Holding tanks before initiating GAC backwashing. 

Discharge System 
The discharge system is fully automated requiring minimal operator attention. Liquid phase 
carbon may raise the pH of the polished water. To handle potential pH adjustment 
requirements, an automated acid feed system is included in the system as shown on the P&IDs 
(Figures 7-10 and 7-13 for the on-site and off-site systems, respectively). The operator is to 
manage the inventory of acid (supplied in drums). 

7.7 Residual Wastes Management 

Metals removal via oxidation/sedimentation is the most labor-intensive operation of the 
groundwater extraction and treatment systems describe in the previous sections. The sludge 

'rrv. 
holding tanks have been sized to hold approximately ten and eight days of metal sludge for the 
100 and 500 gpm systems, respectively. Filter bag changeouts by the operator would occur 
during any site visit. This will be less when sand filter and GAC backwashing occur. GAC 
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backwashing will occur infrequently, but there will be daily backwashing volume from the sand 
filters. The operator must carefully monitor and manage the sludge holding operation of filling, 
decanting, and evacuation. The operator frequency schedule described for Equalization, pH 
adjustments, etc., would be the same as described in Section 7.6, above; however, it may take 
longer to reach state or to convert from daily to weekly scheduling for the waste management 
operations. Furthermore, it may take an operator more than 8 hours per day at the start of 
operation to carry out metals removal along with the other standard operations. 

7.8 Monitoring 

Existing and proposed monitor wells will be used to monitor the performance of the extraction 
systems and document compliance with the groundwater quality objectives. The identification 
of existing wells and placement of proposed wells will be sufficient to monitor upgradient and 
down gradient water quality at each extraction system location. 

At the National Heatset property, existing monitor wells will be used upgradient of the area of 
influence of the extraction system wells. A new monitoring well will be placed downgradient of 
the extraction system wells, as shown in Figure 4-1 and 4-3. For the off-site treatment system, 

w one monitor well will be placed upgradient of the extraction system wells and two monitor wells 
will be placed downgradient of the extraction system wells, as shown in Figures 4-2 and 4-4. 

Monitor wells will be sampled quarterly for volatile organics and results will be reported to the 
NYSDEC. 
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8.0 SPECIFICATIONS LIST AND PROJECT SCHEDULE FOR DETAILED DESIGN 

8.1 List of Specifications for Detailed Design 

A list of the specification sections that are required for completion of the contract documents 
and to bid the construction of the groundwater extraction, treatment, and discharge systems are 
shown in Table 8-1. These specification sections have been selected based on the 
Construction Specification Institute Master ~orrnat-, 1995 edition. Each section is marked as 
applicable: 

to in-well stripping, 

to extraction and treatment (GW Pump and Treat) 

by building trade or craft (general, mechanical, plumbing or electrical) or 

8.2 Project Schedule 

The proposed implementation schedule is illustrated for the on site and off site extraction and 
treatment systems in Figures 8-1 and 8-2, respectively and for the in-well stripping system in 
Figure 8-3. The significant scheduling differences between the two approaches arise from the 
need to pilot test in-well stripping, and, the significantly longer construction schedule for 

'Ir, extractionltreatment. Pre-construction activities/deliverables are included in the implementation 
schedules. 
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Table 3-1 
Summary of Aquifer Pump Test Analysis Results 

National Heatset Printing 
Babylon, New York 

Monitoring 
Well 

AW-2A 
AW-3A 
AW-4A 
A W-9 

I I I I 

;eometric Mean: I I 9.574 1 137 1 0.16 1 

Maximum 
Drawdown 

(feet) 

iverage Values: 
Aedian Values: 

qotes: 
Hydraulic Conductivity (Kh) = Transmissivity (Ty Aquifer Thickness (b) 

ransmlsslvity solved by AQTESOLV computer program. 

lydraulic conductivity calculated based on average aquifer thickness of 70 feet. 

ipedfic yield was determined by the AQETSOLV program. 

lrawdown was recorded by the installation of transducers in each well. 

lata quality of fair or better was used In the calculation of average values. 

0.348 
0.339 
0.302 
0.727 

M:ll95repslHeatseV100% Design Table 3-1 

Estimated 
Transmissivity 

(feet"day) 

9,594 
9.759 

Page 1 of 1 

10,260 
8,764 
9,759 
777 

Estimated 
Hydraulic 

conductivity' 
(feetlday) 

137 
139 

147 
125 
139 
11 

0.18 
0.23 

Estimated 
Specific 

Yield 

Curve Fil 
Data 

Quality 

0.23 
0.23 
0.08 
0.20 

Good 
Good 
Fair 
Poor 





Calculation of Pumping Rate for Groundwater Extraction System Design 
National Heatset Printing Site 

Babylon, New York 

Downaradient Treatment Svstem l2OO2 Datal 

Gradient Z Pumping Pumping Maxlmum Upgradient 

I a te  I a te  Capture Width 
Spacing 

(fi31da~) (gpm)' (feet) (feet) 

Average 
Hydraulic 

Conductivity 
(feetfday) 

Downgradienl 
Capture 
Distance 

(feet) 

Notes: 

Gradient according to 2001 gauging data. 

Hydrauik conductivity value provided from Table 3-1. 

Hydraui~c conductivity is high range of conductivities calculated from pump test analysis. 

Aquifer thickness of site averages 70 feet. 

' [Gradlent x Hyd. Conductivity (Wdy) x Capture Width (ft) x Sat. Thickness (ft)] x 2= Pumping Rate (cubic Wdy) 

Width of site was assumed to be the maximum width of the 1.0 mg/L isopleth for total VOCs in groundwater at 75 - 85 feet bgs. (HZM,1999; Figure 4.3) 

Calculation of capture zone was performed using complex flow potential methodology (Keely & Tsang, 1983 and Erdman. 2000). 
Upgradient capture width and downgradient capture distance are presented to illustrate predicted extent of capture zone. 

Capture 
Width at 
Recovery 
Well (feet) 

Final Design Report - Tables 3-2 and 3-3x1s Table 3-2 

Saturated 
Thickness 

(feet) 
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Maximum 
Table 3 3  

Capacity of Aquifer within Groundwater Extraction System 
National Heatset Printing 

Babylon, New York 

Capture Zone 

Notes: 
' Taken from USGS, 1974. 

[Dist To Upgradient Dlvlde (ft) x Plume Wdlh (ft) x Recharge Rate (inlyr)] x [I (ftY12 (In)] x [l(yr)/365 (dy)] = Flow to Well (cubic feeffday) 

M:/l95reps/Heatset/100% Design Tables 3-2 and 33 Page 1 of 1 

Recharge 
Rate 

(incheslyear) 
25 
25 

Distance to 
Upgradient 

~ i v i d e '  
(feet) 
28,000 
28.000 

Available 
Flow to Welt 

Width of 
Plume 

(feet) 
450 

1.520 

(f t31day) 
71,918 

242.922 

( g ~ m )  
374 

1.262 



Table 4-1 
Estimated Influent Concentrations 

National Heatset 
Babylon, New York 

CHEMICAL OF CONCERN 

ONSITE 
ESTIMATED 
INFLUENT 

CONCENTRATION 
(U GIL) 

OFF-SITE 
ESTIMATED 
INFLUENT 

CONCENTRATION 
(UGIL) 

OFFSITE 
ESTIMATED 
INFLUENT 

CONCENTRATION 
2002 

(UGIL) 

On-site concentrations are estimated using the maximum concentrations detected during 
the July 26,2001 sampiing event. The off-site concentrations are estimated using the 
maximum concentmtions detected as reported in the 1999 Record o f  Decision. 
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Table 4-2 
Clean-up Criteria for Groundwater 

National Heatset 
Babylon, New York 

CHEMICAL OF CONCERN 

NA - Not Available 
- Values presented are for the trans 1,2-DCE isomer 

Shading indicates chosen clean-up criteria 
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CHEMICAL OF CONCERN 

Vinyl Chloride 
Trichloroethene 
Tetrachloroethene 
Hydro~en Chloride 

Table 4-3 
Offgas Discharge Requirements 

National Heatset 
Babylon, New York 

UUIUF;LINL 

CONCENTRATIONS NYSDEC I CONCENTRATIONS NYSDEC 
n A m  rl DAR-1 
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Table 7-1 
Influent Metals Concentrations Utilized in Metals Removal 

for Groundwater Treatment System 
National Heatset Printing 

Babylon, New York 

11 Data SourceMlell ID. 

Design Report 
RI Data 

Table 4.30 
MW-7 
MW-9 
MW-14 

Table 4.26 
MW-7 

lron 
Concentration 

Manganese 
Concentration 

MW-7A 
Suffolk County Data 

0.8 1 

Notes: 

Albany AW Well NO. 4~ 
Albany Ave Well No. 5 
Albany Ave Well No. 6 

lron concentration utilized in Design Report was determined by applying 
a 1.4 multiplier to the highest iron concentration observed in previous 
data. 
Manganese concentration utilized in Design Report was determined by 
applying a 1 .I 5 multiplier to the average manganese concentration 
observed in previous data. 

b 

m://l95reps/Heatseff 100% Design Table 7-1 

0.53 
0.53 
0.92 

Page 1 of 1 

0.01 
0.01 
0.03 
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Specification TitleITechnology Description 

I Section 01 71 0 I Site Restoration 

Section 01 700 

= e 
$2 .- 
5 2  * 

Contract Close-Out 

Section 021 10 

a iilii 4 . ~ .  
a''$ 

I= 5 5 3 a o o  
0 

Section 021 11 

Section 02200 

Section 02220 

X 

Clearing and Grubbing 

Section 02223 

Section 02225 

Section 02227 

, * e G m L  
m u *  

Z g E C  
+ g =  

X 

Excavation and Handling of Contaminated Material 

Earthwork Terms 

Excavation and Subgrade Preparation 

Section 02350 

Section 02401 

X 

Transportation and Disposal 

Trenching 

Section 0241 5 

3 
E s . 2  0 

z m r c  2 m *  

3 
, a p  

X 

X 

X 

X 

Sheeting and Shoring 

Section 02444 / Chain Link Fence and Gates 

a m .  m, 
E I , E  8 
a 3 ePZ 

I- E e I - S S & 3 0  

X 

X 

- -  
WastewaterIStormwater Management 

Section 02450 

X 

X 

X 

X 

X 

Section 02480 

- -- 

Page 2 of 6 
0 1 /O5  
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X 

X 

X 

X 

Waste Material Dis~osal 

X 

X 

Soil Erosion and Sediment Control 

Section 0251 3 

X 

x x 
X 

Dewatering 

X 

Topsoil and Seeding 

x 
X 

X X 

X 

Hot Mix Asphalt Concrete Pavements 

X 

X 

X 

X 

X 

X 
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Specification TitleITechnology Description 

Section 151 40 SUDDOI-~S. Anchors and Seals 

/ Section 161 00 ! General Electrical Reauirernents I 
Section 161 92 

Section 16400 

* In well stripping treatment contractors are forbidden to use pre-engineered or other types of permanent buildings, and 
shall use other more modular structures, e.g., sheds, sea-land containers, etc, to house above ground equipment 
components. 
The electrical contractor shall be responsible for the entire electrical installation. 

Section 1651 0 

Page 6 of 6 
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Programmable Logic Controtler 

Service and Distribution - Motor Control Centers 

Lighting Systems 
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55.5. 

,-,, 9 + MW-E 

C(W-F 
g MW-C 

LEGEND 

M W ~  DEEP MON1TORING WELL 

SHALLOW MONtTORlNG WELL 

@ SENTRY WELL LOCATLON (PROPOSED) 

IN-WELL STRIPPING TREATMENT AREA 

a EXTRACTION WELL LOCATIONS (PROPOSED) 

5 3  
SEDIMENT SAMPLE 

GP 
6 GEOPROBE POINT 

EDGE OF PAVEMENT 

CONCRETE 

... . . . . .. . .. -. . . .. . . .. . .. .. CURB 

DROP CURB 

BOLlARD 

. 7 ~ ~ ~ - - - r ~ ~ ~ L - . ~ ~ ~  WALL 

RAILROAD 

V X CHAIN LLNK FENCE 

LP 
P UTILITY POLE 

ANCHOR 

-. w-- OVERHEAD WIRES 

P $2 STANDPIPE 
CSS/iff 

CATCH BASIN FIELD INLET (DW=DRY WELL) 
U* 

MANHOLE 

SEWER MANHOLE 

UNDERGROUND SEWER (PAINT MARK) 

GAS METER 

UNDERGROUND GAS LINE (PAINT MARK) 

HYDRANT 

WATER VALVE 

UNDERGROUND WATER L h E  (PAINT MARK) 

UNDERGROUND ELECTRIC LINE (PAINT MARK) 

CONTOUR LINE (0.5' INTERVAL) 

I) HORIZONTN DATUM: N.Y.S. PLANE CODROiWTE SYSTEM. 
NMl 83. LOOlC ISUND ZONE 

2) VERTICAL DATUM: NGVD 1929 

3) DATE OF FIELD SURVEY. 6/25/97. 12/1/99. 4/18/01 

UW-C 1 59.56 1 59.28 1 59.56 1 
UW-E 1 59.52 1 59.24 1 59.52 1 
UW-F I 59.54 1 58.99 1 59.50 1 
UW-G 1 59.63 1 59.39 1 59.63 1 
UW-H I 58.04 1 57.77 1 58.04 1 

NOTE: 
U W - t i  IS AEOUT 1792' SOUTH ANO 418' EAST OF 

SOUTHERN MOST PLOTTED POINT. 
UW- 12 IS ABOUT 3665' SOUTH ANO 468' EAST OF 

SOUTHERN MOST PLOTT€O POINT. 

I PROPOSED RECOVERY WELL TABLE I 

PROPOSED SENTRY WELL TABLE 

1.0. NO. EASTING NORTHING 

4) LLL INVERT *NO PIPE ELEVATIONS SHOWN UEASURED AS 
WSiBLE AT TIME OF S u m .  OIRECTIOH IWD 1;ESTINATtON OF 
SOME PlPES NOT KNOWN OR DETERMINABLE F90U SURFACE 
OBSERVATIONS FIGURE 4-1 

I 

5) NO BENCHUARK IN VlClNlPI AVAILABLE WllH NAVD 88 
ELEVATIONS 

6) SURMY COMPLETED BY YEC. INC. Sh;lw'" Shaw Environmental & Infrastructure, Inc. 

t 
, 

NATIONAL HEATSET PRINTING 
5 b1/19/051 K I ~1 I TYI I FW 103% DL% OR-YTC: CONTFXT DOCVUEHT R M m  BABYLON. NEW YORK . . ------ 
a 1/35/04 m EW MI fw ~ O O X  DESIGN m-YE L U)NSTRUCT~H a t ~  DRIW DWWN BY DOWNGRADIENT TREATMENT SYSTEM PROJECT 

HD / DL FINAL 100% DESIGN REPORT DRAWINGS 
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1 12/18/02 IX EU EW ~ S X  DISCHUIGE MSGN TO ON-~TE.  RLTEWTION R E ~ T E D  WIN TREATYENT ELK. E wernberg IN-WELL STRIPPING TREATMENT AREA - ON-SITE 

I DRAWING NO 1 SHEET NO I REV NO 



FIGURE 4-2 

I S C A L E  

I 0 9a 
FEET d 

/ Shaw- Shaw Environmental & Infrastructure, tnc. 

GENERAL NDTES NATIONAL HEATSET PRINTING 

1 l H I S  DRAVING V A T  COMPILED FROM DRAWING NO XAM-638-1 
NORTH A H I T I V I L L E .  TOVU Of BABYLON' PREPARED B r  ALBERT f. TAGUE FINAL 100% DESlGN 
JR.  LAND SURVEYOR. 1 0 3 5 - A  MERRiCr R o a n .  COPAIGUE. M Y  

2 ALL E L t V A T l n N Y  RCTER TO USC AND GS D n r U n  

KFERENCE- 3 RE-CIKCUL"TIDN VELC LOCATIONS TO B t  DtrLRMlNEO BY CDNTRACTCR AND APPROVED BY NYSDEC 

W E  UIP W R C E :  
WFFOLU C O U N I Y  WATER AUTHORIPT. 
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LEGEND 

MWe DEEP MONITORING WELL 
$ SHALLOW MONITORING WELL 

@ PROPOSED SENTRY WELL LOCATION 

- SEDMENT SAMPLE 

GEOPROBE POINT 

- L -  EDGE OF PAVEMENT 
-. -- 

CONCRETE 
- 

- - - CURB 

-. . - --- DROP CURB 

BOLLARD 

---- - - WALL 
.. - 

- ----- RAILROAD 

- -- -- CHAJN LINK FENCE 

UTILITY POLE 

- - ANCHOR 

OVERHEAD WIRES 

STANDPIPE 

: CATCH BASIN FIELO [NLET (DW=DRY WELL) 

MANHOLE 

SEWER MANHOLE 

UNDERGROUND SEWER (PAINT MARK) 

GAS METER 

UNDERGROUND GAS LlNE (PAINT MARK) 

HYDRANT 

WATER VALVE 

UNDERGROUND WATER LINE (PAINT MARK) 

UNDERGROUND ELECTRIC LINE (PAINT MARK) 

CONTOUR LlNE (0.5' INTERVAL) 

EXTRACTION WELL. PROPOSED LOCATIONS 

GROUNDWATER TREATMEN; PLANT 
PROPOSED LOCATION 

1) HORIZONTAL OAWM: H.Y.S. PLANE COOROINATE SYSTEM, 
NPD 83. LONG ISLANO ZONE 

2) MRTIW M U M :  NCVU 1929 

3) DATE OF n a o  SURVEY: 6/25/47, iz/j/ga. 4/'8/0i 

WELL ELEVATION TMLE (In f a d )  

PROPOSED RECOVERY WELL TABLE 

1.0. NO. I EASTlNC I NORTHING 

PROPOSED SENTRY MU TABLE 

4) W INVERT W O  PIPE ELEVATIONS SHOWN MWUPED AS 
WSlBE Ar TlME OF S u m .  OIRECTION AND OESTIN4TlON OF 
SOME PIPES NOT KNOWN OR OETERMIWLE FROM SURFACE 
OBSERVATIONS FIGURE 4-3 

I 

5) NO BENCHMARK IN VICINITY AVAlLABLE WITH NAVD 88 
ELEJATlONS 





NOTES: 

PLAN VIEW 
SEE SHEET M - 3  FOR EQUIPMENT GENERAL ARFUNGEMENT 

WEST ELEVATION SOUTH ELEVATION 
su.LE: 1/a--1.-0- 

FIGURE 4-5 

Shaw- Shaw Environmental & Infrastructure, Inc. 
NORTH ELEVATION 

SOLE: 1/8-- 1 ' 4 -  

EAST ELEVATION 







T K - 5 4 5 0  B - 5 4 3 O A / B  
AIR STRIPPER BLOWER 

P - 5 4 9 0 A / B  
STRIPPER 

DISCHARGE PUMPS 

F-551 OA/B F - 5 5 1 1  A/B 
BAG FILTERS BAG FlLTERS 

T K - 5 5 5 0 / 5 5 5  1 
CARBON VESSELS 

T K - 5 5 6 0  P-5570 
BACKWASH HOLDING BACKWASH TANK 

TANK PUMP 

M - 5 5 6 0  
BACKWASH HOLDING 

TANK MIXER 

TO ATMOSPHERE TU 

L . .  - .  . - .  . - . - . .  - .  . - .  . _1 I 

I CARBON VENDOR 

I WKWASH SUPPLY 
FROM TK-5610 

TO SHEET TK-5610 P-2C 

NOTE: 
1. AIR STRIPPER PUMP P - 5 4 9 0 B  (SPARE) NOT SHOWN. 

DESIGN BASIS: 

1 0 0  GPM 

DISCHARGE CRITERIA: INFLUENT WATER QUALITY: 

TRANS 1,2 - D~CHLUKUL~HLNL 3 u ~ / L  - - 
1,2 - DICHLOROETHENE 0.6 ug/L  3.500 uq/L 
1,1,1, - TRJCHLOROETHENE 5 uq/L  -- 
VINYL CHLORIDE 2 uq /L  -- 
TRlrUl nRnFTUFNF 4 , ,n /I 

FIGURE 7-2 

A 
Shaw- shaw Environmental a Infrastructure, Inc 

I I OESIDNED BY: 
H. Dudek NATIONAL HEATSET PRINTING 

E Weinbsrg BABYLON. NEW YORK 

I 1 DRAW BY: 
DOWNGRADIENT TRE4Th4ENT SYSTEM PROJECT 
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P-5640 
METERING PUMP, ACID 

TK-56 10 P-5620Ah P-5630 
TREATED WATER DISCHARGE/RECYCLE S f ~ ~ & W $ ~ &  

TANK PUMPS 

FROM CARBON VESSELS 
SHEEl P-2B 

TO SHEET P-2A 

ACID STORAGE 

P-5640 

BACKWASH SUPPLY 
TO SAND FILTERS 

. 

NOTES: 

1. DISCHARGE PUMP P - 5 6 2 0 0  (SPARE) NOT SHOWN. 

BACKWASH SUPPLY 
TO CARBON VESSELS 

DESIGN BASIS: 

1 0 0  GPM 

DISCHARGE CRITERIA: INFLUENT WATER QUALITY: 

- -. - 

1,2 - DICHLOROETHENE 0 . 6  &/L 1 3 ,500  u a / L  
I ,  I ,  1 , - TRICHLOROETHENE 5 u q / ~  I -- 

1,1 - DICHLOROETHENE 5 U ~ / L  -- 

.,, 

TETRACH LOROETHENE 5 U ~ L  1 14,000 u q / L  

TRANS 1.2  - DICHLOROETHENE 5 u a / L  1 -- 

VlNYL CHLORIDE 2 u q / L  

TO TOWN 
100 GPM 

- - 

-- 

FIGURE 7-3 

SUMP 
TOTAL 

TRICHLOROETHENE 5 u a / L  

I A 
( Shawm Shaw Environmental & Infrastructure, Inc, 

6 5 0  ua /L  

TER EXlR4CTlON AND TREATMENT 
FLOW DIAGRAM - ONSITE 









CLOSED BALL VALVE 

W GATE VANE 

M CLOSED GATE VALVE 

CHECK V A M  

F-i DWHRAGM VALVE 

+ a u m m  VALVE 

GLOBE VALM 

CLOSED GLOBE VALM 

NEEDLE VALM 

PWGVALVE 

m CLOSED PLUG VALVE 

0 ROTARY VALVE 

3-WAY VALVE 

& 4-WAY VALVE 

AIR RELEASE VALVE 

DIAPHRAGM ACTUATOR 

DIAPHRAGM ACTUATOR 
WlTH POSmONER 

ELECTRIC MOTOR ACTUATOR 

PNEUMATIC ACTUATOR 

PNEUMATIC CYLINDER 
ACTUATOR 

REGULATOR WITH 
EKERNAL TAP 

SELF CONTAINED REGULATOR 

2-WAY SOLENOID 

3-WAY SOLENOID 

4-WAY SOLENOID 

PIPING 

MAlN PROCESS PlPlNG 

SECONDMY PROCESS PlRNG 

VENWR SVPPUEO 

UNE BREAK PlPlNG 
OR INSTRU~~ENTATION 

INSULATED PIPING 

W G E D  NOZZLE CONNECTION 

THREADED CAP OR 
CONNECTION 

TR4P 

NR €WINATOR 

POP DRAJN 

VACUUM BREAKER 

W P L E  PORT 

BUND FVWGE/FLANGES 

MREADED PlPE CAP 

DWHRAGM SEAL 

EDUCTOR 

EXPANSION JOINT - FLEXIBLE CONNECTION 

5 HOSE CONNECTION 

-c-- REDUCER (CONCENTRIC) 

---a--- REOUCER (ECCENTRIC) 

-7- SUP BLIND 

@ TIE-IN 

VENT STACK 
TO ATMOSPHERE 

-C--.CLL COMPR€SSED AIR LINE 

HOSE BIB 

-I[+ PlPE UNION 

) QUICK-DISCONNECT 

INSTRUMENTS 

PANEL MOUNTED INSTRUMEM 

PANEL MOUNTED [NSTRUMEM 
FOR mum (A)/ SPm (8) EPUIPIID( 

REAR PANEL MOUNTED 
INSTRUMENT 

L0CAu.Y MOUNTED 
INSTRUMENT 

INSTRUMENT WRNlSHED 
WTH EOUIPMENT BY VENDOR 

PLC 
CENTRAL 

PLC 
NON D l S P W  FUNCTION 

PLC 
BUND FUNCTION 

PLC 
LOCAL\HANUAL BACKUP 

PLC 
H: L: LOW HIGH ALARM ALARM 

LEML W G E  BOARD 
(WmtOUT S W )  

RESTRICTING ORIFICE 

VORTEX SHEDDING 
FLOW TRANSMrrlER 

TARGEI FLOW METER 

PirOT TUBE (OR ANNUBAR) 

TURBINE OR PROPELLER 
ROW SENSOR 

MAGNEW FLOW MEER 
(SENSOR ELENEM) 

PARSHALL FLUME 

INSTRUMENTS 

9 0 WEIR 

P O S l l M  DISPLACEMENT @ fLOW TOTMZING INDICATOR 

SONIC FLOW TPANSMlmR 

0 (DOPPLER OR TRANSZT TIME) 

+ S0.c n o w  m,, 

0 (DOPPLER OR TRANSIT TIME) 

v 
FLOW W G H T E N I N G  VANE 

dl PRESSURE GAUGE 

@ LOGIC FUNCTION 
S - SUM 

TWSDUCER FUNCTION 
R - RESISTANCE 
I - CURRENT 
P - PNEUWTIC 
MV - M I M C T S  

S/S START/STOP 

VS E N n s l V s ~ o p  

HM HAND OFF AUTOMATIC 

PB PUSH BmON 
EMERGENCY STOP 

xo ON/OFF 

m VARIABLE SPEED 

CENTRIFUGAL PUMP W / W E  
OR BLOWER WITHOUT W E  

- 
POSITIVE DISPLACEMENT METERING PUMP I t  
CONTAINMENT P U  

OR 
I I 
L---l CONTNNMENT DIKE 

a SUBMERSl8LE PUMP 

EXTRAClTON WELL WITH 
SUSMERSIBLE PUMP 

TANK AGITATOR 
NTH MOTOR 

- 
---- ELECTRICAL SIGNAL - 

M - 1 - 6 - 2  
U U V V  

EQUIPMENT COMPONENT SERES 
UNIT OPERAT3ON COMPONENT SEQUENCE 

PlPE MAERIAL 

SYMBOL SERYlCE 

CS CARBON STEEL 

PE POLYETHYLENE 

wc POLWlNn  CHLORIDE 
RH RUBBER HOSE 

SS STAINLESS STEEL 

HDPE HlGH DENSlTV POLYETHYLENE 

A 
Shaw- shaw Environmental & Infrastructure. inc. 

PIPING 
6'-CS-CW 
V U V  

%%%IZEJ 1 L 
PlPE UP.ER19L PlPE SCHEDULE 

fQUIPMFNT DESGNATIONS 

SYMBOL EQUIPMENT 

F BAG FILTER 

P PUMP 

TK TANK 

M MIXER 

IPC INCUNED PLATE CLARIFIER 
AC AIR COMPRESSOR 

FIGURE 7-7 
I 

N O T E  ALL  SYMBOLS MAY N O T  B E  USED. 

VEMURl ROW UEMENT 
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-1 
Extraction Pumps 

334 SS 
12s CPU 0 122 It. TDH 
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Figure 8-1 
National Heat Set Downgradient Project 

Implementation Schedule - On-Site - Extraction and Treatment 
September 2004 

Note: 1 . Off-site testing and startup is sequenced after on-site testing and startup because the same personnel will be involved in both sets of activities. 
2. Substantial completion occurs after successful completion of Equipment testing and Checkout (week 27). 



Figure 8-2 
National Heat Set Downgradient Project 

Implementation Schedule - Off-Site - Extraction and Treatment - 
September 2004 

Note: 1. Off-site testing and startup is sequenced after on-site testing and startup because the same personnel will be involved in both sets of activities. 
2. Substantial completion occurs after successful completion of Equipment testing and Checkout (week 28). 



Figure 8-3 
National Heat Set Downgradient Project 

In Well Stripping - Implementation Schedule 
September 2004 

Note: 1. Off-site testing and startup is sequenced after on-site testing and startup because the same personnel will be involved in both sets of activities. 
2. Substantial completion occurs after successful completion of Equipment testing and Checkout (week 57). 



Figure 8-3 
National Heat Set Downgradient Project 

In Well Stripping - Implementation Schedule 
September 2004 

Note: 1. Off-site testing and startup is sequenced after on-site testing and startup because the same personnel will be involved in both sets of activities. 
2. Substantial completion occurs after successful completion of Equipment testing and Checkout (week 57). 
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APPENDIX B 

WELL TEST ANALYSIS I TIME-DRAWDOWN CURVES 



Time (min) 

WELL TEST ANALYSIS . 
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Company: IT Corporation 
Client: NYSDEC 
Project: Nation3 Heatset. 
Test Location: Babvlon. NY 

Test h ate: ~pril24,2001 

SOLUTION - 

Saturated Thickness: 70. f t  
AQUIFER DATA 

WELL DATA 
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Company: IT Corporation 
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Project: National Heatset 
Test Location: Babylon, NY 
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Solution Method: Neuman 
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Solution Method: Neuman 
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Getting Started 

AQTESOLV for Windows Features , . 

AQWOLV for Windows is a powerful yet easy-tome tool for hydrogeologists that 
features a suite of analytical solutions for determining aquifer properties from 
pumping tests and slug tests. After first entering or importing data from an aquifer 
test. you can-access visual and automatic curve matching methods for confined, 
unconfined, leaky and fractured aquifers. Visual curve matching is analogous to 
uaditional methods of aquifer test analysis with graph paper and type curves. The 
sophisticated automatic curve matching feature enhances aquifer test analysis by 
providing greater objectivity and a detailed statistical evaluation of the resuIts. 
AQTESOLV for Windows also features many options for obtaining =port quality 
graphics to summarize the results of your analysis. 

Data Management 
AQTESOLV for Windows helps you manage aquifer test data with data manage- 
ment tools for entering, editing and importing data. Wizards guide you through the 
creation of data sets for pumping tests and slug tests. Error checking ensures 

- . consistent and complete data entry. Flexible specification of measurement units lets 
you enter data in English and meuic systems. Reaieval of data from a pressure 
transducer is easy using the Import Wizard in AQTESOLV for Windows. 

Visual Curve Matching 
The visual curve matching feature in AQTESOLV for Windows lets you analyze 
aquifer tests using the traditional method of matching type curves or straight lines 
ro time-displacement data measured during an aquifer test. 

with a pl6t of the data displayed on the computer screen, you can match a type 
curve to your data in an intemtive manner. By simply moving your mouse, you 
can move a type curveon the screen and watch AQTESOLV for Windows update 
the values of aquifer properties. 

Automatic Curve Matching 
The powerful automatic curve matching feature provided by AQTESOLV for 
Windows uses a nonlinear weighted least-squares parameter estimation algorithm to 
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match type curves or straight lines to time-displacement data measured during an 
aquifer test, 

The automatic curve matching feature minimizes the errors between the position of 
the type curve and your data and provides statistical measures of the type curve "fit" 
such as the precision of the estimated aquifer properties and error distributions. 

Statistical Analysis 
Automatic curve matching provides statistical criteria measuring the "fit" of a type 
curve to your data The statistics give you an objective basis for comparing the 
match of several different solutions to the same set of data 

Automatic curve matching computes standard errors of the estimated parameters 
that allow you to evaluate the precision of the parameter estimates and to construct 
approximate confidence intervals, Statistics for the model errors provide a basis for 
choosing between different aquifer test solutions that produce similar visual 
matches. 

Plots and Reports 
AQTESOLV for Windows helps you visualize the results of your aquifer test 
analyses by providing seven graphical representations. 

displacement us. time.plot 

composite plot 

residuals vs. time plot 

residuals vs. simulated displacement plot 

normality test for residuals 
. ~. 

derivative vs. time plot 

discharge vs. time plot 

In addition, AQTESOLV for Windows includes report options that document the 
contents of data sets and summarize the results of matching analytical solutions to 
data, 

complete aquifer test analysis report 

diagnostic statistics summary 

error log 

The error log feature enables you to quickly identify any deficiencies or 
inconsistencies detected in your data set 

Installation 
The AQTESOLV for Windows diskette proyided with this manual contains an 
installation program that prompts you for the destination directory for the program 
files, the type of installation you are performing, and the Program Group for the 
AQTESOLV for Windows icons. To install the program, perform the following 
steps: 

-- 
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Insert the prbgram diskette in a floppy drive (e.g., drive a:). 

Select Run... from the Flle k n u  and.enter the following commaird: 
a:setup center> 

The installation program prompts you to close any applications that 
are cumntly running. Click Continue to proceed or Exit Setup to 
close any currently running applications. 

When the installation program prompts you for a destination directory 
for the program files, choose the default path (Iaqtw) or click 
Change Directory ... to enter a different path. Click Contlnue 
when you have selected a destination directory. 

When the installation program prompts you for the type of installation, 
click the Typical button to begin installing AQTESOLV for 
Windows. . 
After installation is cornplckf enter a name for the Program Group 
that will contain the AQTESOLV for Windows icons. Aocept the 
&fault name (AQTESOLV for Windows) or enter a new name for 
the Program Group. Click the OK button install the icons in the 
Program Group. 

After viewing last-minute information, close the viewer window. Start 
the application by double-clicking the AQTESOLV for Windows icon. 

Uninstallation 
To uninstall AQ'IESOLV for Windows, simply delete the Program Group (e.g.. 
AQTESOLV for Windows) and the subdirectory (e.g., c:\aqtw) containing the 
program files. AQTESOLV for Windows does not modify any Windows system 
files, so no additional uninstallation is necessary. 

Using Help 
The Help menu provides you with options for exploring the AQTESOLV for 
Windows on-line Useh Guide. 

lndex 
Use lndex in the Help menu to view the table of contents in the AQTESOLV for 
Windows help manual. Once you have entered Help, you can perform searches for 
specific topics using the Search button. 

To obtain Help about a specific menu option or button, click k? on the toolbar. 
Release the mouse on the option or button for which you wish to obtain Help. 

Using Help 
Choose Uslng Help from the Help menu to view instructions for navigating the . 
Windows help system. 
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About AQTESOLV . 

Choose About AQTESOLV... from the Help menu or click Y on the toolbar to 
display program copyright and version information for AQTESOLV for Windows, 
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Guided Tours 

i 
I 
I Overview 

! The "guided tours" provide you with step-by-step instructions illustrating the use of 
1 AQTESOLV for Windows in the analysis of pumping tests and slug tats. The 

tours show you how to pcrfonn visual and automatic curve matching. change 
I between plot and report views, open multiple windows for the same data set, obtain 
I printed output, and much more. Regardless of whether you are a novice or an 
L expert in analyzing aquifer test data, it is recommended that you take the time to go 

through the guided tours to become familiar with AQTESOLV for Windows. 

I+-? 
Analyzing a Pumping Test 

The fmt stop in the guided tour shows you how to use AQTESOLV for Windows to 
analyze a constant-rate pumping test in a confined aquifer. This step-by-step 
example illustrates the use of visual and automatic curve matching to estimate the 
hydraulic properties of the aquifer. 

Open a New Data Set 
'. Open a new data set by choosing New from the Flle menu. In the New Data Set 

dialog box, choose Gulded Tour fmm the list box to initialize the new data set 
with &fault values. AQTESOLV for Windows opens a new window with an Error 
Log view that reports any errors identified in the data set, 

Enter Data for Pumping. Test 
Units Choose Units ... from the Edit menu to open the Units dialog box for selecting 

I 
I units of measurement for the data set 
I 1. Select ft (feet) for Length, min (minutes) for T h e ,  consistent for 

Pumping Rate and consistent for Hyd. Conductivity. 

2. Click the OK button to close th:: Units dialog box. 

Consistent units 

I 
1 Title 
hw 

1 

For this data set, consistent units for pumping rate are cubic feet-perminute; 
consistent units for hydraulic conductivity are feet-perminute. 

Choose Title... from the Edit menu to open a dialog box for editing the data set 
title. 
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I .  Enter Theis Verification for the Title. 

Aquifer data 

Pumping well data 

2. click the OK butkn to close the dialog box. 

Choose Aquifer Data... from the Edit menu to open a dialog box for editing 
aquifer data. 

1. Enter 100.0 for the value of saturated Thlckness. - 

2. Click the OK button to close the dialog box. 

Choose Pumplng WelVEdit ... from the ~dlt 'menu to open the Pumplng Well 
Data dialog.box for editing pumping well data. 

1. Click the Edit button to open the Pumping Period Data dialog box 
for entering pumping rates. 

2. In the Time and Rate cdit controls. enter values of 0.0 and 3.14159 
for time and rate, respectively, where tirne is in minutes and rat6 is in 
cubic feet-pet-minutc. 

TlPS 
Enter rates for a pumping test by entering a sequence of pumping 
periods. Define pumping periods by entering the starting time and 
pumping rate for the period. The fmt pumping period should have a 
time = 0.0. For recovery, enter a pumping period with the time when 
the pump was shut off and a pumping rate = 0.0. 

3. Click the <<Add button to transfer the values from the edit controls to 
the list box. 

4. Click OK to close the Pumplng Perlod Data dialog box. 

5. Click OK to close the Pumping Well Data dialog box. 

Observation well data Choose Obs. WellEdit... from the Edit menu to open the Obsenratlon Weil 
Data dialog box and edit data for the observation well. 

1. Enter a value of 100.0 for the X-Coordinate location of the well. 

2. Click the Edit buaon to'open the Observation Data dialog box for 
entering observation data from the keyboard. All of the time values 
should be greater than the start of the first pumping period entered for 
the pumping well (i.e., > 0.0). All of the displacement values should 
be greater than zero. 

Enter the following 10 measurements into the cdit controls for Time 
and Displacement (set all weights equal to 1.0): 
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2. Click the <<Add button to transfer values from the edit controls to the 
list box. 

3. When you have finished entering the observations, click the OK 
button to close the Observation Data dialog box. 

4. Click the OK button to close ihe Observation Well Data dialog 
box. 

After you have completed the previous data entry steps, the Error Log displayed in 
the active window should show that the,data set contains no errors. Now you ate 
ready to display the data, choose a solution and estimate aquifer properties. 

Save Data Set 
Choose Save As... from the File menu to open a dialog box for saving the data you 
have entered into the current data set 

1. Enter TOURlAQT for the file name. 

2. Click the OK button to close the dialog box and save the data set. 

Display Plot in Window 
Choose Displacement-fime from the View menu to display a plot of 
displacement vs. time in the active window. The window displays a plot of the 
observation well data on semi-logarithmic axes. 

: Choose Theis Sdution . 
Choose Confined ... from the Solutlon menu to open a dialog box with solutions 
for analyzing pumping tests in a confined aquifer. 

1. Choose the Theis (1935) solution. 

2. Click the OK button to close the dialog box. 

After you have selected the Theis solution for a pumping test in a confined aquifer. 
AQTESOLV for Windows updatcs the window by plotting the data on double 
logarithmic axes; superimposing the Theis type curve on the plot. and adding the 
current values of transmissivity (7') and storage coefficient (S) to the legend. 

For details concerning the Theis solution, see "Theis (1935) Solution for a Pumping 
Test in a Confined Aquifer" on page 40. 

Perform Visual Matching with Theis 
The Theis type curve solution computes drawdown in a confined aquifer using the 
following equations: 
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where s is drawdown, Q is pumping rate, T is transmissivity, r is radial distance be- 
tween pumping and observation wells, S is storage coefficient, and t is time. 

Hydrogeologists commonly nfer to'lhe exponential integral in the drawdown 
equation as the Theis wellfunction, abbreviated as w(u). Therefore. we can write 
the Theis drawdown equation in compact notation as follows: 

To analyze a pumping test using the Theis typecurve method. one plots drawdown 
as a function of time on double logarithtpic axes. By matching a type curve drawn 
by plotting w(u) as a function of I/u, one can estimate the values of transmissivity 
and storage coefficient by visual analysis. 

Choose Visual from the Match menu to perform visual curve matching of the 
Theis type curve to the observation well data, 

1. To begin interactively moving the type curve, move the mouse cursor 
over the plot, click the left mouse button, and hold it down. 

2. As you move the mouse, the type m e  also moves. AQTESOLV for 
Windows updates the values of the aquifer properties, T and S, in the 
legend as the type curve position changes. 

3. When you have finished matching the type curve to the observation 
well data, r c l k e  the left mouse button to end visual curve matching. 

Perform Automatic Matching with Theis 
Choose Automatic... from the Match menu to open a dialog box for performing 
automatic matching of the Theis type curve solution to the observation well data. 

AQTESOLV for Windows usw a nonlinearleast-squaw estimation procedure to 
match a solution to observation well data. The estimation procedure performs a 
sequence of iterations to minimize the residual sum of squares (RSS) criterion. The 
residuals are the errors between the computed and observed values of displacement. 

1. Click the Start button to begin the automatic estimation procedure. 

2. As the automatic estimation procedure completes iterations, the dialog 
box displays the changes in the residual sum of squares (RSS) criterion 
md the values of the aquifer properties. AAcr the automatic 
estimation procedure finishes, AQTESOLV for Windows displays a 
message box containing residual summary statistics. Click the OK 
button to close the message box. 

3. Click the Close button when the automatic estimation procedure has 
finished. 
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Print Results 
Choqse Print ... from the File menu to print a copy of the type curve solution. To 
select a printer other lhan the default..click the Setup ... button and choose a new 
printer, Click the OK button to print the type curve plot. 

Open a New Window for a Diagnostic Plot 
Choose New Wlndow from the Window menu to open a second window for the 
active data set. The initial view in the second window is the same as the previously 
active window. 

1. Select Normal Probability from the View menu to plot values of 
residuals (errors) plotted on normal probability axes in the new 
window.  his view option is only available after you have performed 
automatic curve matching. 

Diagnostic tea for normal If the residuals are normally: distributed, they will fall on a straight line when 
distribution of residuals plotted on normal probability axes. Deviations from a normal distribution may 

indicate that the chosen analytical solution is inadequate lor the analysis. 

Save Data Set 
Choose Save from the File menu to save your work in the TOUR1.AQT data set. 

2. A€ter you have inspected the nonnal probability plot, close the 
window. , 

Analyzing a Slug Test 

Units 

Title 

The second sample in the guided tour illustrates the analysis of a slug test in a 
confined aquifer using a type-curve solution by Cooper. Bredehoeft and 
Papadopulos and a straight-line solution by Bouwer and Rice. The step-by-step 
instructions in this aample lead you through the use of visual and automatic curve 
matching to estimate aquifer properties from slug test data. 

O!en_ aNew Data Set 
Open a ney data set, bcbwsing  New from the File menu. In the New Data Set 
dialog box, c h d e  Gulded Tour from the list box to initialize the new data set 
with default values. AQTESOLV for Windows opens a new window with an Error 
Log view that reports any errors identified in the data set. 

Enter Data for Slug Test 
Choose Units ... from the Edit menu to open the U n l t ~  dialog box for selecting 
units of measurement for the data set. 

1. Select m (meters) for Length, min (minutes) for Time, and cmlsec 
(centimeters-per-second) for Hyd. Conductlvlty. 

2. Click the OK button to close the Units dialog box. 

Choose Title ... from the Edit menu to open a dialog box for editing the data set 
title. 

1. Enter ConEined Slug Test for the Title. 

2. Click the OK bunon to close the dialog box. 
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Slug test dara Choose S lug  Test Well... from the Edit menu lo open a dialog box for entering 
...& 

' C .  
slug test data. I 

1. Enter 0.56 for Initial Displacement. f 
2. Enter 6.076 for Caslng.Radlus. 

3. Enter 0.076 for Wellbore Radius; 

4. Enter 100.0 for Ween  Length. 

5. Enter 100.0 for Water Column Height. I 
6, Enter 100.0 for ~aturated~hickness. I 

7. Click the Edit button to open the Observation Data dialog box for 
entering observation data from the keyboard. Enter the following 21 
measurements intq the edit controls for Time and Displacement (set 
all weights equal to 1.0): 

- 1 
I 

8. Click the <<Add button to transfer values from the edit controls to the 
list box. I 

9. When you have finished entering the observations, click the OK 
button to close the Observatlon Data dialog box. 

10. Click the OK button to close the Slug Test Data dialog box. I 
I 

After you have completed the previous data entry steps, the Error Log displayed in 
the active window should show that the data set contains no errors. Now you are 
ready to display the data, choose a solution and estimate aquifer properties. I 

L 

Save Data Set 
Choose Save As ... from the File menu to open a dialog box for saving the data you I 
have entered into the current data set. 

I 
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1. Enter TOUR2.AQT for the file name. 

Complete report 

Diagnostic report 

2; dlick the OK button to close the dialog box and save the data set. 

Display Report in Window 
Choose Report from the View menu to display a complete reporl of the data set in 
the active window. 

The complete report displays in report format all of the data contained in the active 
data set. The report also shows parameters estimated by visual or automatic curve . 
matching. The repon includes diagnostic statistics if you have performed automatic 
estimation. 

Display Plot in Window 
Choose Displacement-Tlme from the Vlew menu to display a plot of 
displacement vs. time in the active window. The window displays the data plotted 
on semi-logarithmic axes. 

Choose Cooper Et Al. Solution 
Choose Confined... h m  the Solution menu to open a dialog box with solutions 
for analyzing slug tests in a confined aquifer. 

1. Choose the Cooper-Bmdehoen-Papadopulos (1967) solution. 

2. Click the OK button to close the dialog box. 

For details concerning the Cooper-Bredehoeft-Papadopulos slug test solution, see 
"Cooper-Bredehoeft-Papadopulos (1967) Solution for a Slug Tcst in  a Confined 
Aquifer" on page 61. 

Perform Automatic Matching with Cooper Et Al. 
Choose Automatic... from the Match menu to open a dialog box for automatically 
matching the Cooper-Bredehoeft-Papadopulos type curve solution to the slug test 
data. 

1. Click the SMrt button to begin the automatic estimation procedure. 
- 

2. As thp automatic estimati~n"~mcedure completes iterations, the dialog 
box displays.the changes in the midual sum of squares (RSS) criterion 
and the values of the aquifer properties. After the automatic 
estimation procedure finishes, AQTESOLV for Windows displays a 
message box containing residual summary statistics. Click the OK 
button to close the message box. 

3. Click the Close button when the automatic estimation procedure has 
finished. 

Display Diagnostic Report in Window 
Choose Diagnostlcs from the View menu to display a report containing 
diagnostic statistics for the estimated aquifer properties in the active window. 

In the diagnostic report, the standard errors indicate the precision of the estimated 
parameters. Ideally, the standard errors should be small compared to the estimates. 
The correlation matrix shows correlations between the estimated parameters and 
may indicate estimation difficulties*when strong correlations exist The diagnostic 
report also displays summary statistics for the model residuals. 
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Display Plot in Window .. . 

Choose Displacement-The from the View menu to display a plot of 
displacement vs. time in the active window. 

Choose Bouwer-Rice Solution' 
Change the solution by choosing Confined.., from the Solution menu. 

I .  Choose the Bou-wer-Rice (1976) solution. 

2. Click the OK button to close the dialog box. 

After you have selected the Bouwer-Rice straight-line solution for a slug test in a 
confined aquifer, AQTESOLV for Windows updates the window by plotting the 
data on semi-logarithmic axes and superimposing a straight line predicted by the 
Bouwer-Rice solution on the plot. 

I f 

F a  details on the Bouwer-Rice slug test solution, see "Bouwer-Rice (1976) Solution 
for a Slug Test in an Unconfined Aquifct" on page 82, 

Perform Visual Matchlng with Bouwer-Rice 
Choose Visual from the Match menu to perform visual curve matching of the 
Bouwer-Rice solution to the dug test data. 

1. To begin intcndvely matching the Bouwer-Rice solution to the data, 
click the left mouse button and hold it down to anchor a point along 
the new stt'aight line you wish to match to the data. 

2. As you move the mouse, AQESOLV for Windows drags a straight 
line between the anchor pointand the mouse cursor. 

3. When you have finished matching the Bouwer-Rice solution to the 
observation well data. release the left mouse button. AQTESOLV for 
Windows computes new estimates of hydraulic conductivity (K) and y- 
axis intercept (yo) and updates the straight line displayed on the plot. 

Estimar;on tip For most slug tests, one should use visual matching to obtain the most meaningful 
estimate of K with the Bouwer-Rice solution because visual matching gives you 
greater control over the range of data that you want to match with the straight line. 

. If you choose to attempt autowic matching with the.Bouwer-Rice solution, you 
should assign weights of zero to the measurements not within the range of data that 
you want to match. 

Save Data Set 
Choose Save from the Flle menu to save your work in the TOUR2.AQT data set. 

Additional Tutorials 
The on-line version of this Usefs Guide contains additional tutorials for pumping 
test and slug test solutions found in AQTESOLV for Windows. To access these 
tutorials, choose Index from the Help menu to access the Table of Contents  for 
the on-line help manual. 

Pumping Test Tutorials 
Theis (1935) solution for a confined aquifer 

- 
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Cooper-Jacob (1946) solution for n confined aquifer 

~apado~ulos-cooper (1967) largediameter well solution for a confined aquifer 

Theis (1935) solution for a recovery test in a confined aquifer 

Theis (1935) solution for a step drawdown test in a confined aquifer 

Hantush (1962) solution for a wedge-shaped aquifer 

Theis (1935) solution for an unconfined aquifer 

Cooper-Jacob (1946) solution for an unconfined aquifer 

Neuman (1974) and Quick Neuman solutions for an unconfined aquifer 

Streltsova (1974) solution for an unconfined aquifer 

Moench (1997) large-diameter well solution for an unconfined aquifer 

Hantush-Jacob (1955) solution for a leaky aquifer 

Hantush (1960) solution for a leaky aquifer 

Moench (1985) largediameter well solution for a leaky aquifer 

Mocnch (1984) solution for a double-porosity fractured aquifer (slab-shaped blocks) 

Moench (1984) solution for a double-porosity fractured aquifer (spherical blocks) 

Slug Test Tutorials 
Cooper-Brdehoeft-Papadopulos (1967) solution for a confined aquifer 

Bouwer-Rice (1979) solution for an unconfined aquifer 

Hvodlev (1951) solution for an unconfined aquifer 

1 
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Working With Data Sets 

What is an AQTESOLV for Windows Data Set? 
An AQIESOLV for Windows data set is a file created by AQTESOLV for 
Windows that records your woik during an aquifer test analysis session. It contains 
data from an aquifer test (e.g., aquifu geometry data, test well data, pumping data, 
and time-displacement data) and information concerning the solution method used 
to analyze the test data (e.g., solution method and aquifer properties). A data set 
also contains data that you enter to format plots and reports. In other words, an 
AQTESOLV for Windows data set contains a complete record of your aquifer test 
analysis at the time you save i t  

Managing Data Set Files 

Creating a New Data Set 
Click on the toolbar to Select New from the Flle menu to create a new AQTESOLV for Windows data set. 
open a new data set From the New Data Set dialog box, choose a template or wizard from the list box 

to create a new data set. 

Defaub 

The Default template creates a new data set with default values. Choose options - 

from the Edit menu to modify the default values (see "Editing Data Sets" on page 
18). 

Gulded Tour , 

The Guided Tour template creates a new data set containing default values for a 
"Guided Tour" example contained in this manual. 

lm~ott AQTESOLV for DOS Wlzard 

The AQTESOLV for DOS Wizard helps you import a data set created with a 
DOS version of AQTESOLV. 
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P u m ~ l n a  Test Wizard 

The Pumping ~est Wizard helps you create a new data set for a typical pumping 
test. This wizard allows you to import time-displacement data from a pressure 
transducer file. 

The Slug Test Wizard helps you create a new data set for a typical slug test. This 
wizard allows you to import time-displacernent data from a pressure transducer file. 

T e m ~ i a t e  Wizard. 

The Template Wizard helps you create a new data set using an existing 
AQTESOLV for Windows data set as a custom template. 

Click on the toolbar to 
save the active data set 

Click @ on the toolbar to 
open an existing data set 

Tutorial 

The Tutorial template creates a new data set containing default values for a tutorial 
contained in this manual. 

When you &ate a new data set, A Q m O L V  fot Ibndows automatically opens an 
Error Log window that indicates data items that you need to enter for a complete 
data set. The Error Log view displays deficiencies in the data set. After 
completing data entry, view the data by chwsing an option from the View menu 
(see "Viewing Dm and Results" on page 29). 

Savlng a Data Set 
You have two options for saving an AQ?'ESOLV for Windows data set. 

To save data set using the current file name 

Choose Save from the Flle menu to save an AQ'IWOLV for 
Windows data set on disk using the current file name. 

To save data sat wlth a new tlle name 

1. Select Save As... from the File menu to specify a file name 
before you save the data set. 

2. . Enter a name for the data set you want to save in the dialog box. 

3. Click the OK button to save the data set. 

Opening a Data Set 
Choose Open ... from the Flle menu to open an existing data set created with 
AQTESOLV for Windows. 

1. Enter the name of the data set you want to open in the dialog box. 

2. Click the OK button tb retrieve the data set. 

Closing a Data Set 
Choose Close from the File menu to close the active data set. If you have changed 
any data, AQTESOLV for Windows prompts you to save the modified data set. 
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Importing an AQTESOLV for DOS Data Set 
You have two options for importing a data set created with a DOS version of 
AQTESOLV. 

To Import an AQTESOLV for DOS data set Into a new 
AQTESOLV for Windows data set 

1. Select New from the File menu to open the New Data Set 
dialog box. 

2. Chodse lmport AQTESOLV for DOS Wizard from the listbox 
ioirnport an AQTESOLV for DOS data set. 

To lmport an AQTESOLV for DOS data set into an active 
AQTESOLV for Windows data set. 

1. Select Impo rt... from the Flle menu to open the lmport dialog 
box 

2. Ch- lmport AQTES~LV for DOS data set from h c  
liitbox and follow the steps in the lmport AQTESOLV for DOS 
Data Set Wizard. 

Importing Observations 
You have two options for importing a file containing time-displacement 
measurements from. a pumping test or slug test. 

. To lmport observation data from the File Menu 

1. Select Impo rt... from the Flle menu to open the lmport dialog 
box. 

2. Choose Observation Well Measurements from the listbox 
and follow the steps in the Obsewation Data lmport Wizard, 

To lmport pumping perlod data from the Edlt Menu 

For a pumping test, choose Obs. WelVEdlt.. h m  the Edit 
menu to open the Observation Well Data dialog box. For a 
slug test, choose Slug Test Well ... from the Edit menu to open 
the Slug Test Data dialog box. 

Importing 

Click the lmport button and follow the steps in the Observation 
Data lmport Wizard. 

Pumping Rates 
You have two options for importing a file containing pumping rate data from a 
pumping test. 

To lmport pumplng perlod data from the File Menu 
. . 

1. Select Import.. from the File menu to open the lmpdrt dialog 
box. 

2. Choose Pumplng Rate Measurements from the listbox and . 

follow the steps in the Pumping Period Data lmport Wizard. 
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To import pumping period data from the Edit Menu 
' i 

1. choose hmptng WeiVEdlt... from the Edit menu to open the 
Pumping Well Data dialog box. f 

I 

2. Click the import button and follow the steps in the Pumping i 

Period Data import Wizard. 
I 

Editing Data Sets 
The Edit.menu provides-options for entering or modifying data in the active data 
set. Selecting any uf the options d l 1  open dialog boxes which prompt you for 
information stored in AQTESOLV data sets. . . 

Choose Units ... h m  the Edit menu to open a'dialog box which prompts you for 
units of mtasumcnt for tit&, length, pumping rate and hydraulic conductivity. 

* .  
Dimensioirally consi& unless otherwise spe;cified, AQTJSOLV for Windows assumes that pumping rates 
units and hydraulic conduct iv i ty /~ns~s iv i ty  units are dimensionally consistent with 

the units specified for length and time. F a  example, if the units of length and time 
were feet and minutes, mptctively, the dimensionalt consistent units would be 

! 
ft3/rnin cubic feet per minute for pumping rate and Jday square feet per day for 
€ransmissivi€y. 

d 
I 

O p t i 0 ~ 1  units for pumping For those not wishing to use dimensionally 44consistent" units. AQTESOLV for 
rate and hydraulic Windows provides options for pumping rate units including gallons and liters (e.g., 

gpm and Usec). For units of hydraulic conductivity/transmissivity, you also can 
select units containing gallons (e.g., gpmlft2 gal/rnin/sq. ft). 

Select Tltle., from the EdH menu to open a dialog box that allows you to enter a 
40 character title for the data set. 

Project Info 
Choose Project Info ... from the Edit menu to open a dialog box prompting you to 
enter information for my of the following items into the active data set (each item 
may contain up to 30 characters): 

client name 

project number 

1ocation.of test 

t a t  well name 

observation well name 

date of test 
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Aquifer Data - 

Select Aquifer Data... from the Edit menu to enter aquifer geometry and special 
hydraulic property data into the active data set. 

Aquifer data 

saturated thickness of the aquifer [L] 

Saturated thickness 

1. Enter tbe saturated thickness of the aquifer measured from the top 
of the aquifer (or the water !able) to the bottom of the aquifer. 

2. In an unconfined aquifer, the maximum displacement should not 
exceed the saturated thickness. 

Hydraulic candildlvtty ratio 

ratio of vehcal to horizontal hydraulic conductivity (for partial 
penetration) [dimensionless] 

thickness of slabshaped matrix blocks (fractured aquifers) EL] 
diameter of spherical matrix blocks (fractured aquifers) [L] 

slope orientation (wedge-shaped aquifers) [degrees] 

1. Enter the ratio of vertical to horizontal hydraulic conductivity 
CKdK,Kz/Kr) for pumping test solutions applying the Hantush 
(1961hb) comtions for partially penetrating wells. 

2. The Neuman (1974) solution for pumping tests in unconfined 
aquifers, which estimates the value of EZ/K,Kz/Kr in the value- of 
the $ beta parameter, does not use the hydraulic conductivity ratio 
value eatcred in the aquifer data. 

Fractured aquifer data 

1. Enter the thickness of slab-shaped matrix blocks for the Moench 
(1984) solution for a double-porosity fractured aquifer with slab- 
shaped blocks. 

2. h t e r  the diameter of spherical blocks for the Moench (1984) 
solution for a double-porosity fractured aquifer with spherical 
blocks. 

Wedge-shaped aquifer data 

1. Enter the orientation of the slope on the base of the aquifer as the 
angle measured in a counterclockwise direction from the positive 
xsaordinate axis to the vector oricnted in the updip direction of 
the slope. 

2. Enter the slope orientation angle in degrees. 

Pumping Well 
Choose the Pumping Well option from the Edit menu. Select Edit ..., Add... or 
Delete ... from the popup menu to edit. add or delete a pumping well. If you are 
editing or adding a pumping well. the Pumping Well Data dialog box allows you 
to enter data for the pumping well. 
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'Pumping well data 

pumping well name 

x-coordinate location [L] 

ycoordinate location (L] 

casing radius &] 

wellbore radius [L] 

full or partial penetration data 

Well coordinates 

1. AQTESOLV for Windows usesan x-y coordinate system to 
compute distances between pumping wells and observation wells. 

2. For a simple pumping test involving only one pumping well and 
one observation well, locate the pumping well at x4.O and y=O.O. 
Locate the observation well x=r and y a . 0  where r is the radial 
distance &tween the pumping and observation wells. 

Largediameter well data 

1. To analyze pumping tests using large-diameter well solutions. 
enter values for the W u g  radius and wellbore radius of the 
pumping well.- 

2 If the value for either of these two variables is 0.0, AQTESOLV 
for Windows assumes the pumping well has an infinitesimal 
radius. 

Well penetratlon data 

1. A well is fully penetrating if its screen or perforated interval 
extends over the full saturated thickness of the aquifer. 

2. The scmn  of a partially penetrating well only extends over a 
portion of an aquifefs saturated thickness. For a partially 
penetrating well, enter depths from the top of the aquifer (or water 
table) to the top and bottom of the well screen. 

3. The bottomof well screendepth must be greater than the top of 
well screen depth. The minimum depth for the top of the well 
screen is 0.0; the maximum depth for the bottom of the well 
screen is the saturated thickness of the aquifer. 

Entering or lmportlng rates 

1. Click the Edlt button to open the Pumping Perlod Data dialog 
box for entering rate data from the keyboard (see "Entering 
Pumping Rates fmm the Keyboard" on page 20). 

2. Click the Import button to open the Import Wizard for 
importing rate data from a delimited text file (see "Importing 
Pumping Rates from a File" on page 22). 

Entering Pumping Rates from the Keyboard 
To enter pumping period data for a pumping well, open the Pumping Period 
Data dialog box. 
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To enter pumping period data 

1. Choose Pumping WeYEdit.. from the Edlt menu to  open the 
Pumping Well Data dialog box for a pumping well. 

2. Click the Edlt button to enter pumping period data for the well. 

To add new pumplng period data to the list box 

1. Enter the values of time and pumping rate in the edit controls. 

TlPS 
Enter rates for a variable-rate test by entering a sequence of 
pumping periods. Define pumping periods by entering the 
starting time and pumping rate for the period. ?he first pumping 
period should have a time = 0.0. For recovery, enter the time 
when thepump was shut off and a pumpingrate = 0.0. 

2. Click the << Add button to transfer data from the edit coamls to 
the list box. 

To edit the data for a specific pumping period In the llst box 

1. Select the pumping period that you want lo edit by clicking the 
left mouse button on the data in the list box. 

2. Click the Edlt >> button to copy the selected time and pumping 
tate from the list box to the edit controls. 

3. Modify the data in the edit controls 

4. Click the << Add button to transfer data from the edit controls to 
the list box. 

To delete pumplng period data from the llst box 

1. Select the pumping period(s) that you want to delete by clicking 
the left mouse button on the data in the list box. To select a range 
of pumping periods, press the SHIFT key when you click Ihe 
mouse on the fust and last pumping period in the range. To select 
several individual pumping periods, press the CTRL key when 
you click the mouse on the individual pumping periods. 

2. Click the Delete >> button to delete the selected time and 
pumping rate data from the l i t  box. Before deleting the data, 
AQTESOLV for Windows pmmpts to confirm your action. 

To search for a specific time or pumplng rate In the list box 

1. Click the Search button to open a dialog box For the search. 

2. Enter the data vector, time or pumping rate, that you wish to 
search and the specific value. 

3. Click the OK button to search for the value. 

To transform pumping period data In the list box 

1. Select the pumping period(s) that you want to transform by 
clicking the left mouse button on the data in the list box. To 
select a range of pumping periods, press the SHIFT key when yoli 
click the mouse on the first and last pumping period in the range. 
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Create a delimited text file to 
import measurements 
recorded by a pressure 
transducer. 

To select several individual pumping periods, press the CTRL key 
when you click the mouse on the individual pumping periods, 

Click the Math button to open a dialog box for the operalion. 

Enter thc data vector, time or pumping rate, that you wish to 
transform. 

Select a transformation operation (add, subtract, multiply. divide 
or replace). 

Click the OK button to perform the transformation. Before 
transforming the data, AQTESOLV for Windows prompts to 
confim your action. 

To filter pumplng perlod data in the list box 

Click the Filters button to open a dialog box for the filtering 
operations. 

Select filter operations for discarding or retaining pumping 
periods. . 

Use filtcts to faducc the number of pumping periods. Retain rate 
values exceeding a minimum threshold (AQ'TESOLV for 
Windows time-averages intermediate values not retained). 

Click the OK button to filter the observations. Before filtering the 
data, AQTESOLV for Windows prompts to confirm your action. 

Importing pumping Rates from a File 
Import pumping period starting time and pumping rate data for a pumping well 
with the Pumplng Period lmport Wizard. The delimited text import file may 
contain one or more columns of data separated by comma, blank or tab delimiter,. 

The lmport Wizard supports delimited text files created by many different types of 
pressure transducers. The wizard automatically searches for the row containing the 
firstprnping period, or you can.spccify thestarting row in the file. Transformation 
and filter operations also allow you to modify and reduce the data during the import 
process. 

To lmport rates for a pumplng test 

1. Choose Pumping WeiVEdit... from the Edlt menu to open the 
Pumplng Well Data dialog box for a pumping well. 

2. Click the Import button to start the lmport Wizard. 

Step 1. Open an import file contalnlng pumping period data 

1. Enter a path and filename for a text file containing pumping 
period data. Click the Browse... button to search for a file. 

2. To view a specified file, click the View lmport Flle... button. 

3. To append data h m  the import file to pumping period data in the 
* 

data set. check the Append pumplng periods from import 
file to data set box. 
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4. Click the Next > button to proceed to Step 2 of the Import 
Wizard. 

Step 2. Specify the file structure 

1. Enter the No. of Columns contained in the file. The total 
number of columns contained in the file may be greater than the 
number of columns that you wish to import. 

2. Enter a number for the Starting ROW containing the first 
pumping period that you wish to import from the file. 

TlPS - 
. Click the Select Starting Row ... button to view the impott file. 

You can select the first row in the file that you want to import by 
double-clicking i t  

3. Specify t& Data to Import from the file. Enter a column 
number for each data item (starting time of the pumping period 
and pumping rate) that you are importing from the file. Enter a 
column number of 0 (zero) for any item not contained in the file. 

4. Click the Next > button to proceed to Step 3 of the Import 
Wizard. - 

Step 3. Specify transformation and filter operations 

1, Select Pre-Filter Operations for transforming time and 
pumping rate data contained in the file. Enter constants for 
subtraction and multiplication operations. 

2. Click the Filters... button to select options for filtering the data 
imporced from the file. 

rips 
Use filters to reduce the number of pumping periods. Retain rate ' 
values exceeding a minimum threshold (AQTESOLV for 
Windows tirne-averages intermediate values not retained). 

3. Click the Finish button to import data from the file. 

Observatiqn Well 
 hook the Obs. Well option from the Edit menu. Select Edit ..., Add... or 
Delete... from the popup menu to edit, add or delete an observation well. If you are 
editing or adding an observation well, the Observation Well Data dialog box 
allows you to enter data for the observation well. 

Observation well data 

observation well name 

xcoordinate location [L] 

y-coordinate location [L] 

full or partial penetration data 

observation well data 
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Well coordinates 

I .  AQTESOLV for Windows uses an x-y coordinate system to 
compute distances between pumping wells and observation wells. 

2. p or a simple pumping test involving only one pumping well and 
one observa~on well, locate the pumping well at x4.O and y4.O. 
Locate the observation well at x=r and y4.O where r is the radial 
distance between the pumping and observation wells. 

Well penetratlon data 

1. A well is fully penetrating if its screen or perforated interval 
extends over the full saturaled thickness of the aquifer. 

2. The screen of a partially penetrating well only extends over a 
portion of an aquifer's saturated thickness. For a partially 
penetrating well, enter depths from the top of the aquifer (or water 
table) to the top and bottom of the well screen. 

3. The bottom of well screen depth must be greater than the top of 
well screen depth. The minimum depth for the top of the well 
screen is 0.Q the maximum depth for the bottom of the well 
screen is the saturated thkkness of the aquifer. 

4. 'A  piemmeter (in contrast to an observation well) is an opencndtd 
pipe installed in an aquifer to measure hydraulic head at a specific 
depth. ,The piezorneter depth is distance from the top of the 
aquifer (or water table) to the piemmeter opening. 

Entering or importing obsewation well measurements 

1. Click the Edlt button to open the Observation Data dialog box 
for entering observation data from the keyboard (see 'Entering 
Observations from the Keyboard" on page 24). 

2. Click the Import button to open the import Wizard for 
importing observation data fmm a delimited text file (see 
"Importing Observations from a File" on page 26). 

Entering Observations framjhe Keyboard 
To enter time, displacement and measurement weight data for an observation well 
or slug test well, open the Observation Data dialog box. 

To enter observations for a pumplng test 

I. Choose Obs. WellEdit. .. from the Edlt menu to open the 
Obsewation Well Data dialog box for an observation well. 

2. Click the Edlt button to enter measurements for the well. 

To enter observations for a slug test 

I. Choose Slug Test Well ... from the Edlt menu to open the Slug 
Test Data dialog box. 

2. Click the Edit button to enter measurements for the test well. 

To add new obsewatlon data to the list box 

1. Enter values of time, displacement and weight in the edit controls. 1 
+Z 
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m :  
Assign weights to indicate the relative weight of each 
measurement during automatic curve matching. Assign a weight 
of zero for measurements you wish automatic curve inatching to 
ignore.. 

2. Click the << Add button to transfer data from the edit controls to 
the list box. 

To edit the data for a specitlc observatlon in the list box 

1. Select the obserktion that you want to edit by clicking the left 
mouse button on the data in the list box. 

2. Click the Edit >> button to copy the selected time, displacement 
and weight from the list box to the edit controls. 

3. Modify the data in the edit controls 

4. Click the << Add button to transfer data from the edit controls to 
the list box. 

To delete observation data from the list box 

1. Select the observation that you want to delete by clicking the left 
mouse button on the data in the list box, To select a range of 
observations, press the SHlFf key when you click the mouse on 
the fast and last observation in the range. To select several 
individual observations, press the CTRL key when yau click the 
mouse on the individual observations. 

2. Click the Delete >> button to delete the selected time, 
displacement and weight data from the list box. Before deleting 
the data, AQTESOLV for Windows prompts to confirm your 
action. 

To search for a speclflc time, displacement or weight In the list 
box 

I. Click the Search button to open a dialog box for the search. 

2. Enter the data vector, time, displacement or weight, that yau wish 
to search and the specific value. 

3, Click the OK button to search for the value. 

To transform observation data In the list box 

1. Select the observation that you want to transform by clicking the 
left mouse button on the data in the list box. To select a range of 
observations, press the SHIFT key when you click the mouse on 
the first and last observation in the range. To select several 
individual observations, press the CTRL key when you click the 
mouse on the individual observations. 

2. Click the Math button to open a dialog box for the transformation 
operation. 

3. Enter the data vector, time, displacement or weight, that you wish 
to transform, 

4. Select a transformation operation (add, subtract, multiply, divide 
or replace). 
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5. Click the OK button to perform the transformation. Before 
transforming the data. AQTESOLV for Windows prompts to 
confirm your action. 

To filter observation data In the list box 

1. Click the Filters button to open a dialog box for the filtering 
operations. 

2. Select filter operations for discarding or retaining observations, 

TlPS 
Use filters to reduce the number of'observations. Retain time 
values having a uniform logarithmic spacing or displacement 
values exceeding a minimum threshold. 

3. Click the OK button to filter the observations. Before filtering the 
data, AQTESOLV for Windows prompts to confirm your action. 

Importing Obseniations from a File 
Create a delimited textfile to Import tima, displacement and measurement weight data for an observation or slug 
impon measuremenrr test well with the Obsewatlon Data Import Wizard. The delimited text import 
recorded by a pressure file may contain one or more columns of data separated by comma, blank or tab 
transducer. delimitcrs. . 

The lmport Wlzard supports delimited text filw created by many different types of 
pressure transducers. The wizard automatically searches for the row containing the 
first observation, or you can specify the starting row in the Ale. Transformation and 
filter operations also allow you to modify and reduce the data during the import 
process. 

To import observaUons for a pumping test 

1. Choose Obs. WelVEdit.. from the Edit menu to open the 
Observation Well Data dialog box for an observation well. 

2. Click the lmport button to start the lmport Wizard. 

To import observations for a slug test 

-1. Choose Slug Test Well ... from the Edit menu to open the Slug 
Test Data dialog box. 

2. Click the lmport button to start the lmport Wizard. 

Step 1. Open an lmport file containing observation data 

1. Enter a path and filename for a text file containing observation 
data. Click the Browse ... button to search for a file. 

2. To view a specified file, click the View lmport File.. . buuon. 

3. To append data from the import file to observation data in the 
data set, check the Append observations from import file to 
data set box, 

4. Click the Next > button to proceed to Step 2 of the Import 
Wizard. 
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Step 2. Speclfy the tile structure 

I .  Enter the No. of Columns contained in the file. The total 
number of columns contained in the file may be greater than the 
number of columns that you wish to import. 

2. Enter a number for the Starting Row containing the first - 
observation that you wish to import from the file. 

TlPS - 
Click the Select Starting Row ... button to view the import file. - 

You can select the first row in the file that you want to import by 
doubletlicking it. 

3, Specify the Data to Import from the file. Enter a column 
number for each data item (elapsed time, displacement and 
measurcthcnt weight) that you are importing from the file. Enter 
a column number of 0 (zero) for any item not contained in the file. 

4. Click the Next > button tn proceed to Step 3 of the Import 
Wizard. 

S t e p  3. Specify transformation and  filter operations 

1. Select Pre-Filter Operations for transforming time and 
displacement data contained in the file. Enter constants for 
subtraction and multiplication operations. 

TIPS - 
Subtract the static wafer level fmm each value of displacement 
contained in the file to transform depth to water values to 
displacement values. To transform negative displacements to 
positive displacements, multiply each displacement value by -1. 

2. Click the Filters ... button to select options for filtering the data 
imported from the file. 

TlPS 
7 

Use filters to reduce the number of observations contained i:! the 
impod file. Retain time values having a uniform logarithmic 
spacing or displacement values exceeding a minimum threshold. 

3. Click the Finlsh button to import data from the file. 

Slug Test Well 
Choose Slug Tes t  Well ... from the Edlt menu to open the Slug Test  Data 
dialog box for entering slug test data. 

Slug t e s t  data 

initial displacement in well [L] 

casing radius [L] 

wcllboreradiusF] 

saturated thickness of aquifer [L] 

screen length [L] 
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static height of water in well [L] 

&-osity of gravel pack [dimensionless] 

r ratio of vertical to horimntd hydraulic conductivity (for partially 
penetrating wells in an anisotropic aquifer) [dimensionless] 

Entering or importing slug test well measurements 

1. Click the Edit button to open the Observation Data dialog box 
for entering observation data from the keyboard (see "Entering 
Observations from the Keyboard" on page 24). 

2. Click the Import button to open the Import Wizard for 
importing observation data from a delimited text file (see 
"Importing Observations from a File" on page 26). 

Test Type 
Choose Test  Type ... from the Edit menu to select the type of test (pumping test or 
slug test) contained in an AQTESOLV for Windows data set. 

. . Setting the test type In a new'data set 
1. When you open a new AQTESOLV for Windows data set, the test 

typc is defined automatically when you enter pumping test or slug 
tcst data. 

2. If you enter data for a pumping well or observation well. 
AQTESOLV for Windows defines the test type as Pumping Test. 

3. If you enter data for a slug test well, AQTESOLV for Windows 
defines the test type as Slug Test. 

Changing the  test type in a data set 

1. The Edlt menu only enables options for the type of test contained 
in a data set. 

2. choose Editrrest Type ... to change the test type. 
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Viewing Data and Results 

Overview 

View Menu 
The View menu provides options for viewing data, solutions and estimation results. 
Two g e n d  types of views, plots and reports, are available for viewing data and 
solutions, and evaluating estimation nsults. Other options in the View menu allow 
you to customize the appearance of your plot. 

Format Menu 
The Format menu provides options for fomatting plots and reports. For plots, . 

choose options for specifying axes parameters, colors, fonts and symbols. For 
reports, select fonts and colors. 

Window Menu 
AQTESOtVfurWirrzlows alfows more than one view (window) for a data set. The 

: Window mem,provides you with options for opening new windows, positioning 
windows and activating windows. 

Choosing a View 

Plot Views 
Select diflerent plot views Graphical formats for viewing aquifer test (displacement) data and matching 
from the View menu or the analytical solutions include displacement vs. tlme, composite and derivatlve 
toolbar list box vs. time plots. AQTESOLV for Windows also provides discharge vs. time 

plots to view discharge rat- from variable rate pumping tests. 

Perform automatic estimation Graphical formats for examining residuals (errors) from the matching of analytical 
to view residual plots solutions to aquifer test data include resldual VS. time, residual VS. simulated , 

displacement and normal probability plots. 
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Displacement Vs. Tim.e Plot 

Chwse the Displacement-Time option from the View menu to plot values of 
displacement as a function of time in the active window, 

The Displacement-Tlme view option allows you to analyze 
displacement data fmm one or more observation wells contained in the 
active data set. 

For pumping test solutions containing only two parameters, 
Dispiacement-Time plots display a single type curve regardless of 
the number of observation wells shown on the plot. For solutions 
involving three or more parameters. Displacement-Time plots show 
one type curve for each observation well. 

Composite Plot 
Select Composite from the Vlew menu to plot values of displacement as a 
functions of time divided by the square of radid distance (ti?), 

The Composite view option allows you to analyze displacement data 
from one or more observation welts contained in the active data set. 

For pumping test solutions 'containing only two parameters, 
Composite ptots display a single type curve regatdlcss of the number 
of observation wells shorn on the plot. For solutions involving three 
or more parameters, Compostte.plots show one type curve for each 
observation well. 

Composlte plots are only enabled for data sets containing pumping 
test data. 

Residual Vs. Time Plot 
After performing automatic estimation of aquifer properties for a given analytical 
solution, plot residual values as a function of time by choosing Residual-Time 
from the Vlew menu. 

Ideally, the residual values should not exhibit correlation with time. 

. when Residual-The data are plotted linear axes, AQTESOLV for 
Windows fits a straight line to the data to indicate the degree to which 
the residuals are biased with respect to time. 

Residual Vs. Slmulated Plot 
After performing automatic estimation of aquifer properties for a given analytical 
solution, plot residual values as a function of simulated displacement by choosing 
Residual-Simulated from the View menu. 

Ideally, the residual values should not exhibit correlation with the 
values of simulated displacement. 

When Residual-Simulated data are plotted on linear axes, 
AQTESOLV for Windows fits a straight line to the data to indicate the 
degree to which the residuals are biased with respect to simulated 
displacement. 
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Normal Probability Plot 
After performing automatic estimation of aquifer properties for a given analytical 
solution, plot residual values on normal probability axes by choosing Normal 
Probability from the View menu. 

A Normal Probability plot displays the standard normal deviates of 
the ranked residuals (residuals sorted from smallest to largest) as a 
function of the residual values. 

If the residuals are normally distributed, they will fall on a straight 
line when plotted on normal probability axes. A Q m O L V  for 
Windows fits a straight line to residuals shown on the Normal 
Probability plot to measure the.degree to which the residuals fit the 
normality assumption, 

Deviations from a normal distribution may indicate inadequacy in the 
fit of the aquifa model to the data 

After sorting thc residual values for all observation wells, AQTESOLV 
for Windows plots the standard normal deviates using the plot symbol 
for the fmt obsmation well. 

Discharge Vs. Time Plot 
To view pumping well discharge rates from a variable rate pumping test, choose 
Discharge-Tlme from the View menu. 

The Discharge-Time view option allows you to view constant or 
variable pumping rates for one or more pumping wells. 

Discharge-Time plots are only enabled for data sets containing 
pumping test data 

Derivative Vs. Time Plot 
Choose Derivative-Tlme from the Vlew menu to display the first derivative of 
displacement data as a function of time. If you have chosen a solution, 
AQTESOLY for-Windowsalso plotsthe first dedvative of the solution. 

The ~erivatiue~ime view option allows you to view the first 
derivative of displacement measurements from one or more 
observation wells. 

Derivative-Time plots provide a useful diagnostic tool for detecting 
deviations in the rate of displacement change. For example, 
interpretation of a Derivative-Tlme plot can indicate the presence of 
aquifer boundaries, leakage and delayed gravity response. 

AQTESOLV for Windows computes derivatives for displacement 
using either nearest neighbor or smoothlng techniques. Choose 
Options ... from the Vlew menu to select the method used to 
calculate derivatives from displacement data. 

Linear Axes 
Choose Linear Axes from the View menu to display a plot with linear x and y 
axes. 
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Semi7Log Axes 
Choose Seml-Log Axes from the View menu to display a plot with a logarithmic 
x axis and a linear y axis. 

Log Axes 
Choose Log Axes from the View menu to display a plot with logarithmic x and y 
axes. 

Depending on the active view type and solution, not all axis types may be enabled in 
the View menu. For example, if the active window displays a plot of displacement 
vs. time with the Cooper-Jacob (1946) solution for confined aquifers, the Linear 
Axes and Log Axes options will be disabled because the Cooper-Jacob solution 
only plots as a stfaight line on semi-logarithmic axes. 

Show Data 
Choose Show Data from the View menu to enablddisable the display of 
observation well or residual dm on plots. 

Show Legend 
Choose Show Legend from the View menu to enablddisable the display of a 
legend on plots. The plot legend displays &bols for observation wells, aquifer 
type, solution method and paramem values. 

Show Type Curve 
Choose S h ~ w  Type Curve from the View menu to enablddisable the display of a 
type curve for the active solution on displacement vs. time and composite plots. 

Show Type. Curve Family . . 

Choose Show Family from the View menu to enableldisable tht display of a 
family of type curves for the active solution on displacement vs. time and composite 
plots. This option is only enabled if the active solution has two or more parameters. 

If you enable the Show Family option, A Q F O L V  for Windows will display two 
additional type curves, one above and one below-the curve matched to your data. By 
default, AQTESOLV for Windows multiplies the current value of the type curve 
family parameter (e.g., rt") by 0.5 to plot the upper curve and 2.0 to plot the lower - 
curve. To edit the multipliers used for the upper and lower curves, choose 
Optlons ... from the View menu. 

Show Theis Curve 
Choose Show Theis from the View menu to enablddisable the display of 
bounding Theis type curves for the active solution on displacement vs. time and 
composite plots. This option is only enabled if for pumping solut io~ having two or 
marc parameters. 

For example, two bounding Theis type curves are displayed for the Neuman solution 
for unconfined aquifers using the values of T and S for the firs1 curve and T and Sy 
for the second curve. 
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Show Valid Time ' 

Choose Show Vaiid Time from the Vlew menu to enablddisable the display of 
the time after which a straight-line approximation solution becomes valid on 
displacement vs. time and composite plots. This option is only enabled if the active 
solution is he  Cooper-Jacob (1946) solution for a confined or unconfined aquifer. 

To set a critical value of u used to compute the valid time, select Options ... 
from the View menu. 

Zoom 
Choosc Zoom... from the Vlew menu to change the size of the plot within the 
active window. 

1. Enter a Zoom Factor ranging from OS to 5. 

2. Use this optio" to scale the size of a plot within the active window. To 
scale the length of plot axes within dl windows attached to the active 
data set, see "Axes" on page 35. 

Choose Options ... from the View menu to open a d i o g  box for entering 
parameters controlling the display of valid times and type curve families. 

Critical Value of U 

1. Set the critical value of u used to compute the valid time displayed 
for the Cooper-Jacob (1946) solution when you enable the Show 
Valid l ime option in the Vlew menu. 

2. A conservative critical value of u is 0.01. 

Type Curve Families 

I .  Enter multipliers for the upper and lower type curves displayed 
when you enable the Show Family option in the Vlew menu. 

2. The upper curve. displayed above the active type curve, has a 
. - "  --.- + ----- multiplier less than I; the lower curve, displayed below the active 

type curve, has a multiplier greater than 1. 

Derivative Calculation 

1. Choose a method for calculating derivatives from time- 
displacement data (nearest neighbor or smoothlng). 

2. The nearest neighbor option provides the least amount of 
smoothing for "noisy" data and works well for displacement data 
that show ideal response. 

3. The.smoothing option allows you to choose a "smoothing 
factor" for the calculation of derivatives from "noisy" data Enter 
the smallest smoothing factor to discern the derivative pattern 
from the data. 
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Select Report Views from the 
V i m  menu or the toolbar list 
box 

Petform automatic esrirnation 
to view diagnostic report 

Click on the toolbar to 
refiexh display 

Report Views 
The View menu provides you with a Diagnostic report and a Complete report 
hat display textual summaries of your data set and the results of your aquifer test 
analysis. An Error Log report identifies any emrs  that your active data set may 
contain. 

Dtagnostlc Report 
Choose Diagnostics from the View menu to display a report containing 
estimation statistics for parameters (hydraulic properties) and residuals. The 
diagnostics report contains standard errors for estimated parameters, correiations 
between estimated parameters, and residual summary statistics. 

Complete Report 
Choosc Report from the View menu to display a complete report summarizing the 
amtents qf the activedata set and estimation results in a textual format. 

Error Log 
Choose Error Log from the View menu to display a report identifying any errors 
contained in theactive data set. Choose this report option if you are entering data 
into a new data set. 

Viewing Optlons 

Refresh 
Choose Refresh from the View menu to refresh (redraw) the plot or report in the 
active window. 

Toolbar 

Choose ~oolbar from the View menu to enablddisable the AQTESOLV for 
Windows toolbar. 

Status Bar 
Choose Status Bar from the View menu to enablddisable the AQTESOLV for 
Windows status bar. The AQ'ESOLV for Windows status bar contains four panes 
which indicate messages and slatus information. 

Message Pane 

The first pane in the status bar supplies descriptive messages for menu 
options. 

Check Errors lndlcator 

The second pane in the status bar displays the message Check Errors 
if AQTESOLV for Windows detects errors in active data set. TO 
view the errors, choose Error Log from the View menu. 
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Test Type Indicator 

' h e  third pane in the status bar displays either Pumping Test or 
Slug Test to indicate the type of test contained in the active data 
set  

Solutlon lndlcator 

The founh pane in the status bar displays the current solution for the 
active data set AQTESOLV for Windows will prompt you to 
choose a solution if the data set contains sufficient data to perfom 
a forward solution. 

I 
I Formatting a View 

Plot Formats 
Choose Plot from the Format menu to select options for formatting axes, symbols, 
legends and colors. 

Axes 

Choose PloVAxes ... from the Format menu to open a dialog box for editing plot 
axes. 

X and Y Axls Parameters 

1. Edit parameters controlling axis ranges, tickmarks and labels. 
Choose minimum and maximum values, major and minor 
tickmarks, and tickmark label spacing for each axis. 

2. Select the axis Label boxes to choose x- and y-axis labels. 
Choose one of the predefined axis labels or enter a new label. 

3 .  ~elect'the (Inits boxes to choose a format for appending units to 
the x- and y-axis labels. 

Optlons 

-1. - Check thk Upper Left Orlgln box to place.the origin of the plot 
axes in the upper left m e r  of the plot. 

2. Chcck the Show Graph Paper box to display horizontal and - 

vertical lines at the major tickmarks of the graph. 

3. Enter a value between 0.5 and 1.5 for the Axis Length Scale 
Factor to adjust the length of the axes displayed on the screen. 

4. Click the Font ... bhton to change the font used to display axis 
labels. 

5. Click the Color. .. button to change the color used for drawing the 
axis labels. 

Symbols 
Choose PloVSymbols ... from the Format menu to open a dialog box for editing 
plot symbols. 

1 
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Select a symbol type (e.g., square, circle, etc.) from Symbol box. 

Size 

Select a symbol size from Size box. 

Color 

Click the Color... button to change the color used for drawing plot 
symbols. 

Legend 
Choose PloVLegend ... from the Format menu to open a dialog box for editing 
plot legends. 

Font 

Click the Font... button to change the font used to display text. 

Color 

Click the Color... button to change the color used for text. 

Printer Options 

From the options provided, check the data to appear in the legend of 
printed plots. 

Curves 

.Choose PloVCurves... from the Format menu to open a dialog box for editing 
colors used for plotting curves. 

Report Formats 
Choose Report ... from the Format menu to open a dialog box for formatting 
reports. 

Header Text 

Enter text for a report header. 

Footer Text 

Enter text for a report footer. 

Prlnter Options 

Choose options for including blocks of text in a report. 

Font 

Click the Font ... button to choose a font for the report. 

Color 

Click the Color... button to choose a color for the report. 

Formatting Options 
Choose Optlons ... from the Format menu to enter formatting options for plots 
and reports. 
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Step Test Prediction Time 

1'. Enter a time for predicting drawd~wn in a pumping well 
including linear and nonlinear well losses based on .the Jacob- 
Rorabaugh equation (see "'lheis (1935) Solution for a Step 
Drawdown Test in a Confined Aquifer" on page 56). 

2. AQTESOLV for Windows uses the'prediction time to print the 
Jacob-Rorabaugh well-loss equation in plots and reports. 

3. The prediction time is not required for estimation of aquifer 
properties. 

Working with Multiple Views 
AQTESOLV for Windows idlows you to have more than one view (window) for a 
data s e t  The Window menu provides you with options for opening new windows, 
pasitioning windows and.activating windows. 

Opening a New Window 
Choose New Wlndow from the Window menu to open a new window for the 
active data sct The new window will have the same view @lot or report) as the 
previously active window. To change the view, select a view option from the View 
menu. 

Cascading Windows 
Choose Cascade from the Window menu to cascade windows from the upper left 
comer of the AQTESOLV for Windows client m a .  

Tiling Windows 
Choose Tiie Horlrontal or Tiie Vertical from the Window menu to tile windows 

' -  '-horizontally or vertically, respectively. 
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Knrseman, G.P. and N.A. DeRiddcr, 1990. Analysis and Evaluation of 
Pumving Test Data (2nd ed.), Publication 47, Intern. Inst. for Land 
Reclamation and Improvement. Wageningen, The Netherlands, 370p. 

Tutoriai 

Perform the tutorial for the cooper-~acob (1946) solution for a pumping test in a 
confined aquifer (see "Tutorial" on page 47) to learn how to use this solution. 

Neuman (1974) Solution for a Pumping Test in an 
Unconf lned Aquifer 
Neuman (1974) derived an analytical solution for unsteady flow to a partially , 

penetrating well in an unconfined aquifer with delayed.gravity response: 
I .  

For a partially penetrating pumping well, the drawdown in a piezometer is found 
using the following equations: 

For apartially penetrating pumping well, the drawdown in a partially penetrating 
observation well is found using the following equations: 

I 
I 

66 Choosing a Solution AQTESOLV for Windows User's Guide 



The gamma terms are the roots of the following equations: 

Refer to the "List of Symbols" on page 109 for a description of the parameters and 
variables contained in the equations. 

AQTESOLV for windows allows you to analyze both constant- and variable-rate 
pumping tests using the Neuman solution.. For tests with a variable discharge rate,. 
the program uses the principle of superposition ta compute drawdown in the 
aquifer. For more inforkation concerning the application of the principle of 
superposition in variable-rate pumping tests, refer to the "Theis (1935) Solution for 
a Pumping Test in a Confined Aquifer" on page 40. 

The Neurnan solution supports observation welis and piezometen. Use this solution 
to estimate values of transmissivity, elastic storage coefficient, specific yield and 
Bbeta (or KfiKzlKr for a data set containing more than one pair of pumping and 
observation wells) in an unconfined aquifer. 

Entering parfial penetration The equations of Neuman (1974) for a partially penetrating observation well or a 
data for observation wells or pietometer use elevations measured from the base of the unconfined aquifer (zm 
piczometers Z ~ D .  zD); however, when entering partial penetration data for observation wells and 

pierometen into AQTESOLV for Windows, input depths measured from the 
potentiometric surface before pumping (static water table). 

Assumptions 

aquifer has infinite areal extent 

AQTESO~V for Windows User's Guide Choosing a Solution .* 67 



aquifer is homogeneous and has uniform thickness 

aquifer potentiomelric surface is initially horizontal 

aquifer is unconfined 

flow is unsteady 

diameter dpumping well is very small so that storage in the well can 
be neglected 

Data Requirements 
. pumping and observation well locations 

pumping rate@) 
. . observation well measurements (time and displacement) 

aquifer satmated thickness 

partial penetration depths (optional) 

Solution Options 
* variable pumping rates 

r multiple pumping wells 

multiple observation wells 

partially penetrating wells 

Visual Curve Matching 
In practice, one use two sets of type curves to analyze a pumping test in an 
unconfined aquifet with the Neuman solution. Type A curves match early time 
data and Type B curves match late time data: 

To analyze a pumping test using the Neuman type curve method, one plots 
drawdown as a function of time on double logarithmic axes. By matching two 
families of type curves drawn by plotting w(uA$) as a function of I/uA and w(u~,P) 
as a function of 1/us, one can estimate the values of uansmissivity, storage 
coefficient, specific yield and Pbeta by visual analysis. 

Procedure for Visual Curve Matchlng 

I .  Match Type A curves to early drawdown data to estimate T, S 
and Pbeta. 

2. Match Type B curves to late drawdown data to estimate T, Syy 
and @beta. 

3. From the View menu, choose Type A or Type B to display the 
type curve for the active value of Pbeta and initiate visual curve 
matching. 
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4. Choose Increase beta or Decrease beta from the View menu 
to change the value of Bbeta used for visual curve matching. 

5. Click and hold the left mouse button down to drag the Neuman 
type curves to a new position on the screen. Release the left 
mouse button when you have finished moving the curves, 

Partial Penetration v p e  Curves 
AQTESOLV for Windows st&s Type A and Type B curves for fully penetrating 
wells. If your data set contains partially penetrating wells, however, you must 
compute new Type A and Type B curves for the partial penetration depths of the 
pumping and observation wells. AQTESOLV for Windows automatically prompts 
you when new partial penetration type curves are required for your data set. 

Computing Curves 

Choose Calculate in the Partial Penetratlon i=urves dialog box to 
compute partial penetration curves using partial penetration data 
for the pumping and observation wells. AQTEBOLV for 
Windows will save the partial penetration curves with the data set, 

Retrieving Cunres From Disk 

Choose Retrieve from disk from the Partial Penetratlon Curves 
dialog box ,to open a disk file containing partial penetration type 
curves. . 'he format of the file is compatible with DOS versions of 
AQTESOLV. 

Saving Curves on Disk . 
After computing partial penetration type curves, AQTESOLV for 

~indows'~rompts you to save the type curve data on disk. The 
format of the file created by AQTESOLV for Windows is 
compatible with DOS versions of AQTESOLV. 

References 
Neuman, S.P., 1974. Effect of partial penetration on flow in unconfined 

aquifers considering delayed gravity response. Water Resources 
R-earcb, vol, 10, no. 2, pp. 303-312. 

Moench, A.F., 1993, Computation of type curve. for flow to partially 
penetrating wells in water-table aquifers, Ground Water, vol. 31, no. - 
6, pp. 966-97 1. 

Moench, A.F., 1996. How to a well in a water-table aquifer: an improved 
Laplace transform solution, Ground Water, vol. 34. no. 4, pp. 593- 
596. 

Tutorial 
Access the tutorial for this solution from the on-line User's Guide in AQTESOLV 
for Windows. 

In this tutorial, you will use the Neurnan and Quick Neurnan type curve solutions to 
analyze a constant rate pumping test in an unconfined aquifer. This tutorial shows . 
you how to use visual and automatic cuwe matching to match Neuman type curves 
to drawdown data measured during the lest. 
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Open a New Data Set 

open a new data s& by choosing New from the File menu. In the New Data Set  
dialog box, choose Tutorial in the list box and click OK to initialize the new data 
set with default values. AQTESOLV for Windows opens a new window with an 
E m r  Log view that reports any errors identified in the data set. 

Enter bata for Pumping Test 

Choose Units. .. from the Edlt menu to open the Units dialog box for selecting 
units of measuremeht for the data set. 

I .  Select ft (feet) for Length, min (minutes) for Time, gdmin 
(gallons-per-minute) for Pumping Rate and fthnin (feet/rninute) for 
Hyd. Conductivity. 

2. Click the OK button to close the Units dialog box. 

~hoase ~itle..,%om the Edit menu to open a dialog box for editing the data set 
title, 

1. Enter Fairborn, 'Ohio for the Title. 

2. Click the OK button lo close the dialog box. 

Choose Aquifer Data, from the Edlt menu to open a dialog box for editing 
aquifer data. 

1. ' Enter 78.0 for the-value of Saturated Thickness. 

2. Click the OK button to close the dialog box. 

Choose Pumplng WeiVEdit... from the Edit menu to open the Pumping Well 
Data dialog box for editing pumping well data 

1. Click the Edit button to open the Pumplng Period Data dialog box 
for entering pumping rates. 

2. In the Tlme and Rate edit controls, enter values of 0.0 and 1080.0 
for time and rate, respectively, where time is in minutes and rate is in 
gallons-per-minute. - 

3. Click the <<Add button to transfer the values you entered to the list 
box. 

4. Click OK to close the Pumplng Period Data dialog box. 

5. Click OK to close the Pumplng Weli Data dialog box. 

Choose Obs. WelVEdit. .. from the Edit menu to open the Observatlon Well 
Data dialog box and edit data for the observation well. 

1. Enter a value of 73.0 for the X-Coordinate location of the well. 

2. Click the lmport button to import observation well measurements 
from a delimited text file using the Obsewatlon Data lmport 
Wizard. In Step 1 of the import Wizard, cntcr FAIRBORN.DAT 
for the name of the import file. The file FAIRBORN.DAT contains 
time and displacement data arranged in two columns separated by a 
tab delimiter. Click h e  Next button to proceed to the next step. 

3. In Step 2 of the lmport Wlzard, enter data describing the structure of 
the import file. The import Wizard automatically determines that 
the import file contains 2 columns of data. Enter 1 for the Elapsed 
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Time column and 2 for the Displacement column. Click the Next 
button to proceed to the next step. 

In Step 3 of the Import Wizard, choose transformation and filter 
options for the data contained in the import file. Retain the default 
settings, and click the Flnlsh button to import data from the file. 

After AQTESOLV for Windows has finished importing the data, a 
message box displays the number of observations imported from the 
file. Click the OK button to close the message box, 

Click the OK button to close the Observation Well Data dialog 
box. 

After you have completed the previous data entry steps, the Error Log displayed in 
the active window should show that the data set contains no errors. Now you are 
ready to display the data, c l p x e  a solution and estimate aquifer properties. 

Save Data 'Set 

Choose Save AS.. . from the Flle menu to open a dialog box for saving the data you 
have entered Into the current data set. 

I. Enter NEUMANlAQT for the file name. 

2. Click the OK button to close the dialog box and save the data set. 

Change View In Window . , 

Choose Displacement-Time from the View menu to display a plot of 
displacement vs. time in the active window, The window displays a plot of the 
observation well data on semi-log axes. 

Choose Qulck Neuman Solution 

Change the aquifer model and solution by choosing Unconfined... from the 
Solutlon menu to open a dialog box  with solutions for analyzing pumping tests in 
an unconfined aquifer. 

1. Choose the Quick Neuman solution. 

2. Click the OK .button toclose the dialog box. 

. . -- - - - - - -- -- A f t ~  you have selected the Quick Neuman solution for a pumping test in an 
- -. . - - - unconiriedaquifer, AQTESOLV forWimdows updates the window by plottlng the 

data on double logarithmic axes, superimposing a Neurnan type curve on the pIot, 
and displaying values of transmissivity m, storage coefficient (S), specific yield - 
(Sy) and beta in the legend. 

m e  Quick Neuman implementation of the Neuman solution, rather than the full 
Neuman solution, is ideal for most situations. Computations with Quick Ncuman 
are much faster than Neuman with virtually no loss in accuracy. Therefore, you 
should uqe Quick Neuman for initial estimation followed by Neuman to refine the 
estimates obtained with Quick Neuman. 

Perform Vlsual Matchlng with Quick Neuman 

Visually match the Quick Neuman solution to the data as follows: 

1. Choose Type A from the Match menu to match Type A curves to the 
early data. 

2. Choose Increase beta or Decrease beta from the Match menu to 
display a Type A curve using one of the 19 preset values of beta - 
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To begin interactively moving the Type A curve, movc the mouse 
cursor over the plot. click the left mouse button, and hold it down. 

As you movc the.mouse, the type curve also moves. AQTESOLV for 
Windows updates the values of T and S in the legend as you move the 
Type A curve. 

When you have finished matching the Type A curve to the early data, 
release the left mouse button to end visual curve matching and redraw 
the complete type curve. 

Choose Type B from the Match menu to match Type B curves to the 
late data. 

Follow the procedure for Type A curve matching to tit a Type B curve 
to the late data. As you move the Type B curve, AQTESOLV for 
Windows updates the values of T and Sy in the legend. 

You should obtain a match using a value of 0.06 for beta If necessary. repeat the 
preceding steps to finish matching the Type A and B curves. 

Perform Automatlc Matching with Quick Neuman 

Choose Automatic ... from the Match menu to open a dialog box for performing 
automatic matching of the Neuman type curve solution to the observation well data 

1. Click the Start button to behn the automatic estimation procedure. 

2. As the automatic estimation procedure completes iterations, the dialog 
box displays the changes in the residual sum of squares W S )  criterion 
and the values of the aquifer properties. After the automatic 
estimation procedure finishes, AQTESOLV for Windows displays a 
message box containing residual summary statistics. Click the OK 
button to close the message box. 

3. Click the Close button when the automatic estimation procedure has 
finished. 

The plot shown in the active window displays the values of transmissivity 
(T=24.04), storage coefficient (S4.0.00211 l), specific yield (Sy=0.1061) and beta 
(=0.4458) determined by automatic estimation. 

Choose  Neuman Solution 

Change the aquifer model and solution by choosing Unconfined ... from the 
Solution menu to open a dialog box with solutions for analyzing pumping tests in . 

an unconfined aquifer. 

1. Choose the Neuman (1974) solution. 

2. Click the OK button to close the dialog box. 

Compared to the Quick Neuman implementation of the Neuman solution, the full 
Neuman implementation is cornputationally mote intensive and therefore requires 
greater time to plot the type curve. In all other respects, working with the Neuman 
solution for visual and automatic curve matching is identical to Quick Neuman. 

Save Data Set 

Choose Save from the Flle menu to save your work in the NEUMANlAQT data . 

set. 

I 
72 Chooslng a Solution AQTESOLV for Windows User's Gulde 



Quick Neuman Solution for a Pumping Test in an ,i e,! 
Unconf iried ~ q u ~ f e r  A J' I 
The Quick Ncuman solution option provided by AQTESOLV for Windows 
computes Neuman type curves using a tw+stage interpolation technique. 

i 
QuickNeuman yields essentially the same results as the Neuman solution option, 
only much more quickly. Therefore, Quick Neuman is a viable alternative for 
performing automatic curve matching prior to using Neuman (see "Neuman (1 974) 

r 
1 

Solution for a Pumping Test in an Unconfined Aquifer" on page 66). 

Assumptions 

aquifer has infinite areal extent 

aquifer is homogeneous and has uniform thickness 

aquifer potentiometric surface is initially horizontal 
I 

aquifer is unconfined 

flow is unsteady 

0 diamdh of pumping well is very small :;o that storage in the well can 
be neglected 

Data Requirements 

pumping and observation well locations 

pumping rate(s) 

obse~ation well measurements (time and displacement) 

aquifer saturated thickness 

partial penetration depths (optional) 

Solution Options I 

variable pumping rates 

multiple pumping wells 

multiple observation wells 

-I 
partially penetrating wells I 

Reference I 

Neuman, S.P., 1974. Effect of partial penetration on flow in unconfined 
aquifers considering delayed gravity response, Water Resources 
Research, vol. 10, no. 2, pp. 303-312. 

Tutorial i 
To learn how to use the Quick Neuman solution. perform the tutorial for the 
Neuman (1974) Solution for a Pumping Test in an Unconfined Aquifer. 

4~ 
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List of Symbols 
a = constant defrning variation in thickness of wedge - shaped aquifer [L;' 1 
b = thickness of aquifer [I,] 
bo = thickness of aquifer at pumping well 61 
b, = thickness of fracture skin [L] 
b' = thickness of aquitard overlying aquifer in leaky system or 

one - half thickness of blocks in fissured system [L] 
b" = thickness of aquitard underlying aquifer L] 
B = leakage factor w'] 
B(Q, t) = linear head - loss coefficient fT/ L ~ ]  
B, (r, , t) = linear aquifer - loss coefficient [T/ L ~ ]  
B, = linear well - losscoefficient [T/ L2] 
C = nonlinear well - loss coefficient v2 / L?] 
d, = vertical distance between top of perforations in pumping 

well and initial position of water table divided by initial 
saturated thickness of aquifer k] 

H = static height of water in well measured from base of well 
to static water level [L] 

I-& = initial displacement in well due to slug injection or extraction [L] 
J, = Bessel function of fvst kind, zero order 
J,  = Bessel function of fmt kind, first order 
K = hydraulic conductivity of fractures in fissured system &/TI 
KO = modified Bessel function of second kind, zero order 
K, = modified Bessel function of second kind, first order 
K, = radial (horizontal) hydraulic conductivity of aquifer [L / TI 
K, = hydraulic conductivity of fracture skin [L / TI 
K, = vertical hydraulic conductivity of aquifer &/ TI 
K' = hydraulic conductivity of aquitard overlying aquifer in 

leaky system or block system in fissured system TI 
K" -=- hydraulic conductivity of aquitard underlying 

aquifer / TI 
1, = vertical distance between bottom of perforations in 

pumping well and initial position of water table divided by 
initial saturated thickness of aquifer L] 

L = length of well screen [L] 
p = Laplace transform variable 
P = order of nonlinear well - losses [dimensionless] 
Q = pumping rate b3 / T] 
r = radial distance [L] 
r, = well casing radius &] 
re = equivalent radius over which head loss occurs [L] 
r, = well radius [L] 
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s = displacement [L] 
s, = displacement at time t [L] 
so = initial displacement in well [L] 
S = coefficient of storage of aquifer [dimensionless] 
S, = fracture skin [dimensionless] 
S, = specific storage of aquifer or fractures in fissured system [ 
S: = specific storage of aquitard in leaky system or 

blocks in fissured system [L"] 
S, = wellbore skin [dimensionless] 
S ,  = specific yield of aquifer [dimensionless] 
S' = coefficient of storage of aquitard overlying aquifer 

[dimensionless] 
S" = ceeffrcient of storage of aquitard underlying aquifer 

[dimensionless] 
t = time since pumping began 
t, = dimensionless time with respect to S, equal to Tt /sr2  IT] 
t , = dimensionless time with respact to S, equal to Tt 1 s ,r2 m 
T = trammis~ivity [12 I TI 
xo = x - coordinate location of pumping well p] 
y = variable of integration 
yo = y - coordinate locati~n of pumping well L] 
Yo = Bessel function of second kind, zero order 
Y, = Bessel function of the second kind, fmt order 
z, = vertical distance above bottom of aquifer divided by 

initial saturated thickness of aquifer L ]  
z,, = vertical distance from bottom of aquifer to bottom of 

observation well perforations divided by initial saturated 
thicknessof aquifer &] 

z,, = vertical distance fiom bottom of aquifer to top of 
observation well perforations divided by initial saturated 
thickness of aquifer [L] 

- . - - -  -- -- up- - - -- 
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Estimating Aquifer Coefficients 

Overview 
The Match menu provides two methods for estimating the hydraulic properties of 
aquifers from pumping tests and slug tests. Each method matches analytical 
solutions to data measured during an aquifer test. 

The first method, visual matching, is analogous to traditional 
graphical methods which rely on manually fitting type curves or 
straight lines to determine hydraulic parameters. 

The secdnd method uses a nonlinear least-squares parameter 
estimation technique to automatically fit analytical solutions to aquifer 
test data. 

Whichever method you choose, AQTESOLV for Windows allows you to visualize 
the results of y o l ~  analyk'rs by plotting the solution and data. In addition, the 
automatic curve matching technique provides statistical measures of the "fit" of the 
solution to the data. 

Editing Parameters and Estimation Options 

Setting Parameters 
Choose Parameters., from the Match menu to open a dialog box for editing 
values of the hydraulic parameters in an aquifer model, setting parameter bounds, 
and enablingtdisabling parameters for automatic estimation. 

Settlng Parameter Values 
Choose Parameters ... from the Match menu to open a dialog box for editing 
values of the hydraulic parameters in an aquifer model. Enter new values in the 
Estimate boxes for each parameter. 

For example, if you are matching the Theis (1935) solution to your data. use the 
Estimate boxes to assign values for the transmissivity (T) and storage coefficient 
(S) parameters. 

AQTESOLV for windows User's Guide Estimating Aquifer Coefficients 111 



Automatically Setting Parameter Values 

1. click ~utomatlc ... to set parameter estimates to values 
:yCI 
i I : 

detennined,most recently from automatic curve matching. 

2. Click Visual,.. to set parameter values to their visual curve 
matching estimates. 

3. Click Current-.. to reset the parameters to their current values. 

~s&gning Parameter Bounds 
Choose Parameters... from the Match menu to assign feasibility constraints for 
each of the parameters in a solution during automatic curve matching. Enter I 
constraints in the Minimum and Maximum boxes for each parameter. 

1 

For example, if you are estimating transrnissivity (T) in the Theis solution. you can I 
constrain the range of T between a minimum value of 10 and a maximum value of i 

100. During automatic curve matching. AQTESOLV for Windows will constrain 
the estimated value of T to lie between 10 and 100. I 

I 
~ctivating/D~activati& Parameters 
Choose Parameters... from the Match menu to activate or deactivate the 
estimation of certain parameters during automatic curve matching. The Active? 
check boxes indicate the active or inactive status of each parameter. 

For example, to estimate transmissivity O and hold storage coefficient (S) constant 
in the Theis solution. deactivate (turn off) estimation by removing the check in the 
Active? field f a  S. 

Controlling Automatic Estimation 
Choose Itetatlons.. from the Match menu to edit parameters which control the 
automatic curve matching p w e d m  

Automatic curve matching changes the values of parameters using an iterative 
procedure to match a type curve or straight line as closely as possible to your data. 
In each iteration, the automatic curve matching algorithm seeks parameter 
adjustments that reduce the residual sum of squares (RSS). When additional 
iterations fail to lower the RSS, AQTESOLV for Windows automatically terminates 
the iterations. 

Convergence Criterla 1 
If you wish to control the iteration procedure yourself, you can edit the following 
three criteria which control the termination of the automatic curve matching 
algorithm: 

maximum number of iterations 
I 

residual sum of squares tolerance I 
parameter change tolerance 

During automatic curve matching, AQTESOLV for Windows checks each of the 
criteria at the end of each iteration. If the iterations reach the maximum number of 
iterations criterion or the RSS reaches the RSS tolerance or the maximum change 
in any of the estimated parameters reaches the parameter change tolerance, the 
iterations terminate. 

4 
I 

M? 

112 Estirnatlng Aqulfer Coefncients AQTESOLV for Windows User's Gulde I 



Generally, you should maintain the tolerances for RSS and parameter change at 
small values (e.g., 1 x 10'"1 .OE- 10); however, for certain solutions, changing the 
maximum number of iterations may be valuable. For example, if the automatic 
curve matching feature is converging slowly, you may wish to increase the 
maximum number of-iterations. 

Setting Match Options 
Choose Options.. from the Match menu to enablddisable the following solution 
options: 

partial penetration 

*' multiple wells 

if your data set includes partially penetrating wells or more than one pumping well. 
This f a twe  allows you to examine, effects of enablinddisabling partial penetration 
or image well data. 

Automatic Curve Matching 
Click # on the toolbar to Choose Automatic... from the Match menu to use automatic curve matching to 
invoke automatic cuwe estimate the values of hydraulic parameters. This procedure automatically adjusts 
matching the values of hydraulic properties to achieve the best statistical match betwwn the 

solution (i.e., type cwve) and the test data 

The automatic curve matching feature provided by AQTESOLV for Windows uses a 
nonlinear least squares estimation procedure to match a type curve or straight-line 
solution to your data. The prucedure iteratively minimizes the "residuals" or errors 
between the computed and the observed drawdown or displacement. 

Starting Estimation 

Click thestart button to begin the procedure of automatically matching a solution 
to your data. During automatic estimation, thedialog box displays a residual sum 
of squares (RSS) convergence criterion and the values of the estimated parameters 
.whi$h indicates the progress,of th!: autqmatic .curve matching. 

Aborting Estlmation 

Click the Abort button to To halt estimation before any of the termination criteria are met. click the Abort 
- 

terminate automatic button. Viewing residual plots and diagnostic statistics requires that you allow the 
estimation at any time. automatic estimation procedure to terminate normally; if you halt estimation 

prematurely, you will not be able to view residual plots or diagnostic statistics. 

Tips 

In general, automatic curve matching pcrforms more efficiently with good starting 
guesses for the hydraulic properties in an aquifer model. One way to ensurc good 
initial guesses is to perform visual curve matching prior to initiating automatic 
estimation. For salutions involving three or mow parameters, it a good idea to 
perform visual estimation prior to automatic curvc matching. 

If you wish to perform autovtic curve matching with the Neurnan (1974) solution, ' 
the following procedure is strongly recommended: 

-. 
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1. Perform visual curve matching with Quick Neuman to determine 
initial estimates of hydraulic properties. 

2. Perfonri automalic curve matching with Quick Neuman to refine the 
parameter estimates. 

3. In most cases, the parameter estimates determined using Quick 
Neurnan are sufficiently accurate; however. if desired, you can further 
refine the parameter estimates by changing the solution method to 
Neuman (1974) and performing automatic estimation. 

How Automatic Curve Matching Works 
AQTESOLV for Windows performs nonlinear weighted least-squares parameter 
estimation (automatic curve matching) using the Gauss-Newton linearization 

. method To improve the conveqence of the method from poor initial guesses for 
the unknown parameters, AQTESOLV for Windows includes the Marquardt 
corrktion factor (Marquardt, 1963). 

In the Gauss-Newton met& of parameter estimation, the parameter corrections 
necessary to minimize the difference between observed and estimated values of the 
response variable can be expressed as a Taylor series- expanded about the current 
estimated value as follows: 

where: 

y, = ith observed value of response variable 
9, = estmate of the ith value of response variable 

- I  -60 Ab = parameter correction, b 
6' = updated estimate of the unknown parameter 
6' = current estimate of the unknown parameter 

The previous equation can be linearized by truncating the Taylor series after the 
first derivative as follows: 

Thus, for p unknown parameters, the general linearized equation for computing 
parameter corrections is written as follows: 

The previous equation is written for each observed value of the iesponse variable. 
The partial derivatives of the response variable with respect to the unknown 
parameters are known as sensitivity coeff~cient The resulting system of linearized 
equations is solved iteratively until convergence is obtained. The objective function 
for this minimization problem is the sum of the squared residuals given by the 
following expression: 
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where n is the total number of observed values of the response variable. In matrix 
' 

form, the Gauss-Newton method computes parameter correction as follows: 

where: 

Al3 = p x 1 vector of parameter corrections 
X = n x p matrix of sensitivity coefficients 
XT = p x n transpose of X 
XTX = p x p variaric; -covariance matrix 
AY = n x 1 vector of residuals (yi - 9 , )  

.To improve the conditioning of the varian~avariance matrix, AQTESOLV for 
Windows adds the Marpuardt correction factor to the previous equation: 

where: 

h = Marquardt correction factor 
I = identity matrix 

Thc Marquardt correction factor is added when parameter corrections computed by 
the Gauss-Newton method fail to redm the residual sum of squares (RSS). 
Iterations performed with the Marquardt correction factor start with a sufficiently 
small value of Alambda; larger values of Mambda are added until the RSS is 
reduced. The parameter estimation algorithm terminates when the RSS is 
minimized. 

Weighted least-squares estimation is accomplished as foil 3ws: 

~ . . 
where: 

W = n x n nonsingular symmetric matrix obtained from oTo 
w = n x n diagonal matrix of weights 

Thus. in this implementation of the weighted least-squares algorithm, a larger 
weight assigned to a measurement results in greater influence by that measurement 
in the parameter estimation procedure. 

Visual Curve Matching + 

Click .y on the toolbar to Choose Visual from the Match menu to invoke the visual curve matching feature 
initiate visual curve matching provided by AQTESOLV for Windows. By selecting this option, you can 

interactively match a rype curve or straight line to your data The Visual option is 
only available if you are viewing a displacement vs. time or composite plot in 
the active window. 

AQTESOLV for Windows lets you perform visual estimation of aquifer properties 
by using a mouse to move a type curve or straight line on the screen. 
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Matching Type Curves I 

I .  ~fter'choosin~ the Visual option from the Match menu, click and 1 -4 .. 
hold the Icfl mouse button down within the plot axes. I 

2. Move.& mouse to match the type curve to your data As you move 
the type curve, AQTESOLV for Windows automatically updates the 
plot legend to reflect changes in parameter values. 

3. Release the left mouse button when you have finished matching the 
type curve. 

Matching Straight Lines 

1. After choosing the Visual option from the Match menu, move the 
I 

mouse to a point located on the new straight line you wish to match to 
you data. Click and hold the left mouse button down to anchor the 
new straight line at this point: - I 

2. Move the mousd to match a new straight line to your data. As you 
move the mouse, AQTESOLV for Windows drags a straight line 

. between the anchor point and the position of the mouse. 

3. Release the left mouse button when you have finished matching a new 
straight line. AQTESOLV for Windows automatically updates the 
plot legend to reflect changes in parameref valucs. 

Sensitivity Analysis 
Choose Perturb,. from the Match menu to test the sensitivity of the fitted solution '$ 

to discrete changes in the valucs of parameters in the aquifer model. 

Performing Sensitivity Analysis 

1: Select one or mori you wish to perturb in the list box; I 
2. Click a radio button to increase or decrease the selected parameters. I 

3. Enter a percentage for the perturbation applied to each selected 
parameter. I 

4. - : click th= OK button to.pmeed with thesensitivity analysis. 
1 

Options for Neuman Type Curve Matching 
The Match menu and toolbar provide several options that are available only when 
performing visual curve matching with the Neuman and Quick Neuman solutions. ' 

See "Automatic Curvc Matching" on page 113 for tips on using automatic curve 
matching with the Neuman solution. 

TY pe A 
I 

Click A on the toolbar to use Choose Type A from the Match menu to invoke visual curve matching with the 
Type A curves Neuman or Quick N e u m  solution using Type A curves. Type A curves allow you 

to estimate values of transmissivity (T) and elastic storage coefficient (S). 
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Click on the 
Type B curves 

Procedure 

For a fixed value of @eta, match Type A curves to early time- 
displacement data. 

Click and hold the left mouse button in the plot area to drag the type 
curve to a new location. 

Choose Increase beta or Decrease beta from the Match menu to 
change the value of pbeta used to draw the Type A curves. 

toolbar to use Choose Type B from the Match menu to invoke visual curve matching with the 
Neuman or Quick Neuman solution using Type B curves. Type B curves allow you 
to estimate values of transqissivity O and specific yield (Sy). 

Procedure 

1. For a fixed value of Pbeta, match Typo B curves to late time- 
displacement data. 

2. Click and hold the left mouse button in the plot area to drag the type 
curve to a new location. 

. ... . 3. Choose lncrease beta or Decrease beta fr-om the Match menu to . 
change the value of flbeta used to draw the Type B curves. 

Decrease Beta. 
Click % on the toolbar to Choose Decrease beta from the Match menu to decrease the value of pbeta used 
decrease beta for visual curve matching with the Neuman and Quick Neuman solutions. 

lncrease Beta 
Click on the toolbar to Choose Increase beta from the Match menu to increase the value of pbeta used 
increase beta for visual curve matching with the Neuman and Quick Neuman solutions. 
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Obtaining Output 

Overview 
AQTESOLV for Windows has two options for obtaining output from the program. 
First, you can print plots and reports Qn output devices conntcted to your computer. 
Second you can export data from the program to files for use by other software. 

Printing Plots and Reports 
The File menu provides options for obtaining printer output from AQTESOLV for 
Windows. The options allow you to print plots and reports, preview the printed 
appearance of plots and reports prior to printing, and configure a printer connected 
to your computer. 

Printing 
Click & on the toolbar to Choose Print... from the File menu to open a dialog box for printing the plot or 
open the Print dialog box report in the active window. Click the Setup ... button to select a specific printer. 

Firint Preview 
Click on the toolbarfor Choose Print Preview from the File menu to preview the appearance of a plot or - 
Print Preview report prior to printing. While previewing, click the Print ... button to print the 

plot or report or click the Close button to end print preview without printing. 

Print Setup 
Choose Print Setup ... from the Flle menu to open a dialog box for choosing the 
specific printer connected to your computer, selecting paper size and orientation, 
and setting printer options. 

Page Setup 
Choose Page Setup ... from the File menu to open a dialog box for configuring 
the printing of report headers and footers. 
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Margins 

~nter'values (in inches) for the margins of printed pages of reports and 
plots. 

Headers and Footers 

Select these options to show headers and footers displayed on the 
printed pages of reports. 

Font Rotation 

S e l ~ t  this option to display the y-axis plot labels with a rotated font. 
This option is disabled if the current default printer connected to 
your system does not support font rotation. 

Troubleshooting 

Y-Axis Label Prlnted Horizontally 
If you encounter difficulties printing the y-axis label of a plot, perform each of the 
following steps in succession to remedy the problem 

1. Check the settings in the Print Setup ... menu. Make sure you are 
using the correct driver for your printer. 

2. If available, select-the option to print graphics in master mode in the 
Prlnt Setup ... menu. 

3. If available, select the option to print True Type fonts as graphics in 
the Prlnt Setup ... menu. 

4. Overtide font rotation for the y-axis label in the Page Setup ... menu. 

2. If available, select the option to print True Type fonts as graphics in 
the Print Setup ... menu. 

Plot Legend Exceeds Page Size 
If the legend beneath a plot exceeds the page size, choose Plotllegend ... from the 
Format menu and perform one or more of the following remedies to decrease the 
size of the legend. 

1. Click the Font ... button to select a smaller font size. 

2. In the noup of Printer Options, deactivate one or more of the tejtt 
blocks displayed in the legend (e.g., title, project info, asuifer data 
or well data). 

Plot or Report Output Is Compressed 

If the output for a plot or report appears compressed on the output device, attempt 
the following remedies. 

1. If available, select the option to print graphics in raster mode in the 
Print Setup ... menu. 
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Exporting Data and Type Curves 
To Save Data in a File 

Choose ExporVData ... from the File menu to export data from AQTESOLV for 
Windows to a file. A dialog box prompts you for the name of a file for the exported 
data. 

To Save Type Curves in a File 

Choose Exportrrype Curve ... from the File menu to export type curves from 
AQTESOLV for Windows to a file. A dialog box prompts you for the name of a file 
for the exported data. 

Format of Exported Flles 

When you export data or type curves, AQTESOLV for Windows creates a text 
(ASCII) file consisting of two columns with a tab separator. The first column 
contains data plotted on the x-axis and the second column contains data plotted on 
the y-axis of an AQTESOLV for Windows plot. 

The following table lists the variables exported for each type of plot displayed by 
AQTESOLV for Windows. 

Residual vs. Time 1 time 1 residual 

Residual vs. Simulated displacement residual 
I I 

Y 

displacement 

displacement 

TYPE OF PLOT 

Displacement vs. Time 

Composite 

Derivative vs. Time time derivative 

X 

time 

timdradiusA2 

Discharge vs. Time I time I discharge rate . 
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Glossary of Terms 

Aquiclude 
A saturated geologic unit that is incapable of transmitting significant quantities of 
water under ordinary hydraulic gradients. 

Aquifer 
A saturated pemeable geologic unit that can transmit significant quantities of water 
under ordinary hydraulic gradients. 

Aquitard 
A saturated geologic unit that transmits water in quantities insufficient for 
economic use. 

Casing Radius 
Radius of unperforated portion of well casing. 

Ciient Name 
A user-supplied character string (up to 30 characters) storing the name of the client 
which sponsored the aquifer test. Used for reports and plots. 

Coeff lcient of Permeability 
See Hydraulic Conductivity. 

Company Name 
A user-supplied character string (up to 30 characters) storing the name of the 
company which conducted the aquifer test. Used for reports and plots. 

Confined Aquifer 
An aquifer with upper and lower boundaries consisting of aquicludes. 
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test. Used for reports and plots. 

Displacement 
Change in water level relative to static condition. 

Double-Porosity Fractured Aquifer 
An aquifer represented by a double porosity system consisting of low-permeability, 
primary porosity blocks and high-permeability, secondary porosity fissures. 

.Fracture Skin 
A thie, low-permeability material coating the surface of fractures (e.g., mineral 
deposit) that restricts flow of water. 

Fractured Aquifer 
See Double-Porosity Fractured Aquifer 

Hydraulic Conductivity 
The volume of water moving through a unit area of aquifer perpendicular to the 
direction of flow in unit time under a unit hydraulic gradient. 

Leaky Aquifer 
An aquifer with upper and lower boundaries of one aquitard and one aquiclude or 
two aquitards. 

., Location of Test 
A user-supplied character string (up to 30 characters) storing the location of the 
aquifer test. Used for reports and plots. 

Measurement Weight 
Use weights to assign the relative weight of each measurement for use during 
automatic curve matching. In typical cases, assign weights of 1.0 or 0.0 to include 
or exclude measurements during automatic curvc matching. 

Observation Well Name 
A user-supplied character string (up to 30 characters) storing the name of the 
observation well used in the aquifer test. Used for reports and piots. 
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Permeability 
See Hydraulic Conductivity. 

Piezometer 
An open-ended pipe installed i n  an aquifer to measure hydraulic head at a specific 
depth. 

Porosity 
The ratio of void volume_to total volume in an unconsolidated material. 

Project Number 
A user-supplied character string (up to 30 characters) storing the company's 
number or ID of the aquifer test project. Used for reports and plots. 

Residual 
The difference between simulated and observed displacement. 

Residual Displacement 
Water-level displacement measured from static condition in an observation well 
after pumping has stopped during the recovery phase of a pumping test. 

Saturated Thickness 
Vertical distance measured from the top of an aquifer (confining layer or water 
table) to the base of the aquifer. 

Semlconfined Aquifer 
See. Leaky Aquifer. 

Specific Storage 
The volume of water teleased from storage by a unit volume of confined aquifer per 
unit decline in hydraulic head. 

Specific Yield 
The volume of water released from storage per unit surface area of an unconfined 
aquifer per unit decline of the water table. 

Storage Coefficient 
See Storalivity. 
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Velocity Plots and Capture Zones of Pumping 
Centers for Ground-Water Investigationsa 

by Joseph F. ~ e e l y ~  and Chin Fu TssngC 

< 

ABSTRACT 
Nonpurnping monitoring we& are commonly 

instPllcd and smpled to dclincm thc cxtcnt of a con- 
taminant plume md its chemical character. Samples from 
municipal and private pumping wells arc frequently . 

collected during groundwater contamination ~vestigitrions 
as well. Pumping wells are also employed for rtmcdial 
actions. 

To propafy interprrt sampling data from monitoring 
and pumping wells q d  to cstinute their potential effectjve- 
ness io remedial actions, it is important to clearly defme 
the geometry of that portion ofthe aquifer contributing * water to the v d l  (the captucc zone). Velocity distribution 
ploa by manual and computerized methods are illustrated 
and shown t o  be simple and of reasonable accuracy. 

? I 
INTRODUCTION 

Oftentimes in the course of groundwater 
investigations, water-supply wells are sampled to 

' obtain first-order approximations of the quality of 
. water being delivered to consumers. The most 

! t . common response to showings of unacceptable 
1 i - lcvels of contambants is the installation of low- l y  : 

.:' Cost, smalldiameter nonpumping monitoring wells 
, ,for the express purpose of estimation of the 

n Agency, it has noc been subject to Agency 
and therefore does not necessarily reflect the views 

e Agency; no official endorsement should be inferred. 
:> b ~ r o u n d  Water R c x a ~ c h  Branch, R. S. Ken Environ- 

Rcccived June 1983, accepted July 198 3. 
!widcussion open until May 1,1984. 

magnitude and extent of the problem. The differ 
ences in construction, operation, and sampling of 
supply (pumping) wells as opposed to monitoring 
(nonpumpbg) wells may result in combined data 
sets which are coi~fusing to the investigator. The 
primary exception, of course, is the case where the 
contaminant of concern has spread ubiquitously 
throughout the aquifer-a rare occurrence indeed. 

Since very limited areal and vertical extent of 
contaminant plumes is the norm, combining data 
from wclls of different construction and operation 
to produce contours of contaminant concentra- 
tions for source location or remedid action could 
potentially result in poor decisions, wasted funds, 
and so on. Unfortunately, such a predicament is a l l  
too often encountered. Several recent articles 
address these points in greater detail (Gibb and 
others, 1981; Keely, 1982; Keely and Wolf, 1983; 
Keith and others, 1983 ; Nacht, 1983 ; Schuller and 
others, 1981; and Schmidt, 1977 and 1982). In the 
present paper, it shall be assumed that data have - 
been appropriately corrected to account for the 
different sources of data variability. Based on this, 
several easily mastered methods for rapid estima- 
tion of the impact of pumping centers on nearby 
contaminant plumes are described and illustrated 
by examples. 

MANUAL PLOTS OF VELOCITY 
DISTRIBUTIONS 

The velocity of flow through an aquifer can 
be simplistically represented by rearranging and 
slightly modifying Darcy 's law, which is: 

Q = KIA, 

where 

Q is the volumetric flow rate in gallons per 
day (cubic merers/day), - 



K is the hydraulic conductivity in gallons per 
day per square foot (metersdday), 

1 is the hydraulic gradient (dimensionless), 

A is the cross-sectional area through which 
flow occurs in square feet (square meters). 

By rearrangement alone, "Darcy velocity" (VD-) 
expressions are obtained: 

But, since the flow actually occurs only through 
the pores, rather than through the entire cross- 
sectional area (A), a slight modification is needed. 
Division of the Darcy v Jocity by the effective 
porosity (&) yields the true pore velocity (v). 

Generally one finds the left-hand term of the 
preceding relationship to be most useful for corn- - 
puting the velocity towards a pumping well because 
Q is usually known for the well, and A is readily 
estimated. Assuming uniformly radial flow towards 
the well is possible, the cross-sectional area (A) 
through which flow must pass to reach the well is 
equal to the area of rhe curved face of an imaginary 
cylinder of radius r. That radius is chosen by the - 

investieator as the distance from the well where the 
velocity effect is of interest to him or her, and is 
entxelv arbitraw. The area of the curved face of 
the imaginary cyhnder at that radial distance is 
given by A = tnrh where h is the height of the - 
imaginary cylinder (the effective saGrated thickness 
of the aquifer zone yielding watei to the well). 

* 

Naturally this implies that there is a distribution of 
velocities surrounding the pumping well, which 
increases in magnitude as one gets closer and closer 
to the well. By substitution of A = 2nrh into the 
velocity equation Q + A& = v, one arrives at the 
operative formula needed: 

Q 2nrh4~ = Vpumping f 
The right-hand term of the pore velocity form 

of Darcy's law is generally employed for estimation 
of the natural flow velocity, KI + & = vnam&. This 
is because the average hydraulic conductivity (K) 
and hydraulic gradient (I) are usually known or 
fairly well estimated fbr an aquifer, whereas the 
average bulk flow (Q) and cross-sectional area (A) 
of the aquifer are not usually known or estimated 
accurately. One must estimate the effective 
porosiry (4e) regardless of the approach adopted. 

These simple formulae for vplrnp!% and 
v n a d  are quite often all that can be justifiably 
employed because detailed information on $ 
variations in hydraulic conductivity, flow, 4 
hydraulic gradient, and so forth are unavailable to .3  

i the investigator-at least in the initial stages ,of a I 

con taminan t investigation. 
Manual plots of the velocity distribution 

; 
surrounding a pumping well, in the presence of a 
real natural flow rate and direction, can be readily j 
constructed with the equations just described. The 
data in Table 1 result from such an approach; also . 

incorporated in Table 1 is a column tisting the. 
theoretical drawdown, calculated by use of a.hand- . 

held programmable calculator version-4 the Theis i 
equation (Warner and,Yow,' 1979). The important ., 

features of the data in Table 1 arc that y,elo~ities i 
from natural flow and pumpage are added together , 

-to vield net velocities at  distances uomadient of - , 
the well, whereas their differences m&t be 

ea to yim net vaoaties downgradlent of ., 
the well. This is quite sensible since the natural 
f l o w e m  is moving waters toward the well on 
the upgradient side of the well, but is trying to  
move waters away from the well on its down- 
gradient side. Figure 1 is a gtaphical presentation 
of the data in Table 1, to facilitate conceptual 
appreciation of this discussion. 

As can be seen in Figure 1 and Table I, at 
some distance downgradient the pull of waters 
back toward the well by pumping is exactly 
countered by the flow away from the well due to 
the natural flow velocity. Todd (1980) refers to 
this as the "stagnation point"; the American 
Petroleum Institute (1972) refers to it as a 
"velocity divide." Note that the stagnation point/ 
velocity divide occurs well within the cdne of 
depression caused by pumping. Thii may seem 
counterintuitive initially, but calculation of net 
water surface elevations (by subtraction of draw- 
down values from prepumping elevations) will 
confirm that the situation depicted is quite real. 
This relationship is such that the greater the pump- 
ing stress, the farther downgradicnt the velociry 
divide occurs (for a given natural flow velocity). 
Conversely, the greater the natural flow velociv, 
the closer the divide comes to the pumping weU 
(for a given pumping stress). 

It is much more efficient to solve directly for 
the distance to the stagnation point than it is to 
construct plots like Figure 1. One abides by h e  
definition of the stagnation point and sets the 
expression for vpumping equal to the value of 



Table 1. Drawdowns and Velocities Toward 8 Well ConshWy Discharging 
600 Gallons Per Minute (1 14 ms/hr) for 1000 Minuter 

Theoretical Velo& due Net velocity Net velocitv w 

radius drawdown to pumping up6adim; db~mgradient 
(ft) @I (tt/doyl (ft/dcry) (&day) 

2 5 1.19 20.44 23.33 17.55 

Notes: T is transmissivity (= 5 X 10~gdlons/d~y/ft), S is the storage coefficient (= 0.005), h is the saturated aquifer thickness 
(= 100 ft), is the effective porosity (= O.30), and 1 is the natural gradient (= 0.0013. or 13 fd10.000 f t ;  a watdtvcl  
elevation change of roughly 7 ft/rnilc). Positive velocity values indicate flow toward the we& Negative velociua indicate flow 
away from thewell. Also note: rn = ft X 0.31, rn3 = gallons X 0.21, and km = miles X 1.62. 

'. and then one rearranges this to solve direct* for r: 
- *  : 8: .  

.??- 1' :?, .. r = Q 2xh&vnWrpt.$, 

"' Using the data from Table 1 (for the graphical 
 comparison, see Figure I), 

i$dd (1980) notes that the rnucimum 

. w a  , 
!$es the stagnation distance [n X 176.5 ft = 
154 ft (169.m) for the preceding example] to - I 

of the well. Only for the extremely tare case of 
zero natural flow velocity are-the areal boundaries 
of the capture zone and the cone of depression 
everywhere identical. 

, this occurs despite the fact that signifi 
owns are felt there E0.5 ft (1 5 cm) in 
11. These boundaries define the areal limits 
at will be referred to as the "capture zone" 

Fig. 1. Owdown a d  velocity distribution plot for data 
presin#d in Table 1. 
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loo0 500 0 500 looo1t. 

Fig. 2. Two wells accelerating e plume without capturing it. 

T h e  importance of performing these calcula- 
tions can hardly be overemphasized for ground- 
water contamination investigations. Using such 
d ~ l a + m s  i t  is no great .task to show that. a l i e  
o f d d e s i g n = d  to $tap the ad+%& of a . 

co&h 'han t  plume due to a fairly Luge natural 
flow velocity may fail miserably,.despite the fact 
thh th@ adjacsflt cones of deptwsion overlap (an 
almost'saaed buichmark for field practitioners). 
Figure 2 illustrates such a situation, using selected 
data frorn'Table 1. 

1t.k also important to note that this is nor an 
earth-tihattiring discovery. Virtually all contami- 
nant transport codes are based on the calculation 
of a velocity field, so that use of such codes need 
not beviewed with suspicion from that standpoint. 
liowevcr, it is the authors' contention that because 
the vast majority of groundwater contamination 
investigations arc initiated, performed, and. 
concluded without the use of numerical transport 
models and qualitative decision benchmarks such 
'is "overlapping cones of depression" are heavily 
employed, it is imperative that velocity plots now 
be emphasized. 

RADIAL FLOW TIME-SERIES MODEL (RT) 
Major impediments to the widespread use of 

sophisticated contaminant transport models 
indude their general reliance on advanced mathe- 
matics, the need for large computing systems and 
programming skills, and the tedious selection and 
construction of appropriate grids. In order to 
circumvent the most undesirable of thee  charac- 
teristics, two nondispersivc transport codes are 
present=d here whi& rely on th;sirnple velocity I expmion discussed in the preceding action. The " ) ~ a m p l e s  employed here to illustrate these codes 

t were produced with very short FORTRAN 

programs, which are currently available from the 
authors. The full propun descriptions, expanded 1 
theory, and users guides will be released shortly as 
part of a report by Lawrence Berkeley ~aborat6t-y ! 
(Javandel and others, 19831). Also of great interest. 
to field personnel may be the planned subsequent ? 
release of handheld programmable calculator and , 
microcomputer versions of these same codes , 
(Javandd and others, 1983b). 2 

The radial flow time-series model, RT, is 
particularly useful for enirn~~tion of impacts to a 

' 

pumping well from nearby contaminant sources. 5 
Since this code ignores regional flow, it is not as 

, :, 
detailed as might be required for many complete j 
analyses, but its simplicity and brevity makes it 
attractive for rapid esti,ma&m purpoies (RESSQ, . 4 
the other code to be described beliiw, incorporates 
regional flow). One may use RT. with confidence 
for such situations as the combination of a .large . ,, 

pumprng well and. a law rwional .(natural) flow 
elocity. Caution must be exercised when using RT 

for '--Q fie problems where low pumping stresses are 
combined with fairly rapid natural flows because 
substantial errors may &sult. RT is capable af 
providing several useful plots: (1) time-concentra- 
don data, (2) radial distance-conenaation data, 
(3) specified point (x, y)-concentration data, and 
(4) selected concentration contours. 

The primary situation examined here by RT is 
one where a pumping well is surrounded by several 
observation wells, some of which are being im- 
pacted by a spreading contaminant plume. Of great 
interest are the changes in levels qf contaminants at 
the observation wells and the pumping well as 
pumping~progrksses; these concentration-time 
patterns will yield substantial clues as to the Spadd 
distribution of the contaminants. This technique of 
correlating timc-series data to spatial distributions 
has been developed from the techniques described 
by Keely (1982). 

Because of the radial flow situation addressed 
by RT, it is useful to slightly modify the expres- 
sion for vpumping given earlier. In radial coordi- 
nates, it is: 

where v, and vg are the radial and angular com- 
ponents of velocity in the radial coordinate system 
(r, B ) ,  analogous to the x and y velocity cam- 
poncnts of the Cartesian system (%, y). Substitu- 
tion of the expression for vpumping then gives: 



For a pumping well at the origin (0 ,O) of the plot 
to be constructed, vg = 0 by symmetry, so 

vp-p'np 
= v,. Hence, the expression for v, at some 

radia dlstance (r) from the pumping well in 
radial coordinates is the same as VVpWping C&U- 

lated previously by considering the distance to the 
edge of an imaginary cylinder around the well; 

Recognizing that the velocity on some radial 
(v,) is the result of the change in distance k ing  
divided'by the change in time (dr/dt), a substitu- 
tion can be made 

dr Q vr =-=:- 
. d t  Znrh& 

which will lead dir&ly to the equations most 
useful for estimating the position of the contami- 
nant front. Solution of the differentia! expression 
drldt = Q + 2arh& requires only the most straight- 
forward rules of integration: (1) that constants in 
the equation are unaffected, (2) that open integrals 
imply simple subtraction of the maximum and 
minimum values (inthis case, the time of interest 
minus some arbitrary starting time of pumping, or 
't - &), and (3) that a v a r a  (here, r a d E t l h ~ c e )  
is raised to the next power and diided by a value 
equal to that power (cg., r becomes rz+ 2). Hence, 
integration of the radial velocity expression gives: 

This can be readily rearranged to solve for the 
distance traveled during a specific time (= t  to), 

i 
J '-' Likewise, it can be rearranged to solve for the- time 

. required to travel a specific distance (= r - xO), 

' 1 
1 

I 
For example, if an observation well is located 

.I 
a distance r, from the pumping well, then a time 

series data from a given well can be mapped out 
into the aquifer to produce a "snapshot" of the 
spatial contaminant concentration distribution, 
along the radius between the observation well and 
the production well at various times. By using 
observation wells in several directions from the 
pumping well, an areal picture of the contaminant 
concentration in the aquifer at various times can be 
determined. 

To illustrate this situation, RT was used to 
create the sequence of plots shown in Figure 3, 
which run from prepurnping to a little more than 
one day's pumping. Each of the scatter points is 
brought closer to the origin (0,O) by the pumping 
well located there. Alternatively, RT can be used 
to generate contours of relative concentration, 
such as shown in Figure 4. 

Perhaps the most powerful outputs generated 
by RT, however, are the individual relative concen- 
tration-time plots for any of the six monitoring/ 
observation wells or the pumping well (Figure 5). 
It should come as no surprise that these patterns of 
contaminant arrival look like the breakthrough 
curves generated during tracer experiments; the 
fundamental laws and the field design are the same. 
The noticeable difference is that the low level 
leading edge is absent from the early time portions 
of the plots because dispersive effects are not 
accounted for by RT. 

An invaluable variation on this presentation 
of relative concentration-time plots is also output 
by RT (Figure 6). Relative concentrations are 
plotted versus distance for a select number of times 
of interest, generating a family of curves. Thus one 
can examine the relative concentration along a 
selected radial and readily observe the manner jn 
which this relationship changes with time. In the 
example shown in ~ igure  6, it can be seen that the 
farther from the pumping well, the less the 
disturbance of the contaminant plume. As one gets 
closer to the pumping well, the greater the distur- 
bance, so that the overall relative concentrations 
arc lowered rapidly and the length of the plume 
expands considerably. This kind of graphical 
presentation undersc~res the need to plot velocity 
distributions to cstirnatc the impact of pumping 
centers on plume movement. Plume travel times 
based wlcly on a single average velocity will be 
much greater than they ought to be, giving 
planners a false sense of security or lack of 
urgency. 

Because of rctardati~n/attcnuation or 
degradation o f  some mptpminants by physic& 
chemical, or biological myeractions, the velociry at 
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Fig. 3, Scatter maps produced by radial draw-time series 
model. 
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Fig. 4. Contour maps produced by radial draw-time series 
model. 
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Fig. 6. Relative mn&ntratfons along selected radials 
without attenuation (R = 1.0). 



* Ohrs Well 1 
+ 14 hrs R=  l2,04 m 
0 28 hrs 8 = 185" 

which a contaminant species is transported through: 
the subsurface may bc substantially less than the I average pore-water velocity. Since the magnitude j 
of these effects can rarely be asiessed in detail, use :; 
of an empirical weighting factor is often justified. . 

A simplified retardation factor (R) can be 
incorporated into velocity calculations of the water 
front movement (v,) to give the: velocity of the 
contaminant (v,): 

where one notes that R is equal to the ratio of the 
average porewater vdocity to the contaminant 
velocity (R = v,/v,). Use of a large retardation 
factor (R S 1) them implies considerable attenua- 
tion of the contaminant relative to the water front. 
Figure 7 is a replotting of the example in Figure 6, 
but with R = 1.5. 

I I '  
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0 + -  
a + '  - 
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O + '  
o + .  - 

0 5 10 15 20 25 
Radial distance (rn ) 

Fig. 7. Relative concentrations along selected radials with 
attenuation (R = 1.6). 

RESSO MODEL 
While the brevity and simplicity of RT make 

it a useful tool for rapid assessment of simplified 
situations, it  does lack the ability to deal .with the 
effect on contaminant latch at pumping and 
observation wdls which is due to the regional/ 
natural flow velocity. As was shown in the earlier 
section of this paper which described manual 
plotting techniques for velocity distributions, the 
effect of a moderate natural flow velocity can be 
quite important. 

RESSQ is an expanded version of RT, capable 
of incorporating the natural flow velocity and also 
capabie of simulating more complex situations 
where several pumping wells and contaminant 
sources need to be evaluated sirnultaneous1y. As 
such, it has been constructed so. that all inputs and 
outputs are gcarcd to a Cartesian (x, y) coardinate 
system (see Figure 8). The expression for velocity 
due to a pumping well was given previously as 

where r was the distance from the origin ( 0 , O )  to . 

the edge of an imaginary cylinder surrounding. the 
well (radial fliw assumption). It is useful to create 
a more generalized expression in term of actual 
x- and y-coordinates. The easiest approach is to 
use the origin (0,O) as a reference point and employ 
the Pythagorean theorem of geometry 'for right 
triangles, 

Here, the right triangle has its short sides-parallel to 
the x- and y-axes, and its hypotenuse (of length r) 



defining the line connecting the origin (0,O) to the 
point of interest (.x, y). For a pumping well located 
at (xo, yo), the pumping velocity at h e  point of 
interest (x, y) has x- and y-components given by: . 

and 

The x and y components of the natural flow 
velocity vo, which has a direction at an angle or from 
the x-axis, are: vx = v. cos a, and vy = v0 sin a. If 
one considers a waste-water injection well (with 
Q = 50 m3/hr or 220 gpm) locatdat  poinr A in 
Figure 9 which is suspeaed of potentially contam- 
inating a warermpply well (also with Q = 50 m3/hr , 
or 220 gpm) located 848.5 m '(2784 ft) away at 
point B, the prime questions to  be answered arc: 

1. What do the flow patterns of the system 
look like? 

2. Where will the injected wastewater front 
be after certain time periods (e.g., 0.5,2, and 4 
years)? 

3.. How long does it rake for the injected 
waste water to  reach th; water-supply well? 

4. How does the contaminant concen.uation 
vary at the watersupply well? 

Based on local geology, it has been estimated that 
the effective porosity (&I of the aquifer is 25 
percent. 

'. As a first cut, analogaus to  the simple 

SOURCE/6INK 

Y FLOW VELOCITY 

'w-1 
i 

X 
REalONAL FLOW VELOClT Y 

Fig. 8. Cartesian system showing x- and y-componentr of 
Pumping flow veloclty and showing regional flow velocity 
With angle a to x-axis. 

b---848.5 m --I 
(2784tt,) 

Section through we1 Is 
Fig. 9. Plan view and cross section for RESSQ model 
examples '(discussed In text). 

approach in RT, the rtgional/natur~;.flow velocity 
wiU be neglected. Using RESSQ, Tables 2 and 3 are 
generated. Table 2 lists the arrival times at the 
pumping well of the injected waste waters flowing 
along sncarnlines between the two wells, depicted 
graphically by RESSQ in Figure 10. Note that nine 

. . Distance ( r n )  

Flg. 10. StrearnlInes for RESSQ model example without 
regional flow considered. 



1st 
2nd 
3rd 
4th 
5th 
6th 
7th 
8th 
9th 
10th 
1 lth 
12th 
13th 
14th 
15th 
16th 
. 17th 
18th 
19th 
20th 
21st 
22nd 
23rd 
24th 
25rh 
26th 
27th 
28th 
29th 
30th 
3 1st 
32nd 
331d 
34th 
3 5th 
36th 
3 7th 
38th 
39th 
40th 
41st 
42nd 
43rd 
94th 
45th 

Rod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Ptod. one 
Prod. one 
Prod. one 
Prod. one 
+++*none+ 
++++none+ 
**++none+ 
++++none+ 
++++none+ 
*+++none+ 
++++none+ 
++++none+ 
++++none+ 
Prod. one 
Prod- one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
,Prod. one 
Prod. one 
Prod. one 
Ptod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 
Prod. one 

St6 yn 
6.2 yrs 
7.0 yrs 
8.1 yrs 
9.5 yrs 
11.6 yrs 
14.4 yrs 
18.5 yn 
24.6 yrs 
34.3 yts 
50.4 yn 
79.3 yn 
137.0 yn 
200.1 y n  
200.8 y n 
201.3 yrs 
200.8 y n  
201.7 yrs 
201.5 yrs 
201.4 yrs 
200.1 yls 
200.0 y a  
118.3 yrs 
70.3 y n  
45.5 yrs 
31.4 y n  
22.8 yrs 
17.3 yrs 
13.6 yrs 
11.0 yrs 
9.1 y n  
7.8 yrs 
6.8 yrs 
6.0 y n  
5.4 yrs 
5.0 yrs 
4.7 YE--- . .- 
4.5 yrs 
4.4 yrs 
4.3 yn  
4.3 yrs 
4.4 yrs 
4.5 y n  ' 
4.8 yrs 
5.1 y n  

of the-streamlines carrying the contaminants have which agrees with one's intuitive expectations. The - - 
not reached the water-supply well during the 
specified period of study which was arbitrarily 
chosen to be 200 years. The angle ( P )  at which 
each streamline leaves the injection well (relative 
to the x-axis) is also shown in Table 2. Note that 
strtamlines 40 and 4 1 leave the injection well at 
angles of 3 12 and 320 degrees, respectively, and 
are the first to amve at the water-supply well- 

time of arrival of these two streamlihes. is 4.3 years; 
the water-supply well is affected rather quickly in 
terms of a normal operational lifetime for t h e  
injection well (10-20 years). 

Table 3 presents the time variation of concen- 
tration a t  the water-supply well. Note that the 
total number of streamlines emanating from the 
injection well was again set at 45. Each of these 





On Capture Width and Capture Zone Gaps 
in Multiple-Well Systems 

by John B. Erdmanna 

bstract 
A barrier well line's capture width along its alignment is shown to depend only on total system flow rate QT and aquifer back- 

wnd flow rate per unlt wldth Q, (prepurnping gradient times transrnlsslvlty) under Idealized horizontal flow: Irrespectlve of 
mbcr of wells, the capture width is QTQ, as for a hypothetical single well with flow rate Q, This result applies even tobar- 
cr liner with irregular well spacings and flow rates-and, In fact, to the capture width through the center of any pumping con- 
protloo that & ~mmetr ica l  respecting a line perpendicular to uniform background flow. A flow-perpendicular line of regula* 

equal wells ("regular barrier line") hns the same capture width along its alignment as an identical well h e  p&allel to back- 
wrad Ilow has through Its center. In the general symmeMcal case, the e n t e r  capture width remains Q+Q whether transverse 
dl spadngs are large (allowingtontamlnated ground water to -pe through'capture zone gaps), critical (with lndpient 
e), or safely small. For design referee+-,@ ~ @ a $ i ~ ~ . d ~ ; ~ $ . f o - ~ ~ l a r  barrierrunes of N wells Mth N through 100 and 
+a my from QhQ (N '2, pnviausly'known) to QnQ, (N--)ao), where Q each well's flow rate. Inclplent gaps at critical spac- 
g ormr always between the two center wells, or  the center well and two adjacent wells. Spacings substantially smaller than crit- 
d are recommended for contaminant capture. Designs are illustrated that preclude capture zone gaps. 

t t  'uction 
-n a pumping well system is used to capture contaminated 

. .i'vatcr, the system's capture xone-aquifer region ultimately 
uui&ting water to its wells--must span the contaminant plume 
dd~ without gaps. Although.bro;dly applicable techniques now 
&far &hating multiple-weU captwe zones, including theiu e w  
;ioa over time (Strack et al. 1993; B ~ C T  and S m k  1996). the 
sabre o&s rrnmlcably little general guidance on multiplowell 
stem design for contaminant capture. Moreover, some recorn- 
ended dcs'ins are unnecessarily risky in light of the findings pre- 
nad herein. 

The analytical solution for a single well's steady-state capture 
me in uniform flow .has long been Rnown (e.g.2 Jacob 1950. 
p s  344-345: De Wiest 1965, pages 252-255: Kcely and Tang 
83) and is frequently invoked in single-well system design. 
W i n g  to this solution, if the well's flow rate is Q [Lq-I] and 
: uniform flow rate per unit aquifer width (prcpumping hydraulic 
dient times hansmissivity) is Q [L2TT]. then.thc'WeIl'r captu~? 
nc haswidth b-= QIQ, infinitely tar upgradieritv~idth"Eb Q/2Q,? 
bK d l .  'and extent downgradient from the ~ l l  .d = Q h C f ,  
igurt !). With the well at the xy-plane origin and uniform flow 
*positive xdirection. the equation for the compkte capture zone 
udwy is x = y cot (yld), 

~ W d k " a t ~ c l . ~ U  g acaptum: 
w , m a q x ~ ~ g e ~  &is- -*_* 

.gui4 the boundary.' Because of this observational dificulty, 

w 

Wenck Associo.tes Inc., 1800 Pioneer Cmk Center. P.O. Box 249. 
r9k Pun. MY 55,159-0249; (612) 4794203, fax (611) 479-4242. 
Qlll\n@wenclicom 

tbccivad June 1999, accepted k m k r  1999. 

Figure 1. Capturt urnc boundary (solidh and curves on nhich wx 
r 0 (dotted) and = 0 (dashed), for HPU at o w n  witla uniform f lp  
in posltlvc x-direction 

capture zone calculations based on ground wntcr flow models are 
essential. To illustiate the difficulty, the v&ll-in-uniform-flow ma- 
lytical solution .is posed here in terms of the dischap potential @ 
defined by Strack (1989, page 49) as follows: 

= { rk;; :a;: kH2. if confined (la1 

1 
, if unconfined (Ibb 

where It [L T-'1 is hydraulic conductivity. H is con fined-nquifer 
thickness. and I$ [Ljis hydnulic head referenced to the aquifer base. 
men with the d i s c h e  vector (Q,. Q,.) [L? T-I] defined as the prod- 
uct of the saturated thickness and the specific discharge vector, and 
treating k and (as applicable) H as constants. it follows that Q, = 
-@/ax and Q, = - W a y  whether the flow is  confined or uncon- 
fined. If the discharge vector's radi  and tangential components art 



Q'and Qw the relations Q, = - a@/& and Qg = - &l(r aQ), where 
rand 8 are the usual polnr cwdinates. are dso valid. Arbiaary addi- 
tive constants in the definition of @ me chosen to guarantee con- 
';nuity even at tmsitions between confined ($2H) and unconfined 

< H) flow. For o, well in uniform flow as in Figure 1, 0 is 
%rack 198% page 228) 

: /  

or in polar coordinates 

where a, is the value of Q, at sidegradient points (0, rJ and 
(0, -fa). Equation 2a implies Q, = Qo - xQ/[~R(x~  + yl)] = 
Q,, [I - xd4x2 + y2)] whe* d = Q/Zrr& as before. The locus of points 
where Q, = 0, and hence also a@/ax = 0, is the circle (x - dn)l+ 
r 3 = (dB)' excluding the well location (Figure 1 ). Also. i&&& is  pos- 

t .  

I itive (Q, c 0) inside the circk and negative outs*& it. Along any line 
.sggment parallel to the x-axis and outside-the circle, such as. . 

1-1' in figure I, from insidc to outside the cap- zone, 4 strictly 
decreases. But at the same time. Equation 2b implies Q, = & cos 0 

1 - QDnr = & (X -d )It, hence Q vanishes (and so also &$& = 0) on 
the line x r d; and a$/& is positive uppdient and negative down- 

1 gradient from the line. Along any line segment on a radius ftom the 
; well and upgradient from the line x = 6 such as 2-2' in Figure I, h m  
' e i &  to outside the capture mne. ( slrictly inaclres. Therefa+ 

,rratcr levels from monitoring wells along 1- 1 ' and 2-2' cannot dis- 

t W s h  the capture zone boundary and even c h i i t  opposite trends 
4 fmrn inside to outside the capture zone. 

In the antecedent literature, generalizations concerning multi- 
: ple-well capun zones focus on lines of regularly spaced, equal wells 
! aljgncd pupendicular to background flow ("regular barrier lines"). 

Kocly (1 984) obsuves that a regular bartier line of N wells with flow 
, rate Q per well has ultimate capture width b = NQQ, as far a hypo- 
! thetical single well with flow rate NQ. the system's total flow rate. 

Generally in multiple-well systems, if urnsvene well spacings 
arc too large. the syst&n's capture zone has gaps between wells - 

! through which contaminated ground water may escape. Whenever 
1 the capture zone has no gaps but any small increase in transverse 

spacing would cause pps. the spacing i s  termed "critical." In ana- 

1 lyzing critical spacings for ngular banier lines with N = 2.3, and 
I 4. Javandel and Tsang ( I  986) conclude that the capture width c along 
b 

the well alignment also is the same as for a single well with the sys- 

I 
tern's total flow me, c = NQDQ,,. when the spacing is critical. Thtse 
authors recommend the critical spacing as "optimum" for regular 
M e r  lines-a recommendation, however. that is shown herein to 
be ill-founded. 

'I;he-assumptions forming the basis for the prrxnt analysis, the 1 analyses of Kecly ( 1984) and of Javandel and Tsang b (1 986). and 
the singlewell solution noted previously  re the following: ( I )  flow 

horizontal and steady: (1) the aquifer is homogeneous, isotropic, I w d  infinite in horizontal extent; and (3) uniform background 
I tw represents far-field recharge, local recharge being neglected. 
rhe horizontal flow idealization rests on the Dupuit-Forchheimer 
assumption: resistance to flow in the venical direction is regarded I as negligible tStrack 1989. page 36). Tnnrverse dispersion is 

neglected insofar as contaminant capture is identified with hydraulic 
cap- Although models based on less resbictive assumptions arc 
available, simple analytical models arc often useful as a means of 
preliminary analysis or as an approximate check on other models. 
In discussing the use of hydmgmlogic models in performance 
assessment, Konikow and Ewing (1999) nmark that "[c]omplcx 
[performance assessment] models should be complemented by 
more transparent simplified analyses." In situations where bound- 
ary conditions art uncomplicated, simple analytical models also 
remain widely useful for remedial design. 

?he prrsent analysis demonstrata that the capture width result 
of Javandel and Tsang (1986) actually generalizes to all gradient- 
wise-symmetric systems-i.e.. systems in which well locations 
and flow rates arc symmetrical respecting a line perpendicular to 
background flow. Gradientwise-symmetric systems consist of 
"symmetric elements," each element being either a well on the sym- 
metry line, or a pair of qua1 wells located symmetrically up- and 
downgradient from the line. Barrier lines (La, lines of wells per- 
pendicular to k k p u n d  flow) are composed strictly of the fmt 
kind of element. ?hc well alignment itself is tbe flow-perpendicu- 
lar symmetry line. Any barrier line, evenwith imgular well spac- 
ings and flow mes, is gradicntwisc-syrhmetric Some examples of 
othu.@ientwisc~~rnmeaic systemkke lines of iegritatly spacad; 
cqoal wells that arc parallel to the background flow, and equal 
wells placed at the vertices of regular polygw. appropriately ori- 
ented. The generalized capture width c for a gradiennKisasymmebic 
well system is measured on the symmetq line and termed the 
"ccntcr" captun width. 

'Ihe center c a m  width result derived hmin has counter-intu- 
itive implications, as discussed subsequently. Apractical applica- 
tion. determining whether certain systems have capturc zone gaps. 
is demonstrated. Trarisverse well spacings substantially smaller 
than nitical are recommended in systems used facontaminant cap- 
tun. For design reference, ciitical spacings are derived for regular 
barrier lines with N through 100 and N+m. The critical spacings 
repMtbd here for N = 3 and 4 diffcr slightly (though not significantly 
for practical puqmcs) fnMl those of Javandel and 'l3ang (1986). For 
existing well lines that have capture m e  gaps. flow rate modifi- 
cations that p l u d e  gaps art discussed. 

Capturn-Width in Multiple-Well Systems 
Derivation of Capture Wldth 

Figme 2 illrrstntes capwre width analyses for two multiple-well 
systems in unifonn flow of magnitude Qo in the positive xdircc- 
tion. 'Zlre arbifmily configured system in Figure 2a consists of two 
wells with flow rates QI and Q1. The gradientwise-symmetric sys- 
tem in Figure 2b consists of two symmetric elements, a well on the 
y-axis (gradientwise symmeuy line) with flow rate Ql. and RHO c q d  
wells symmetrically straddling the y-axis with combined flow mtc 
Q,. Pairs of dividing struunlines delineate capture zone boundaries. 
Stagnation points on a boundary (for example. the points labeled S, 
and S2 in Figure 1) art locations of zero discharge where dividing 
sveamlines meet and diverge, with one divergent stmarnlinc run- 
ning to the well (said to be "associated" with the stagnation point) 
inside the capmre zone and one running outside. When one well's 
capum zone is nested inside another's, as in Figure 2, the dividing 
streamline that diverges outside the nested well's capture zone 
runs to the nesting well. 

Before deriving the center capture width for gradientwise- 
symmetric systems, the ultimate c n p t k  width b for arbitmry sys- 



tuns will be d y z e d  by way of introduction In F w  2% since 
inflow to closed figure ASP occurs only across AD. representing 
the system's capture widthat arbitrary xcoordinatc. the line inte- 
gralofQ,w.ADq~~,thes~'sWflowrarc.InIhelirnit . 
as x-, -00. the system's influence on the flow ficld vanishes, thus 
C& +Q, and the flaw balance Q, b = t& results. Suailarly, the ulti- 
mate capcum width b, for the well with flow rate Q, ax., length of 
BC as x+ -) satisfies & b, = Q,, and, despite thc capture zone 
nesting, the second well's ultimate capture width b2 satisfies & b, 
= Q+ Therefore. an arbitmy well system's ultimate capture width 
cq& that d a  hypothetical qingle well with the systcm*~ total flow 
rate,b=Q,I&; andtheultimatecapme ~idthb~hanyindividual 
wtllwith flowratc &is hesameas thoughthat wellopwatedalone, 
bn = QA. 

Now for gradientwise-symmetric systems, the center capture 
width result follows from this observation: At eveq point on the 
s y m m a y  l i e  except well locations, the discharge vector compo- 

I Q,,. Tn Fi& 2b. for example, the well on h e  y-axis has no 
1 )a on anywhere else on the y-axis since it induces pmly  

ralial flow. and the symmetric well pair's contributions to Q, 1 e v w h c n  on the y-axis cancel one another (see point E);m- 
. fom, way point on the y-axis but the well location has Q, = &. Ln 

F i  2b, the rine segmentu BC measures the single well's cen- 
I 

Figure 3. Caplute zones for gradientwlscsyrnmetrie systems of t h A  
equal wdlr wlth (a) QT = 200 ms d'' md (b) through ( f )  QT r 400 
m3 d4. Aquifer bas Q, t 2 mz 6-' with flow left to rlght.Axer marked 
on 10 m intervals. (Capturn zones traced by.SLA!%I, b a d  bn stag- 
nation points computed externally.) 

ter capture width cl. (Actually, BC circumvents thc well via a 
small sainicircle which may be regarded as iflraitcsimal.) Inflow 
across BC to closed figure BSIC equals Qc1, and outflow (through 
the small semicircle) equals Q1/2, so the flow balance implies 
&c, = Q&2. For the symmetric weU pair's centa capture width c,. 
inflow across AB and CD ta closed figure AS2DCS,B equals Q,,% 
and balances the flow rate of the enclosed wetl, hence &c, = Qa. 
All elements of a gradientwise-symmetric system can be tredtcd in 
one or the other of these ways, so the system's ovecall center cap- 
ture width c and total flow rate QT also satisfy Q,,c = Q$. 

Therefore, a gradientwise-symmetric well system's center 
capnut width c is the same as for a hypothetical single well with 
flow rate Qr , c = Q,J2Q,: and the center capture width c, for any 
symmetric element with flow rate &, is the same as for a well with 
flow rate &, o p a h g  albne, i, = WQ,. This d t  applies even 
if the system's cspuue tone has gaps. When g ~ p s  occur, if wells 
inside om disjoint cap- zone pact haw flow rate subtotal q'. hen 
that part's center capuln width c' is also c' = Qf'n&- 

.". 
-Some Cuunter-Intuitive implications 

To g~ound watcrrrmediation @tione& it seems an annoy- 
ingly pcrvrrse q u a  of natm that a ~11's capam width is @y balf 
at the well h a t  it is infinitgy far upgradient. And contrary to 
intuition, distributing the flow among rnultipk wells yields no 
relief from this harsh limitation For example. Ftgures 3a and 3b 
show two regular barrier lines with N = 3 and 4 = 200 and 400 
m3 d-1, respectively, in an aquifer wherein Q,, = 2 m2 d" (e.g., an 
aquifer with k = 50 rn d-1. prepurnping sanuatcd thickness 8 m 
--hence transmissivity 400 m2 &'-and prrpumping hydraulic 
gradient 0.005). 'Ihc smaller flow rate equals the background flow 
through a width of 100 m However, thc well line with that flow rate 
actually captures only 50 m along its alignment; to capture 100 m 
Q, must be double the background flow through that wid*. as in 
Figure 3b. No matter how finely divided the flow and closely 
spaced the wells. thc capture width along a barrier tine remains 
Q4&- 

Throughout Fwm 3 through 5, dividing -ncs traced 
with tb SLAEM model ( S W ~  1989, pgt~ 31 1-316) d e w  Cap 

nrrc zones. External to SLAEh4, stagnation pintmbrdinat6 were 
found dgcbraically Figures 3 and 4) or &rough k r i c a l  search 



Flpre  1. Capture zones for well systmrs that are both gradientwise- 
and lalerall,v qrnmetric, ~4th Q = 400 mJ d-' and Individual flow rates 
(3 dJ) as Indicated. Other aata as in Figure 3. (Qpturc woes 
trrccd by SLAEM, based on stagnatlon polnts computM externally.) 

(Figure 5). Nearby points on the convergent dividing stmamlines 
w a t  located by matching swam function values, and SLAEM was 

I d m  used to tmc the convqent strramlincs backward, starting from ! hoc points. The s tagdon  points ud capmre zones -Id also be 
'determined using the public domain model CZAEM (Bakkcr and 

I Strack 1996: Strack ct al. 1994). Throughout Figures 3 through 5. 

; br aquifer has the same background flow, and (except in figure 3.) 
d~ well systems have the same total flow rate (400 d 6') and a n -  
t a  capture ddth  (1 00 m). 

! 
I In ad&tion to being '&pendent of the number of wells, a pa- 

Iientwisc-symmetric syslem's center capture width is indepen- 
w t  of the particular well configuration, so long as gradientwise 

j;-try is maintained Fa example, a rcplar barrier line has the 
1 center cqture width as it would have if rotated parallel to the 

backgmund flow-or, for that matter, if rearranged in the form of 
1 a egular polygon with appmpriau orientation (F~pres 3b through 

1 36). Most important, neglecting possible flow rate limitation by 
mutual well interference, a padicntwise-symmetric system's cen- 
ter capture width is independent of the distance between wells. If ' lnovenc well spacings am too large, hc syslcds capture zone has I gags, but tk ygregate center c a p t u ~  width  mains undtasd: mn- 
~ Q s e l y r d y ~ u l g  transverse spacings docs not'- the 

I s$tcm's center capturr: width (Figures 3d through 30. 
1 

Determining the Occurrence of Capture Zone Caps 
The center capture width result enables one to determine 

1 whether capture zone gaps occur in certain well systems. For 
example, in F'igure 3f. with the system3 center capture width 
known to be 100 m, a capture zone gap between the two symrnet- 

1 ric elements (well nnd symmetric well pair) is certain if the distance 
ktwcen their centers is 50 m or more because their capture zones 
m skewed away from one another. (The dischqe vectors induced 

I by the elements partially annul one-another at locations between 
them while reinforcing each other outside them.) The tnnsvene 
spacing in Figure 3f is actually 60 m. so a gap is  wily foreseeable. 

A reasonable prescription for preventing capture zone gaps is 
I a obvious in evrr such is the one just presented, but systems h a t  
k ssess both lateral and gradientwise symmevy arc more rmctablt. 

t i 
:he system in Flgurc 4a is doubly symmetric, consistine of a 
synrneuic well pair up- and downgradient fmm the system's cen- 
ter. with a centcr apture width of 40 ni. and two Iaenlly symnlctric 

Figure 5. Capture zones (upper half-plane only) for five and six-well 
(a) through (0 regular barrier lines m i t h  (a) through (b) 
/Q,, <a thwgh (4 Y4 %Q,"w,Y = 0 3 . d  (el through (0 LC!. 
(g) through (h) barrier ines with L as in (e) through (f) m4 individ- 
ual flaw rates (d d-') as Indlcatcd; dl witb QT = 400 m' dJ and dhcr 
data as in Flyre 3. (Capture m e  traced by SLAEM, based on 
stagnation points computed externally.) 

outer wells with center capwrr.\kldh of 30 m each. Since the outer 
wells* capture zones skew o~tward , '~a~s  arc certain if the outer 
wells arc 15 m or less froni the target width's edge. They arc 
actually only 10 m from the edgc so gaps are once again pre- 
dictable. An obvious modification that would prevent gaps is to 
place the outer wells 20 m from thesystem's center. thereby guar- 
anteeing that the central well pair's captm zone nests those of the 
outer wells (Figure 4b). Alternatively, with the original place- 
ment, this rationale can be applied to flow rates. If the central well 
pair's combined flow rate can be inacased from 160 to 320 rn3 &I, 

~ l ~ g  in a center capture width for than of 80 m, this would 
ensure nesting with the original placement, even while maintain- 
ing the original Qr by Fedpcing the outer-well flow rates (Fig- 
ure 44. Carrying this idea further, spliuing Qr enticely between the 
central wells would leave a two-well system aligned with the 
background flow (Figure 4). For comparison, Figures 4e and Lif 
show exampks of regular barrier lines with two and four wells. 

Capture Zone Gaps in Regular Barrier Lines 
Especially important because of theiu wide usage for contam- 

inant capture, regular barrier lines are both gradiitwisc- and lat- 
era'y symmetric. The occurrence of q m  wne gaps dvough reg- 
ular barrier lines depends on the number of wells N and the "dative 
spacing" LClJQ. where L is the well spacing. Q, the background 
flow per unit width. md Q each well's flow rate. The relative 
spacing equals the rntio of L to the ultimate capture width of one 
well. The "criticnl relative spacing" (LQJQ), for a given N corn- 
sponds to the condition of incipient gaps-i-e.. (LQ /Q), is the 
largest relative spacing that yields no capture zone gaps. For sys- 
tems designed with critical spacing, any undenslimate in a or 
decrease in Q results in one or more capture zone gaps. A regular 
bania line at critical spacing can a1.w have capture zone gaps as n 
result solely of being slightly off-perpendicular to the background 
flow when N is odd. 

Fallacy of 'Optimum' Spacing 
For regular barrier lines used for contaminant cqturc. others 

have recomnlended critical spacings as "optimum" (Javnndcl and 



-mg 19Sb: also sun~marized in Gorclick et ai. 1993. pages 123- increase is more rapid for odd N. which results in a small evensdd 
y. The notion that capture width increes  as well spacing oscillation in the values. The largest even and odd critical spacings 

cs is intuitive but erroneous. It has not been recognized in Table I are 0.49200 for N = 100 and 0.49349 for N 99. 
! *.rSxc. qqwently. that caphue width dong a b h e r  line is i d -  Appendix B presents an algebraic mdysis for N = 4. The result 
el.. !.t of sk ing .  Figures 5-a and Sb illusme critical-spacing cap- 
urt zones for regulw barrier lirles with N = 5 and 6. respectively. 
Fiputr 5 shows portions of the upper half-plane only.) W~th smaIler 
wings  but the =me flow rites (Figurn. 5c and 5d). the well 
optuw zones ar\: safely nested. and them is no decrease in center 
apture width. Designing for critical spacing is risky because of 
t~~~umint ies  in aquifer characteristics and possible fluctuations in 
ystcm flow me. To avoid risking capture zone gaps, well spacing 
hould be substontinlly smaller than critical in regulnr barrier lines 
.scd for contaminant capture. 

:tidal Relative Spadngs 
Although designing for critical spacing is not recommended, 

riticd spacings mwin lmpottant as reference points fsr design. The 
ell-known case N = 2 has the iwllest critical.relntive spacing, 
LQ/Q), = Ihc, which is duivabk algebraically (cg, Jav;mdei and 
iang 1986, Stmk 1989, pages 236-240). Dimensionally, the two- 
tell critical spacing is QIIQ, considerably smaller than each 
dl's center capture width, Q/2Q. Thc outward skew of the WCW 
apmre zones is fhc Fcason such small spacing is required At the 
ther artncmc howeva with intinitely many wells, every well's cap- 
ne nmt is identi4 and laterally symmetric, hence the critical spac- 
v - d y  equals one well's center capture width. Explicit analy- 

a& closel; (within at le4 0.0019) with the value in Table I' and 
reasonably (within about 1%) with the approximation of Javandel 
and Tsmg ( 1986). 

Location of Critical Stagnation Polnts 
In all cases analyzed, critical stagnation points occur betwcn 

the two center wells when N is even. or the center and two djn-. 
cent wells when N is odd At critical spacing, capture zone gaps me 
incipient where contaminant concentrations me usually maxi- 
mum. Table 1 includes the dimensionless critical stagnation 
coordinates. 

Suggested Maximum Relative Spadngs 
When regular barrier lines arr used for coriminant capture. 

well spacings substantially smaller than critical are recommended 
to enskc against capture zone gaps. 

-.- ,- y 

80% of critical in all h: 

Range of N Suggested Maximum LQdQ 

wnfi&&tegu~ar ban*r lLrr I R ~ S  that (LQ,, EQ), H is N = 3 , 4  0.30 
; , :FrdmaM 1995.1997). One on also derive this limiting value N=5, ... 14 0.33 

3 -..'&ring a regular barrier line with variable N, Q, and L, but N = 15, ... - 0.37 ' ~mtllflowNe~=N0.tocal1enmhL=NL.and4'strenmh" 
&=~lhpl.h~&bif~-,&~lti(;&nk(f~,. 
line integral of wells). At every point along a line-sink, the line- 
ink-induccd discharge vector component that is perpendicular to 
u line-sink on either side is equal to M f  the strength. or QRL 
Strack 1989, pwes 283-287). W~th uniform flow in the positive 
4 i o n  a line-sink on the y-axis then has Qx = Q, -+ QRL on 
s upgradient side, and Q = Q - Q/2L on its downgmdient side. 
hrmadkh~ondredo~ ients idewi l lber tvecsedjo long  
sQL>2&. butdraewillbesomeflowthroughehelim-sink~~, 
will "leak") wheneva QIL< 2Q. At quality the condition is crit- 
-rl, (LQJQ), = 

Antecedent literature gives a few critical spacings for N > 2. 
wandel and T q  ( 1986) report (LQdQ), = 2"3/n for N = 3 and 
K approximation (LQJQIc - IZR for N = 4. However, for N = . Mmann ( 1995.1997) provides the complete algebraic solution 
x stagnation points as functions of dative spacing, and on this 
mis derives (L&/Q), = 0.40255 (about 0.4% l ~ e r  than 2%). 
; r d m n  (1995, 1997) also calculates (LC& /Q, numerically for 
I = 4 through 40. A general technique for determining critical spac- 
~gs of regular barrier lines is outlined in Appendix A and detailed 
lsewherc (Erdmm 1997). Determining critical spacings amounts 

ling "critical surgnation points*' on the systemS capture zone 

Figures 3b, 4e, 4f, Sc, and Sd illustrate these suggested m a -  
imum spacings for N = 2,3,4,5, and 6. Uncertainties in hydraulic 
coriductivity and other factors should be carefully considered in 
selecting well spacings. Depending on specific conditions. more 
stringent Limitations than these may often be warmntcd. . 

Modifying How Rates to Eliminate Gaps 
'Gpture zone ?a& in existing regular barrier lines that have 

L.Q& = !4, as in Fqyrcs 5e and Sf, can be eliminated by modib- 
ing flow rates, if aquifer conditions allow. For N = 2. the f l o m t e  
must be doubled to meet the suggested maximum relative spacing 
a doubling of capture width also necessarily results. For all greater 
N, however, a flow rate redistribution suffices that rnaintgh t h ~  

r even N 2.4, doubling the flo-+ 
mte for both center wells, whiie shutting down both end wells. pre- 
vents q t u r e  zone gaps. This redistribution is more.htic than for 
odd N; however, with only a 50% increase at the two center wells 
and a halving at the two end wells, a gap is almost incipient at the I 

Wyy. Situated at junctures between the abutting capture zones center when N = 4. A safe app-h when N is even is to repard the 
I rent wells. critical s t ; t g o n  points mark locations of incip wo  center wells as thou* &y operated alone, and it is on this basis 

I :nt capture row gaps. that doubling their flow tatc is recommended. The even-N flpw m e  
Table 1 lists critical relative spacings for N = 2 through 100, d h b u t i m  forward here also m- that the WD center wells' - 

aid nwnericatly by dre method in Appendix A. Considering even capture zones nest the en& sysccm Rgures 5g and 5h ill us^ h e  

I nd odd N separately, OC increases smoothly with N, but d!e described h e m e s  for N = S.md 6. 



Table 1 
Critical Relative Spadngs and Dimensionless Critical Stagnation Polnt CoMdlnaics for Regular Barrier Lines 



summaw 
Capture zone delineatio?~ are fundamental to designing and 

ing the performake of well systems used to capture con- 
* + p n d  water. Lccalized ground water level obse~ations 
, ):rice cannot usually define a well system's capture zone, 
d& calculations based on grwnd water flow models t t ~ ~  essential, 
stcady-mtc capture zones for multiple-well systems in uniform 
backgmund flow are nnnlyzed here in the context of the horizon- 

flow idealization. 
The center capture width c of a gradientwise-symmetric well 

system with total flow rate QT equals that of a hyhthetical single 
sell with flow rate Qr , thus c = Q, 0% w h e ~  & is b c  back- 
p n d  flout tate per unit aquifer width, Each of the system's sym- 
metric elements (wells on the symmetry line or pain of equal 
wells symmetrically up- and downgradient from the line) has the 

center capture width as a well operating alone at thc element's 
flow rate. All wcll l ine  ppcndiculnr to backgnnud ftow, even with 
&regular spacings and flow ram, arc gradientwise-symmetric, as 
uc m y  orher configurations. Although only wells arc considered 
har, the center capture width rcsult also applies to systems that 
include line-sinks (Erdrnann 1995). 

A gradientwise-symmetric system's center capturt width is 
Indtpendent of h e  number of wells and of their particular placement 
Ubd spacing. The center capture width remains Q,.'2& whether 
transveftc well spacings am large (allowing contaminated ground 
water to iscape through captun? zone gaps), critical (with incipient 
.e), or safely small. Critical spacings arc therefore not "optimum" 
* ~ $ u I a c  b d e r  lines of N wells with flow rate Q per well, the 

spacing varies from Q/nQ, (N = 2, previously known) to 
('N*). At critical spacing, captun? zone gaps are incipient v 

,-.dm the two center wells, or the center well and two adjacent 
wells, where contaminant concenuations arc usually maximum. 
SOadngs substantially ssmalltr than critical arc ncommended in reg- 
alar barrier lines used for contaminant capture. 

The center capture width result enables one to determine the 
occwlence of captuce zone gaps and to design for their prevention 
in a variety of well configurations. 

Appendix Aaetennination of Gdtical Spacing 
for Regular Barrier Lines 

With uniform backpund flow of magnitude & inthe positive 
.xd.irdon, a regular Wu line of N wells with spacing Land flow 

f rate Q per well is digned on the y-axis, centered at the origin. 
ldaaifying each point (x,  y) with the complex number z = x + iy. and 
with the discharge stream function '4' (meaningful if mharge and 

I kalsage to or frok the aquifer can be regarded & negl&ible) being 
the hannonic conjugate of (discharge potentid. Equation 11, the ' cornpIe:r potential Q = O + iY (Strack 1989, pages 278-279) is 

I r e  well lontionr are iv, Ln with v, including the odd integers 
is even) or the even integers (if N is odd) from - (N-1) to 

,-*-I): and C is a real constant determined by specifyin @ at a 
~fercacm  pin^ Defining dimensionless Z = X + iY md d = 6 + 1 i ~ b y z ~ ~ ~ d ~ = h ~ n p i v e s ~ - ~ + ~ ~ l n ~ - i v n )  
+ C. w b c ~  D n QhQ is a *strength pmmetcf inversely ppm- 
Pational to dative well spadhg. and e is a dimensionless real con- 

stant: hence. &=-x + D 2 lnlt - ivd + 6 and + = -Y + D 2: wg 
(Z - ivJ. (All sumrncltions an for n = I. ... N.) Curves on which 
'k is constant are streamlines. The condition Q = 0 holds on the pos- 
itive X-axis and. hence. on the capture zone boundaries of (I) the 
center well when N is odd: (2) the two centcrwells when N is even 
and then i s  no capture zone gap between them: and (3) the entire 
u~ell line when then 3re no capture zone gaps anywhere (whether 
N is even or odd), Critical stagnation points then also have Q= 0. 
On the Y-axis, except for discontinuities nl wells. '!' is a decreas- 
ing function of Y. Thus. at leitit one well on the positive Y-axis hs 
3 < 0 on its capture zonc  bound^ if the system's capture zone hils 
any gaps. Whenever 'k 2 0 nt all upper half-plane stagnation 
points. there are no capture zone gaps. 

The dimensionless discharge function \k = & - i q  = -dd/p~ 
has the form * = 1 - D 2 l/(Z - iv,). hence 4 c I - DX 1\12 
- ivJ2 . and & = - D (Y - v,JIV. - iv J2. For every point in the 
right half-plane. there is a positive D giving 4 = 0. The condition 
Oy= 0 is independent of D md holds (I) on the X-axis, except the 
origin when N is odd: (2) on the centerward side of cnch noncen- 
ter well, on an ovate curve that p;lsses thFough, but excludes. the 
well: and (3) when N is even, on an ovate curve that passes through 
the points XI, and -XI, (see next paragraph) and through, but 
excluding, the two center wells. Points on (I) through (3) with X 
> 0 are the possible 

X-axis has its minimum 
at location X,, that is the positive mot of = 0 (with Y = 0). 
tJx coot being indepndent of D. With the D hpt yields & = 0 at 5. 
& is rhe lone X-axis stagnation point (double mot of *= 0). If all 
upper half-plane stagnation points &en have 2 0. X,, and this D 
are critical. 

Whereas the X-axis has a.= 0. lines parallel to the X-axis that 
pass through either a well oi a midpoint between neighboring 
wells ha& nonzem & d i d  toward tbc X-axis. except at well 
locations; some of the system's wells are symmetric with respect 
to each of these lines. md the remaining wells are in the opposite 
half-plane. Let well n be a noncenter well located at iv, on the pos- 
itive Y-axis (v, 2 2). Then GW e 0 holds on the line Y = v, (except 
at the well) and the midpoint line Y = v, - 1. The curve corn- 
spending to 4 = 0 on which well n'r stagnation point lies is con-. 
~u;lind kt&n these two lines, and wcll n's entire capturr zonc 
must be above the line Y = v, - 1 since no sacamline can run up 
to well n from any point on this line or below it. Points on tk tun-e 

= 0 can be found through numericd search. independent of D. 
e D that also gives = 0 at n point on the curve with X > 0 can 

be found directly; and % can then be directly evaluated at this stag- 
nation point. As Y incremes between the ~r0-4,. curveSs Y-inter- 
cepl (say. q,) nnd v,. the corresponding stagnation-point values of 
both D and 'k decrease. The limiting \dues nte D--ko and Q4= 
as Yq,, and D+O and $4 - v, as Y+v,. Thus. a stagnation 
point associated with well n can be found through numericd search 
for any prescribed value of either D > 0 or *> - v ~ .  

Now let 2, be well n's stagnation paint, and assume that ( 1 I 9 
= 0 at 2, , and (2) El 0 at all uppcr half-plane stasnation points. 
The system's capture zone then has no gaps. hence 'k = 0 on its 
boundq. Well n's capture zone (with $= 0 on its boundary also) 
m u  either (a) share some common h n d q  with the system's cap 
uue zone-in which case 2, and the cornspMlding D criEical--of 
else (b) nest inside the apture zone of another well--Say, well m. 
But suppose (b) is vue. Let iv, be well mgs location a d  Qm its W- 
nation-point '?'value. Well m must be below well n since well mas 



entire captute zone would be above the line Y = vm - I if v, > v,,. 
Lei the upper Y-intercepts of the capture zone boundaries of well 
m and n be om and om, respectively, and note am > a, because of 
the nestin , If there i$ no well between i o ,  and io,. thcn +,,, < 0 

*rw because d is  a dmeasing function of Y on the Y-axis. except for 
;. discontinuities at wells. But even if them we wells between iam and 

ia,. their capture zones are nested inside well m's and are entirely 
above (though possibly abutting) well n's capture zone. A d i n g l y .  
the constrain1 +',< Q 5 0 applies to $on the cn Nre zone bound- 
ary of any such well. So again it follows that k< 0. But this is 
impossible since well rn must be either a center well, in which case 
% = 0. or i4 noncenter well on .the positive Y-axis. in which case Q! 
2 0 by assumption; therefore. (b) cannot be me. Thus. a stagnation 
point & associated with a noncenterwell on the positive Y-axis, and 
the comsponding D. are critical whenever '!' = 0 at 2, while $ 2  
0 at all upper half-plane stngnation points. 

Appendix B-Regular Barrier Line with N = 4 
For a regular banier line of four wells, the condition 6'= 0 

yields the quartic quation Z4 - 4DZ3 + 10Z2 -2ODZ + 9p 0, which 

has closed-form al&b*c mots (q.. see Abmnowitz anditegun 

1%5, pages 17-1 0). Tht -roots uc Z, = (!&-@- t (p? - 4yJ~J  

(center wells) and Z, = (XI[++ f i(4y+ - p:)Y] (outer wells), 

= - 2 0  * (4D' + u - 1 O)a and y, = 1,112 * (u34 - 9)Y where -J3* * 

u k r + +  r-+ 10/3.~=(~3)[4(117D'-70a 3&)J*and p =  
500D6 - 793W + 520D3- 114. Requiring p = 0 (a cubic equation 

I in~lvulurin~=(fi/l50))93+u++u~~iinwhichu~= 
-[{ ((2 + q3)*]*. 6 = 56,867,257, and q = 151.l51; which gives 

D t: 0.824023996. This value of D yields the double root condition 
$2 - 4y- = 0. with stagnation points Z, = 1.185732903 and Z, = 
0.4623 15088 * i 2.487483346. Thc upper stagnation point has += 

0.28 > 0, confirming D is critical, so ( L a  /Q), = 0.38629. 

Altcmatively, the positive real mat of Xb + &* + 2 3 X  - 45 = 0. 

r o u l t i n g f m n ~ @ ~ = O u i r h ~ = O . i s ~ = ( ~  1 3 )  (-5+2 
((125 + 6 6%)''' + (125 - 6 *)*I}*, qnd for 6, = 0 at Xu. 
D = (X,,? + l)(X,,2+ 9M4X,, ( q 2  + 511, which g i k  x,= Z, aid 
the same D as above. 
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